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TUTORIAL

Welcome to MathTalk TM /ScientificNotebook TM
FOR
Dragon NaturallySpeaking® Versions 12 !
MathTalk/ScientificNotebook allows you to “voice” mathematical symbols and equations
of virtually any type, shape or form.
It contains even more sentence commands with variables which enables the User to voice
math even faster. For example, just say “3 x-ray minus 2” to get 3x ! 2 or “2 yankee square
plus 10” to get 2y 2 ! 10 or “5 alpha over 7 bravo” to get 5a
.
7b
Moreover, it is designed so that the keyboard, mouse, and voice can be used
interactively. The user can move back and forth at will between these mediums, employing
the tool that accomplishes the job at hand most easily.
The capabilities of this program may seem quite varied. The user need only use the
part that applies to the task at hand. If the user is voicing pre-algebra, then the user
need only use the program for that purpose. The same goes for algebra, calculus,
statistics, etc. Again, use this as a tool to accomplish the task!
To use MathTalk/ScientificNotebook, you will need Dragon NaturallySpeaking ®
(DNS ) version 12. 0 +. MathTalk/ScientificNotebook also requires Windows 7®
or better.
The instructions and comments which follow will facilitate the use of MathTalk. The
Initial Training, and Training Modules are constructed to develop your understanding and
voice recognition to a comfort level that will make MathTalk quite easy to use. You will
soon find that "talking" equations is much easier than typing them.
HELPFUL DEFINITIONS:
Pictionary -a list of the names of stand alone commands and the actions they
accomplish.
Tutorial - examples and explanations of use of commands.
Sentence Commands - allows the user to voice more than one expression at a time. An
example of this would be to say “square root of twenty”. This particular command allows
you to say any root (from square to ninth) of any number (1 through 20) or of any letter (a
through z, including caps) or any greek letter (including caps)!
Variable List - list of variables for use in Sentence Commands.
Training Modules - training for Pre-Algebra, Algebra, Calculus, Trig, Statistics.
The program contains the following learning assistance items:
1. Manual /Tutorial
2. Pictionary
3. Learning Assistance Module which is comprised of
a. Video demonstrations on the MathTalk CD video demo including:
“Quick Reference Laminate”
“Training MathTalk”
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“Adding Text to MathTalk” (also refer to Voicing or Typing Text in Table of Contents)
b. Direct online access to available Sentence Commands, Variable Lists, stand alone
commands in Pictionary, Manual/Tutorial search.
4. Recommended training for Pre-Algebra, Algebra, Trig, Calculus, and Statistics.
5. Find two QUICK REFERENCE laminates containing the International and Greek
Alphabets, and as well as, a list of often used sentence commands, with examples,
( Say "sample commands" to view.) to make voicing math even faster!! Learning
Assistance Module is available by a single voice command. Just say “mathtalk
learning module” at anytime for a list of commands to access video demos, lists of
sentence commands and their variables, stand alone commands in the Pictionary,
and Training Modules.
With the system requirements met, the load instructions followed exactly, and the
training/dictation techniques followed, you will be awed by this powerful tool!
Remark: It is very important to save your speech file after each sessions or maybe
even several times a session. You may do this by clicking “save user files” in the
DragonBar, NaturallySpeaking.

GETTING STARTED
It as is understood that you have followed the installation instructions EXACTLY such that
you may proceed as follows:
1. From the Desktop say “start mathtalk” or “start shortcut to mathtalk” as per the
Load Instructions which will bring up ScientificNotebook.
2. Follow the directions in “Before You Begin to Use MathTalk”, including saying
“train initial commands” to train the commands listed and then “train alphabet” to
train the International Alphabet. Using the International Alphabet is REQUIRED!
Interested Users may also say “train greek”.
Find included a laminated sheet of the International and Greek alphabet.
3. Each MathTalk Training Module is discussed in the following topics. Select a
Training Module and follow the directions.
4. When ready to create your own math, you may say “new file” and then “ok” to open
a new document.
5. Be sure to say “next line” to move the cursor to a new line when voicing
mathematics.

MATHTALK FOR PRE-ALGEBRA (c)
If your use of MathTalk is Pre-Algebra, we recommend the following steps.
1. Begin with:
a. Watch some of the examples on the Demo CD video. These will help you
learn to talk to MathTalk. We RECOMMEND this step!
b. Study “Rules for Correcting” – see listing in Table of Contents, Tutorial.
This is equally as important. The user must convey to the computer if there is a
2

misrecognition – otherwise, the computer will not know!
c. Study “Voicing or typing Text” – see listing in Table of Contents, Tutorial.
d. Study “next line and enter key commands” by saying “next line command”.
e. Review Trouble Shooting by saying “trouble shooting”.
2. NEXT
a. Study the MathTalk PreAlgebra Examples immediately following # 6.
b. Review variables that apply to the examples that follow. In the following
examples, the command to access these lists will be given at the
appropriate time.
This includes the International Alphabet which is accessed by saying
“international alphabet” and “sample commands” .
3. Study these topics which appear in the following paragraphs (You may refer
to the Table of Contents).
Rules for Voicing Commands
Improve Your Recognition Rate
Rules for Correcting
4. Complete the Pre-Algebra Training Module. Instructions will be at the top of the
page. To access this training, say “prealgebra training”. Be sure to say
“exit training” upon completion (This is also stated on the training document.)
so as to NOT save the document.
This training will help the user:
a. Find their dictation rhythm for MathTalk.
b. Learn to pause between commands (i.e. wait until the command
executes the keystrokes) before saying the next command.
c. Learn to formulate what to say BEFORE saying it!
d. Learn commands that are common throughout MathTalk.
5. You may choose to NOT read the remainder of the manual! Seriously, there
is no need for the user to learn all the MathTalk commands! The user need
utilize only the commands necessary to accomplish the task!
6. At any time say “mathtalk learning module” to access all help commands.

MathTalk PreAlgebra Examples (c)
Number examples:
Say: “twenty-five”, “comma”, “fifteen”, “comma”, “sixty-eight”, “comma”,
“8”, “hundred”
Get: 25, 15, 68, 800
Note you cay say:
Any number 1-99, hundred, and zero. (Sometimes you may need to say “math
mode” before you say the numbers for the numbers to appear in red.)
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Fraction examples:
Say: “4 over 5”, “comma”, “alpha over bravo”, “comma”, “9 over charlie”,
“comma”, “hotel over 3”, “comma”, “twenty- five over sixty- five”,
“comma”, “cap alpha over thirty-five”
Get: 45 , ab , 9c , h3 , 25
, A
65 35
Note that you may say:
1. Any number from 1-99 over any number 1-99.
2. Any number from 1-99 over any letter. The Letter Variable List contains letters
of the alphabet and cap letters of the alphabet. It is necessary to use the
International Alphabet to speak letters. Review the International Alphabet. Say
“international alphabet”. Then view the Cap Letter List by saying “cap
letter list”.
3. Any letter over any letter.
4. Any letter over any number 1-99.
Plus and Minus examples:
Say: “plus 5”, “comma”, “minus 8”, “comma”, “plus x-ray”, “comma”, “minus
yankee”, “comma”, “plus one fourth”, “comma”, “minus one third”
Get: !5, !8, !x, !y, ! 14 , ! 13
Note that you may say:
1. Plus any number from 0-20 (includes other variables). Review Numbers Variable
List by saying “numbers list”.
2. Minus any number from 0-20 (includes other variables).
3. Plus any letter. Review International Alphabet.
4. Minus any letter.
Number/Letter Number/Letter examples:
Say: “3 x-ray”, “comma”, “4 yankee”, “comma”, “thirty-five alpha”,
“comma”, “fifteen cap romeo”, “comma”, “x-ray yankee”
Get: 3x, 4y, 35a, 15R, xy
Note that you may say:
1. Any number 1-99 and any letter.
2. Any letter and any letter.
Square/Cube examples:
Say: “alpha cubed”, “comma”, “yankee squared”, “comma”, “x-ray
cubed”, “comma”, “cap hotel squared”
Get: a 3 , y 2 , x 3 , H 2
Note that you may say:
Any letter squared/cubed. (Includes “cap letter”.)
Square/Cube Root examples:
Say: “square root of twenty”, “comma”, “square root of charlie”,
“comma”, “cube root”, “fifteen”, “move out”, “comma”, “cube root
of one third”, “comma”, “ninth root of 8”
Get: 20 , c , 3 15 , 3 13 , 9 8
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Note that you may say:
1. Square root of any number 0-20 (includes other variables). Review
Numbers Variable List by saying “numbers list”.
2. Square root of any letter.
3. Cube root of any number 0-20 (includes other variables).
4. Cube root of any letter.
5. Square root of any letter. Includes “cap letter”.
6. Any root, square thru ninth, of numbers 0-20 (includes other variables).
If the user wishes additional information, saying “mathtalk learning
module” gives the user learning access help.
Recommended:
a. Review Sentence Commands and Variables Lists. In viewing these, you
will see that you have already been using Sentence Commands and
Variable Lists when you completed the training module as discussed in
number 4 above! To view Sentence Commands with examples, say
“show sentence commands”. To view Variable Lists, say “variable menu” and
“sample commands”.
b. View the Pictionary by saying “pictionary search” to bring up the Pictionary menu.
c. Additional Pre-Algebra examples are in the Manual/Tutorial. See Table of Contents.
d. You may choose do the Training Module again.

MATHTALK FOR ALGEBRA (c)
If your use of MathTalk is Algebra, we recommend the following steps.
1. Begin with:
a.Watch some of the examples on the Demo CD video. These will help you learn
to talk to MathTalk. We RECOMMEND this step!
b. Study “Rules for Correcting” – see listing in Table of Contents, Tutorial. This is
equally as important. The user must convey to the computer if there is a
misrecognition – otherwise, the computer will not know!
c. Study “Voicing or Typing Text” – see listing in Table of Contents, Tutorial.
d. Study “next line and enter key commands” by saying “next line command”.
e. Review Trouble Shooting by saying “trouble shooting”.
2. NEXT
a. Study the MathTalk Algebra Examples immediately following # 6.
b. Review variables that apply to the examples that follow. In the
following examples, the command to access these lists will be given
at the appropriate time.
This includes the International Alphabet which is accessed by saying
“international alphabet” and “sample commands”.
3. Study these topics which appear in the following paragraphs (You may refer
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to the Table of Contents).
Rules for Voicing Commands
Improve Your Recognition Rate
Rules for Correcting
4. Complete the Algebra Training Module. Instructions will be at the top of the
page. To access this training, say “train algebra”. Be sure to say “exit
training” upon completion (This is also stated on the training document.) so
as to NOT save the document.
This training will help the user:
a. Find their dictation rhythm for MathTalk.
b. Learn to pause between commands (i.e. wait until the command
executes the keystrokes) before saying the next command.
c. Learn to formulate what to say BEFORE saying it!
d. Learn commands that are common throughout MathTalk.
5. You may choose to NOT read the remainder of the manual! Seriously, there
is no need for the user to learn all the MathTalk commands! The user need
utilize only the commands necessary to accomplish the task!
6. At any time say “mathtalk learning module” to access all help commands.

MathTalk Algebra Examples (c)

Number examples:
Say: “twenty-five”, “comma”, “fifteen”, “comma”, “sixty-eight”, “comma”,
“8”, “hundred”
Get: 25, 15, 68, 800
Note you cay say:
Any number 1-99, hundred, and zero. (Sometimes you may need to say “math mode”
before you say the numbers for the numbers to appear in red.)

Fraction examples:
Say: “4 over 5”, “comma”, “alpha over bravo”, “comma”, “9 over charlie”,
“comma”, “hotel over 3”, “comma”, “twenty- five over sixty- five”, “comma”,
“cap alpha over thirty-five”
Get: 45 , ab , 9c , h3 , 25
, A
65 35
Note that you may say:
1. Any number from 1-99 over any number 1-99.
2. Any number from 1-99 over any letter. The Letter Variable List contains letters of the
alphabet and cap letters of the alphabet. It is necessary to use the International
Alphabet to speak letters. Review the International Alphabet. Say “international
alphabet”. Then view the Cap Letter List by saying “cap letter list”.
3. Any letter over any letter.
4. Any letter over any number 1-99.
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Plus and Minus examples:
Say: “plus 5”, “comma”. “minus 8”, “comma”, “plus x-ray”, “comma”, “minus
yankee”, “comma”, “plus one fourth”, “comma”, “minus one third”
Get: !5, !8, !x, !y, ! 14 , ! 13
Note that you may say:
1. Plus any number from 0-20 (includes other variables). Review Plus Numbers Variable
List by saying “plus numbers list”.
2. Minus any number from 0-20 (includes other variables). Review Minus Numbers
Variable list by saying “minus numbers list”.
3. Plus any letter. Review International Alphabet.
4. Minus any letter.
Number/Letter Number/Letter examples:
Say: “3 x-ray”, “comma”, “4 yankee”, “comma”, “thirty-five alpha”, “comma”,
“fifteen cap romeo”, “comma”, “x-ray yankee”
Get: 3x, 4y, 35a, 15R, xy
Note that you may say:
1. Any number 1-99 and any letter.
2. Any letter and any letter.
Square/Cube examples:
Say: “alpha cubed”, “comma”, “yankee squared”, “comma”, “x-ray cubed”,
“comma”, “cap hotel squared”
Get: a 3 , y 2 , x 3 , H 2
Note that you may say:
Any letter squared/cubed. (Includes “cap letter”.)
Square/Cube Root examples:
Say: “square root of twenty”, “comma”, “square root of charlie”, “comma”,
“cube root”, “fifteen”, “move out”, “comma”, “cube root of one third”,
“comma”, “ninth root of 8”
Get: 20 , c , 3 15 , 3 13 , 9 8
Note that you may say:
1. Square root of any number 0-20 (includes other variables). Review Numbers
Variable List by saying “numbers list”.
2. Square root of any letter.
3. Cube root of any number 0-20.
4. Cube root of any letter.
5. Square root of any letter. Includes “cap letter”.
6. Any root, square through ninth, of numbers 0-20.
Exponent examples:
Say: “alpha”, “exponent x-ray”, “alpha”, “exponent yankee”, “comma”,
“x-ray”, “exponent minus 4”, “comma”, “echo”, “exponent minus pi over 2”,
“comma”, “cap victor”, “exponent”, “parens”, “x-ray square plus
yankee square”, “sine theta”, “end exponent”
7

!

Get: a x a y , x !4 , e ! 2 , V

x 2 !y 2

sin "

Note that you may say:
(Say “exponent sentence commands” to view all available exponent commands.):
1. exponent any letter. Includes cap letter.
2. exponent any minus letter. Includes cap letter and Greek letter.
3. exponent greek letter
4. exponent any number 0-20 (includes other variables). To view Numbers List
say “numbers list”.
5. exponent minus numbers 1-9. To view Minus Numbers List, say “minus
numbers list”.
6. exponent any number 1-99 & any Greek letter
7. exponent any number 1-99 & any letter
Subscript examples:
Say : “alpha”, “sub 2”, “comma”, “bravo”, “sub india”, “comma”, “charlie”, “sub
one one”, “comma”, “x-ray”, “sub alpha charlie”, “comma”, “ yankee”, “sub
alpha minus 1”, “comma”, “echo”, “sub bravo plus 5”,“comma”, “log”, “subscript”,
“one half”, “move out”
Get: a 2 , b i , c 11 , x ac , y a!1 , e b!5 , log 1
2
Note that you may say:
(Say “sub sentence commands” to view all available sub commands.)
1. sub any number 1-9.
2. sub any number 1-9 and any number 1-9.
3. sub any letter
4. sub any letter and any letter
5. sub any letter plus/minus any number 1-9.
If the user wishes additional information, saying “mathtalk learning module”
gives the user learning access help.
Recommended:
a. Review Sentence Commands and Variables Lists. In viewing these, you will
see that you have already been using Sentence Commands and Variable Lists
when you completed the training module as discussed in number 4 above! To
view Sentence Commands with examples, say “show sentence commands”.
To view Variable Lists, say “variable menu” and “sample commands”.
b. View the Pictionary by saying “pictionary search” to bring up the Pictionary menu.
c. You may choose do the training module again.
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MATHTALK FOR TRIG (c)
If your use of MathTalk is Trig, we recommend the following steps.
1 Begin with:
a.Watch some of the examples on the Demo CD video. These will help you learn
to talk to MathTalk. We RECOMMEND this step!
b. Study “Rules for Correcting” – see listing in Table of Contents, Tutorial. This is
equally as important. The user must convey to the computer if there is a
misrecognition otherwise, the computer will not know!
c. Study “Voicing or Typing Text” – see listing in Table of Contents, Tutorial.
d. Study “next line and enter key commands” by saying “next line command”.
e. Review Trouble Shooting by saying “trouble shooting”.
2. NEXT
a. Study the MathTalk Trig Examples immediately following # 6.
b. Review variables that apply to the examples that follow. In the following
examples, the command to access these lists will be given at the
appropriate time.
This includes the International Alphabet which is accessed by saying
“international alphabet” and “sample commands”.
c. Say “trig list” to review a list of available trig commands.
3. Study these topics which appear in the following paragraphs (You may refer
to the Table of Contents).
Rules for Voicing Commands
Improve Your Recognition Rate
Rules for Correcting
4. Complete the Trig Training Module. Instructions will be at the top of the page.
To access this training, say “train trig”. Be sure to say “exit training”
upon completion (This is also stated on the training document.) so as to NOT
save the document.
This training will help the user:
a. Find their dictation rhythm for MathTalk.
b. Learn to pause between commands (i.e. wait until the command executes
the keystrokes) before saying the next command.
c. Learn to formulate what to say BEFORE saying it!
d. Learn commands that are common throughout MathTalk.
5. You may choose to NOT read the remainder of the manual! Seriously, there is
no need for the user to learn all the MathTalk commands! The user need utilize
only the commands necessary to accomplish the task!
6. At any time say “mathtalk learning module” to access all help commands.
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MathTalk Trig Examples (c)

Number examples:
Say: “twenty-five”, “comma”, “fifteen”, “comma”, “sixty-eight”, “comma”,
“8”, “hundred”
Get: 25, 15, 68, 800
Note you cay say:
Any number 1-99, hundred, and zero. (Sometimes you may need to say “math
mode” before you say the numbers for the numbers to appear in red.)

Fraction examples:
Say: “4 over 5”, “comma”, “alpha over bravo”, “comma”, “9 over charlie”,
“comma”, “hotel over 3”, “comma”, “twenty- five over sixty- five”,
“comma”, “cap alpha over thirty-five”
Get: 45 , ab , 9c , h3 , 25
, A
65 35
Note that you may say:
1. Any number from 1-99 over any number 1-99.
2. Any number from 1-99 over any letter. The Letter Variable List contains letters of the
alphabet and cap letters of the alphabet. It is necessary to use the International
Alphabet to speak letters. Review the International Alphabet. Say “international
alphabet”. Then view the Cap Letter List by saying “cap letter list”.
3. Any letter over any letter.
4. Any letter over any number 1-99.
Plus and Minus examples:
Say: “plus 5”, “comma”, “minus 8”, “comma”, “plus x-ray”, “comma”, “minus
yankee”, “comma”, “plus one fourth”, “comma”, “minus one third”
Get: !5, !8, !x, !y, ! 14 , ! 13
Note that you may say:
1. Plus any number from 0-20 (includes other variables). Review Plus Numbers Variable
List by saying “plus numbers list”.
2. Minus any number from 0-20 (includes other variables). Review Minus Numbers
Variable list by saying “minus numbers list”.
3. Plus any letter. Review International Alphabet.
4. Minus any letter.
Number/Letter Number/Letter examples:
Say: “3 x-ray”, “comma”, “4 yankee”, “comma”, “thirty-five alpha”, “comma”,
“fifteen cap romeo”, “comma”, “x-ray yankee”, “comma”, “ 2 cap zulu”
Get: 3x, 4y, 35a, 15R, xy, 2Z
Note that you may say:
1. Any number 1-99 and any letter.
2. Any letter and any letter.
Parentheses examples:
Say: “parens hotel”, “parentheses cap fee”, “parentheses minus 9”,
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“parentheses alpha bravo”, “parentheses 1”, “parentheses one one”
Get: !h" !!" !!9" !a, b" !1" !1, 1"!Z"
Note that you may say:
1. parentheses any letter (includes cap letter).
2. parentheses any Greek letter (includes cap Greek letter).
3. parentheses minus any letter.
4. parentheses any number.
5. parentheses minus any number.
Say “parentheses sentence commands” to view many more examples.
Square/Cube examples:
Say: “alpha cubed”, “comma”, “yankee squared”, “comma”, “x-ray
cubed”, “comma”, “cap hotel squared”
Get: a 3 , y 2 , x 3 , H 2
Note that you may say:
Any letter squared/cubed. (Includes “cap letter”.)
Square/Cube Root examples:
Say: “square root of twenty”, “comma”, “square root of charlie”,
“comma”, “cube root”, “fifteen”, “move out”, “comma”, “cube root
of one third”, “comma”, “ninth root of 8”
Get: 20 , c , 3 15 , 3 13 , 9 8
Note that you may say:
1. Square root of any number 0-20 (includes other variables). Review
Numbers Variable List by saying “numbers list”.
2. Square root of any letter.
3. Cube root of any number 0-20.
4. Cube root of any letter.
5. Square root of any letter. Includes “cap letter”.
6. Any root, square through ninth, of numbers 0-20.
Exponent examples:
Say: “alpha”, “exponent x-ray”, “alpha”, “exponent yankee”, “comma”,
“x-ray”, “exponent minus 4”, “comma”, “echo”, “exponent minus pi over 2”,
“comma”, “cap victor”, “exponent”, “parentheses”, “x-ray square plus
yankee square”, “sine theta”, “end exponent”
!
2 2
Get: a x a y , x !4 , e ! 2 , V x !y sin "
Note that you may say:
(Say “exponent sentence commands” to view all available exponent commands.):
1. exponent any letter. Includes cap letter.
2. exponent any minus letter. Includes cap letter and Greek letter.
3. exponent greek letter
4. exponent any number 0-20 (includes other variables). To view Numbers List
say “numbers list”.
5. exponent minus numbers 1-9. To view Minus Numbers List, say “minus
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numbers list”.
6. exponent any number 1-99 & any Greek letter
7. exponent any number 1-99 & any letter
Subscript examples:
Say : “alpha”, “sub 2”, “comma”, “bravo”, “sub india”, “comma”, “charlie”, “sub
one one”, “comma”, “x-ray”, “sub alpha charlie”, “comma”, “ yankee”, “sub
alpha minus 1”, “comma”, “echo”, “sub bravo plus 5”,“comma”, “log”,
“subscript”, “one half”, “move out”
Get: a 2 , b i , c 11 , x ac , y a!1 , e b!5 , log 1
2
Note that you may say:
(Say “sub sentence commands” to view all available sub commands.)
1. sub any number 1-9.
2. sub any number 1-9 and any number 1-9.
3. sub any letter
4. sub any letter and any letter
5. sub any letter plus/minus any number 1-9.
Trig Function examples:
Says: “sine squared x-ray”, “comma”,“cosecant squared theta”, “comma”,
“hyperbolic cotangent lambda”, “comma”, “inverse sine theta”
Get: sin 2 x, csc 2 ", coth #, sin !1 "
Note that you may say:
1. any trig function and any letter
2. any trig function
Say “trig list”, “numarg list”, and “argument list” for variable lists. Review Trig
Sentence commands by saying “trig sentence commands”.
Over command example:
Say: “3 over 4”, “sixty-five over seventy-nine”, “3 pi over 4”, “pi over 6”
3! !
Get: 34 65
79
4
6
Note that you may say:
1. any number 1-99 over any letter (includes cap letters).
2. any number 1-99 over any Greek letter (includes cap Greek letters).
3. any number 1-99 over any number 1-99.
(Say “numbers list” to view another variable list.)
If the user wishes additional information, saying “mathtalk learning module” gives
the user learning access help.
Recommended:
a. Review Sentence Commands and Variables Lists. In viewing these, you will see
that you have already been using Sentence Commands and Variable Lists when
you completed the training module as discussed in number 4 above! To view
Sentence Commands with examples, say “show sentence commands”. To
view Variable Lists, say “variable menu” and “sample commands”.
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b. View the Pictionary by saying “pictionary search” to bring up the
Pictionary menu.
c. You may choose do the Training Module again.

MATHTALK FOR CALCULUS (c)
If your use of MathTalk is Calculus, we recommend the following steps.
1. Begin with:
a.Watch some of the examples on the Demo CD video. These will help you learn
to talk to MathTalk. We RECOMMEND this step!
b. Study “Rules for Correcting” – see listing in Table of Contents, Tutorial. This is
equally as important. The user must convey to the computer if there is a
misrecognition otherwise, the computer will not know!
c. Study “Voicing or Typing Text” – see listing in Table of Contents, Tutorial.
d. Study “next line and enter key commands” by saying “next line command”.
e. Review Trouble Shooting by saying “trouble shooting”.
2. NEXT
a. Study the MathTalk Calculus Examples immediately following # 6.
b. Review variables that apply to the examples that follow. In the following
examples, the command to access these lists will be given at the
appropriate time. This includes the International Alphabet which is
accessed by saying “international alphabet” and “sample commands”.
3. Study these topics which appear in the following paragraphs (You may refer
to the Table of Contents).
Rules for Voicing Commands
Improve Your Recognition Rate
Rules for Correcting
4. Complete the Calculus Training Module. Instructions will be at the top of
the page. To access this training, say “train calculus”. Be sure to say
“exit training” upon completion (This is also stated on the training
document.) so as to NOT save the document.
This training will help the user:
a. Find their dictation rhythm for MathTalk.
b. Learn to pause between commands (i.e. wait until the command
executes the keystrokes) before saying the next command.
c. Learn to formulate what to say BEFORE saying it!
d. Learn commands that are common throughout MathTalk.
5. You may choose to NOT read the remainder of the manual! Seriously,
there is no need for the user to learn all the MathTalk commands! The
user need utilize only the commands necessary to accomplish the task!
6. At any time say “mathtalk learning module” to access all help commands.
13

MathTalk Calculus Examples (c)

Number examples:
Say: “twenty-five”, “comma”, “fifteen”, “comma”, “sixty-eight”, “comma”,
“8”, “hundred”
Get: 25, 15, 68, 800
Note you cay say:
Any number 1-99, hundred, and zero. (Sometimes you may need to say “math
mode” before you say the numbers for the numbers to appear in red.)

Fraction examples:
Say: “4 over 5”, “comma”, “alpha over bravo”, “comma”, “9 over charlie”,
“comma”, “hotel over 3”, “comma”, “twenty- five over sixty- five”,
“comma”, “cap alpha over thirty-five”
Get: 45 , ab , 9c , h3 , 25
, A
65 35
Note that you may say:
1. Any number from 1-99 over any number 1-99.
2. Any number from 1-99 over any letter. The Letter Variable List contains letters of the
alphabet and cap letters of the alphabet. It is necessary to use the International
Alphabet to speak letters. Review the International Alphabet. Say “international
alphabet”. Then view the Cap Letter List by saying “cap letter list”.
3. Any letter over any letter.
4. Any letter over any number 1-99.
Plus and Minus examples:
Say: “plus 5”, “comma”, “minus 8”, “comma”, “plus x-ray”, “comma”, “minus
yankee”, “comma”, “plus one fourth”, “comma”, “minus one third”
Get: !5, !8, !x, !y, ! 14 , ! 13
Note that you may say:
1. Plus any number from 0-20 (includes other variables). Review Plus Numbers Variable
List by saying “plus numbers list”.
2. Minus any number from 0-20 (includes other variables). Review Minus Numbers
Variable list by saying “minus numbers list”.
3. Plus any letter. Review International Alphabet.
4. Minus any letter.
Number/Letter Number/Letter examples:
Say: “3 x-ray”, “comma”, “4 yankee”, “comma”, “thirty-five alpha”, “comma”,
“fifteen cap romeo”, “comma”, “x-ray yankee”
Get: 3x, 4y, 35a, 15R, xy
Note that you may say:
1. Any number 1-99 and any letter.
2. Any letter and any letter.
Square/Cube examples:
Say: “alpha cubed”, “comma”, “yankee squared”, “comma”, “x-ray cubed”,
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“comma”, “cap hotel squared”
Get: a 3 , y 2 , x 3 , H 2
Note that you may say:
Any letter squared/cubed. (Includes “cap letter”.)
Square/Cube Root examples:
Say: “square root of twenty”, “comma”, “square root of charlie”, “comma”,
“cube root”, “fifteen”, “move out”, “comma”, “cube root of one third”,
“comma”, “ninth root of 8”
Get: 20 , c , 3 15 , 3 13 , 9 8
Note that you may say:
1. Square root of any number 0-20 (includes other variables). Review Numbers
Variable List by saying “numbers list”.
2. Square root of any letter.
3. Cube root of any number 0-20.
4. Cube root of any letter.
5. Square root of any letter. Includes “cap letter”.
6. Any root, square through ninth, of numbers 0-20.
Exponent examples:
Say: “alpha”, “exponent x-ray”, “alpha”, “exponent yankee”, “comma”,
“x-ray”, “exponent minus 4”, “comma”, “echo”, “exponent minus pi over 2”,
“comma”, “cap victor”, “exponent”, “parentheses”, “x-ray square plus
yankee square”, “sine theta”, “end exponent”
!
2 2
Get: a x a y , x !4 , e ! 2 , V x !y sin "
Note that you may say:
(Say “exponent sentence commands” to view all available exponent commands.):
1. exponent any letter. Includes cap letter.
2. exponent any minus letter. Includes cap letter and Greek letter.
3. exponent greek letter.
4. exponent any number 0-20 (includes other variables). To view Numbers List
say “numbers list”.
5. exponent minus numbers 1-9. To view Minus Numbers List, say “minus
numbers list”.
6. exponent any number 1-99 & any Greek letter.
7. exponent any number 1-99 & any letter.
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Subscript examples:
Say : “alpha”, “sub 2”, “comma”, “bravo”, “sub india”, “comma”,
“charlie”, “sub one one”, “comma”, “x-ray”, “sub alpha charlie”, “comma”,
“ yankee”, “sub alpha minus 1”, “comma”, “echo”, “sub bravo plus 5”,
“comma”, “log”, “subscript”, “one half”, “move out”.
Get: a 2 , b i , c 11 , x ac , y a!1 , e b!5 , log 1
2
Note that you may say:
(Say “sub sentence commands” to view all available sub commands.)
1. sub any number 1-9.
2. sub any number 1-9 and any number 1-9.
3. sub any letter
4. sub any letter and any letter
5. sub any letter plus/minus any number 1-9.
Plus Delta examples:
Say: “x-ray plus delta x-ray”, “comma”, “cap november plus delta
cap november ”
Get: x ! "x, N ! "N
Note that you may say any letter plus delta letter (includes cap letter).
Derivative examples:
Say: “derivative with respect to x-ray, derivative with respect to
tango”, “delta cap foxtrot delta x-ray, delta romeo delta theta ”
dr
Get: dxd dtd dF
dx d"
Note that you may say:
1. d any letter and d any letter.
2. d any letter and d any Greek letter (includes cap letter). Review Greek
Letter List by saying “greek letter list”. Say “derivative sentence
commands” to view more examples.
Higher Order Derivative examples:
Say: “second derivative of yankee with respect to x-ray”, “fourth
derivative of romeo with respect to theta”
d2y d4r
Get: dx 2 d"
4
Note that you can say:
Say “higher order list” to view all available Higher Order commands.) Say
“higher order sentence commands” to view more examples.
1. 2nd thru 9th derivative of any letter with respect to any letter (includes
cap letter).
2. 2nd thru 9th derivative of any letter with respect to any Greek letter
(includes cap Greek letter).
Partial Derivative examples:
Say: “mixed partial of foxtrot with respect to romeo and theta”, “second
partial of x-ray with respect to whiskey”

16

"2f

2

" x
Get: "r"" "w
2
Note that you may say:
Say “partial sentence commands” and “second partial sentence
commands” to view more examples.

Limit examples:
Say: “limit at hotel goes to zero”, “tab key”, “limit”, “cap greek delta”,
“theta goes to zero”, “move out”, “tab key”, “limit as alpha goes to 3”
Get: lim lim lim
h#0

""#0

a#3

Note that you may say:
1. limit as any letter goes to any number 0-20 (say “numbers list” to view
other variables).
2. limit as any letter goes to any letter (includes cap letter).
3. limit as any Greek letter goes to any number 0-20.
4. limit as delta any letter goes to zero.
5. limit as delta any Greek letter goes to zero.
Say “sentence limit commands” to view more examples.
Parentheses examples:
Say: “parentheses hotel”, “parentheses cap fee”, “parentheses
minus 9”, “parentheses alpha bravo”
Get: !h"!!"!!9"!a, b"
Note that you may say:
1. parentheses any letter (includes cap letter).
2. parentheses any Greek letter (includes cap Greek letter).
3. parentheses minus any letter.
4. parentheses any number.
5. parentheses minus any number.
Say “parentheses sentence commands” to view many more examples.
Integral examples:
Say: “ integral with joint scripts”, “limits zero to 2 pi”, “integral with limits”,
“limits minus one fourth to infinity”, “integral with lower limit”, “minus 5”,
“move out”
Get: #

2!
0

$

# #

! 14 !5

Note that you may say:
To view variable lists, say “ numbers list”, “minus numbers list”, “letter list”,
“minus letter list”, “greek letter list”, “sample commands”.
1. integral with joint scripts
2. integral with limits
3. integral with lower limit
4. integral with over limits
5. integral with subscript
Say “limits sentence commands” to view many more examples.
17

Sum examples:
Say: “sum with joint scripts”, “india”, “equals”, “limits 1 to november”,
“sum with limits” ,“limits zero to infinity”
n

$

Get: % i$1 %
0

Note that you may say:
To view variable lists, say “ numbers list”, “minus numbers list”,
“letter list”, “minus letter list”, “greek letter list”.
1. sum with joint scripts
2. sum with limits
3. sum with lower limit
4. sum with subscript
* To see a list of stand alone sum commands with no variables, say “go to
summation commands”.
If the user wishes additional information, saying “mathtalk learning module”
gives the user learning access help.
Recommended:
a. Review Sentence Commands and Variables Lists. In viewing these, you
will see that you have already been using Sentence Commands and
Variable Lists when you completed the training module as discussed in
number 4 above! To view Sentence Commands with examples, say
“show sentence commands”. to view Variable Lists, say “
variable menu” and “sample commands”.
b. View the Pictionary by saying “pictionary search” to bring up the
Pictionary menu.
c. You may choose do the training module again.

MATHTALK FOR STATISTICS (c)
If your use of MathTalk is Statistics, we recommend the following steps.
1. Begin with:
a. Watch some of the examples on the Demo CD video. These will help you learn to
talk to MathTalk. We RECOMMEND this step!
b. Study “Rules for Correcting” – see listing in Table of Contents, Tutorial. This is
equally as important. The user must convey to the computer if there is a
misrecognition – otherwise, the computer will not know!
c. Study “Voicing or Typing Text” – see listing in Table of Contents, Tutorial.
d. Study “next line and enter key commands” by saying “next line command”.
e. Review Trouble Shooting by saying “trouble shooting”.
2. NEXT
a. Study the MathTalk Statistics Examples immediately following # 6.
b. Review variables that apply to the examples that follow. In the following
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examples, the command to access these lists will be given at the
appropriate time.
This includes the International Alphabet which is accessed by saying
“international alphabet” and “sample commands”.
3. Study these topics which appear in the following paragraphs (You may refer to
the Table of Contents).
Rules for Voicing Commands
Improve Your Recognition Rate
Rules for Correcting
4. Complete the Statistics Training Module. Instructions will be at the top of the
page. to access this training, say “train statistics”. Be sure to say “exit
training” upon completion (This is also stated on the training document.) so
as to NOT save the document.
This training will help the user:
a. Find their dictation rhythm for MathTalk.
b. Learn to pause between commands (i.e. wait until the command
executes the keystrokes) before saying the next command.
c. Learn to formulate what to say BEFORE saying it!
d. Learn commands that are common throughout MathTalk.
5. Study the Statistics Section of the Manual\Tutorial. See the Table of
Contents.
6. You may choose to NOT read the remainder of the manual! Seriously,
there is no need for the user to learn all the MathTalk commands! The user
need utilize only the commands necessary to accomplish the task!
7. At any time say “mathtalk learning module” to access all help commands.

MathTalk Statistics Examples (c)

Number examples:
Say: “twenty-five”, “comma”, “fifteen”, “comma”, “sixty-eight”, “comma”,
“8”, “hundred”
Get: 25, 15, 68, 800
Note you cay say:
Any number 1-99, hundred, and zero. (Sometimes you may need to say “math mode”
before you say the numbers for the numbers to appear in red.)
Letter examples:
Say: “alpha”, “equals minus 2”, “comma”, “theta”, “equals”, “1 over 6”
Get: a $ !2, " $ 16
Note that you may say any letter using the International Alphabet. To review the
International Alphabet, say “international alphabet’ (includes cap letter). Review the
Greek Letter List by saying “greek letter list” (includes cap Greek letter).
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Fraction examples:
Say: “4 over 5”, “comma”, “alpha over bravo”, “comma”, “9 over charlie”,
“comma”, “hotel over 3”, “comma”, “twenty- five over sixty- five”, “comma”,
“cap alpha over thirty-five”
Get: 45 , ab , 9c , h3 , 25
, A
65 35
Note that you may say:
1. Any number from 1-99 over any number 1-99.
2. Any number from 1-99 over any letter. The Letter Variable List contains letters of the
alphabet and cap letters of the alphabet. It is necessary to use the International
Alphabet to speak letters. Review the International Alphabet. Say “international
alphabet”. Then view the Cap Letter List by saying “cap letter list”.
3. Any letter over any letter.
4. Any letter over any number 1-99.
Plus and Minus examples:
Say: “plus 5”, “comma”, “minus 8”, “comma”, “plus x-ray”, “comma”, “minus
yankee”, “comma”, “plus one fourth”, “comma”, “minus one third”
Get: !5, !8, !x, !y, ! 14 , ! 13
Note that you may say:
1. Plus any number from 0-20 (includes other variables). Review Plus Numbers Variable
List by saying “plus numbers list”.
2. Minus any number from 0-20 (includes other variables). Review Minus Numbers
Variable list by saying “minus numbers list”.
3. Plus any letter. Review International Alphabet.
4. Minus any letter.
Number/Letter Number/Letter examples:
Say: “3 x-ray”, “comma”, “4 yankee”, “comma”, “thirty-five alpha”, “comma”,
“fifteen cap romeo”, “comma”, “x-ray yankee”
Get: 3x, 4y, 35a, 15R, xy
Note that you may say:
1. Any number 1-99 and any letter.
2. Any letter and any letter.
Exponent examples:
Say: “alpha”, “exponent x-ray”, “alpha”, “exponent yankee”, “comma”,
“x-ray”, “exponent minus 4”, “comma”, “echo”, “exponent minus pi over 2”,
“comma”, “cap victor”, “exponent”, “parentheses”, “x-ray square plus
yankee square”, “sine theta”, “end exponent”
!
2 2
Get: a x a y , x !4 , e ! 2 , V x !y sin "
Note that you may say:
(Say “exponent sentence commands” to view all available exponent commands.):
1. exponent any letter. Includes cap letter.
2. exponent any minus letter. Includes cap letter and Greek letter.
3. exponent greek letter
4. exponent any number 0-20 (includes other variables). To view Numbers List
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say “numbers list”.
5. exponent minus numbers 1-9. To view Minus Numbers List, say “minus
numbers list”.
6. exponent any number 1-99 & any Greek letter
7. exponent any number 1-99 & any letter
If the user wishes additional information, saying “mathtalk learning module” gives
the user learning access help.
Recommended:
a. Review Sentence Commands and Variables Lists. In viewing these, you will see
that you have already been using Sentence Commands and Variable Lists when
you completed the training module as discussed in number 4 above! To view
Sentence Commands with examples, say “show sentence commands”. To
view Variable Lists, say “variable menu” and “sample commands”.
b. View the Pictionary by saying “pictionary search” to bring up the Pictionary menu.
c. You may choose do the training module again.

MATHTALK TUTORIAL
RULES FOR VOICING COMMANDS
All commands must be preceded by a pause and followed by a pause. This is true
for voicing any commands in NaturallySpeaking!
Speak distinctly and slowly. Speak each syllable of each and every word!
Do not pause between words when speaking a command.
Wait until the command executes before continuing.
IMPROVE YOUR RECOGNITION RATE
You can greatly increase your speech recognition rate by adhering to the following
suggestions:
1. Watch some of the examples on the Demo CD video.
2. It is important to position your microphone correctly. Place the microphone
at least 1 inch from the corner of the mouth. For a voice with much volume,
you may need to move the microphone further away.
3. Distinguish small differences by emphasizing them. Thus, to distinguish
between “limits zero to pi” and “limits zero to two pi”, emphasize the
“two” as you say the phrase. Similarly, to distinguish between “mixed
partial of foxtrot with respect to x-ray and yankee”and “mixed partial
of foxtrot with respect to yankee and x-ray”, emphasize the word
underlined. With use, you will find what pitch and speed to use in pronunciation
to obtain optimum speech recognition.
4. Finally, speak firmly at a steady pace, but pause between commands.
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5. See the command executed on the screen before proceeding.
6. Save speech files often by saying “save user files” or click ‘save user files’.
RULES FOR CORRECTING
SPECIAL NOTE: After using any of the following correction methods, it
may be necessary to say “button click” to activate the MathTalk screen.
If the wrong math command appears on the screen:
A. Erase the misrecognition using NaturallySpeaking commands such “delete
previous 1/15 characters”.
B. Then repeat the command.
C. If the misrecognition continues, erase the misrecognition as described above.
Then say “train command” which will bring up a train dialog box. In this
dialog box, say the command one word at a time. All commands in MathTalk
are in lower case.
1) With the correct command in the box, say “train”. Train the command and say
“done”. Then back in ScientificNotebook, say the command again.
2) If voicing the command produces a misrecognition in this dialog box, say
“correct that”. With the Correction dialog box open, then type/spell the
command. For example, you would type/spell “second partial of yankee
with respect to whiskey” (do not include the “ ”). Say “Click Train” to
train the command, say “Click Done” to return to the Correction dialog box,
and then say “Choose 1” (assuming the correct command is in the number
one place). This is a standard correction technique for NaturallySpeaking.
3) It will be necessary to say “button click” to activate the MathTalk screen.
(NOTE: The Dragon command ”Scratch That” can delete the entire line!)
EDITING COMMANDS
Copy
copy this, copy to beginning of line, copy to end of line
Paste
paste this, paste that
Delete
backspace 1 to 20
Example: say “backspace 8”
delete next 1 to 10 characters
Example: say “delete next 10 characters”
delete previous 1 to 10 characters
Example: say “delete previous 6 characters”
Move
move left/right/back/forward 1 to 20 characters/words
Example: say “move right 10 characters”
move up/down 1 to 20 lines/paragraphs
Example: say “move up 2 lines”
move to beginning of line: say “beginning of line”
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move to end of line: say “end of line”
Select
select next/previous 1 to 20 characters/words
Example: say “select next 10 characters”
You can also say “erase line”, “erase to beginning of line”, “erase 2 lines”,
“erase 3 lines”, and “delete rest of line”.
Can’t Remember What To Say?
If you can’t remember what to say, remember the “go to” commands to view stand alone
commands. For example, if you wish to view commands beginning with the letter “s”, say
“go to sierra commands” which will take you into the Pictionary to the commands that
begin with the letter “s”. Using the International Alphabet, say “go to and the letter
commands” to view commands beginning with that letter. Saying “pictionary search” will
take you to other “go to” commands for searches such as commands beginning with
“integral” which would be accessed by saying “go to integral commands”.
Using the International Alphabet & Greek Alphabet
When saying letters of the alphabet, i.e. a, b, c... , or A, B, C... , the International
Alphabet must be used. In fact, it is REQUIRED! Thus, to obtain abc, you would say
“alpha, bravo, charlie”. Likewise, to obtain ABC, you would say “cap alpha, cap bravo,
cap charlie”. Thus, for example, you cannot say “u square”–you must say “uniform
square”.
For Greek letters, you simply say the Greek letter–with the exception of alpha, delta, nu,
xi, eta, zeta, and fee. In the case of the first seven letters, precede them with the word
“greek”, i.e., “greek alpha”, “greek delta”, “greek november”, “greek x”, “greek eta”,
“greek zeta”. Also for phi, say “fee”. This is necessary, since alpha and delta are
International Alphabet letters, nu and xi sound so much like mu and psi (command is “sigh”),
and beta, eta and zeta sound too much like theta.
See the Quick Reference laminate or say “international alphabet” and “greek
alphabet”. ALSO SEE NEXT PAGE !
In this regard be sure and read the section below entitled “Derivative Commands,
Differential, and Delta Commands”.
Derivative Commands, Differential, and Delta Commands
You must say “delta” to get a “d” and “cap greek delta” to get !. For example, say “delta
yankee delta x-ray”, “comma”, “delta yankee”, “comma”, “cap greek delta”, “yankee”,
dy
“comma”, “cap greek delta”, “x-ray” to get dx , dy, !y, !x.
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The International Alphabet is listed below.
For ’Cap’ say ’cap letter’.
a alpha j juliette
s sierra
b bravo

CAP

SAY

k kilo

t tango

c charlie l lima

u uniform

d delta

m mike

v victor

e echo

n november w whiskey

f foxtrot o oscar

x x-ray

g golf

p papa

y yankee

h hotel

q quebec

z zulu

i india

r romeo

Greek Alphabet
(* denotes exceptions to simply saying the Greek letter.)
CAP SAY

!

*Greek Alpha (for Alpha)

"

Beta
cap Gamma

* cap Greek Delta

(for cap Delta)

% Epsilon
&
'

*Greek Zeta
* Greek Eta
Iota

*

Kappa

+

Lambda

0

Rho

1

Sigma
cap Sigma

2

Tau

(for Eta)

3

Upsilon

4

* fee (for Phi)
* cap fee (for cap Phi)

5

Chi

6

* sigh (for Psi)
* cap sigh (for cap Psi)

!

(

cap Lambda

$

cap Pi

(for Zeta)

cap Theta
)

Pi

'

( Theta
#

/
&

$ * Greek Delta (for Delta)
!

* Greek x-ray (for X)
* cap Greek x-ray (for cap X)

%

# Gamma
"

.

,

Mu

-

* Greek november

7 Omega
)

cap Omega

(for Nu)
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Sentence Commands
Sentence commands are really an entire set of commands. They have the form “xx *xx+,
xx *xx+”, where the angles and x’s can be intermixed in anyway you like. For example the
first sentence command is “*Alphabet+ derivative”. By saying “kilo derivative”, “lima
derivative”, “mike derivative”, “november derivative”, and “sierra derivative”, this command
dky
dly
dmy
dny
dsy
produces dx k , dx l , dx m , dx n , dx s . Similarly, the command “*Letter+ over *Letter+” allows
you to get ab , uv , XY by saying “alpha over bravo”, “uniform over victor”, and “cap x-ray over
cap yankee”, i.e., any letter over any letter. See Quick Reference laminate for other
examples.
Types of Math Commands
! Angle *Letter+ (English or Greek) Example: Say “angle x-ray” or “angle
theta” to get ! x , or ! ( .
! Angle *Letter+ with arc (English or Greek) Example: Say “angle x-ray with
x
arc” to get " .
! *Cap Letter+

Examples: Say “cap alpha”, “cap bravo” to get AB.

! *DigitsGroup+ Examples: “23. 459" , “. 00185" , “1. 3476" . Here you must say the
digits one at a time but you should not pause between them. That is say “2-3-point-4-5-9”,
“point-zero-zero-1-8-5”, “1-point-3-4-7-6”. Do not pause between digits. Do pause at the
commas between the three numbers.
! Decorations (Decor) i.e. hats, bars and tildas
! Derivatives
dny
*Alphabet+ Example: dx n
3
d4x
*HigherOrder+ Examples: ddvu3 , d(
4
d
derivative with respect to *Letter+ Examples: drd , d+
delta*Letter+ Examples:dy, dx, d(
dy dr
delta*Letter+delta*Letter+ Examples: dx , d(
#2f
#2u
#2R
mixed partial of *Letter+... Examples: #x#y , #x#(
, #4#(
#f

partial of...... Examples: #x , #F
#(
#
partial with respect to... Examples: #x# , #+
2
2
# f
# r
second partial.....
Examples: #x 2 , #(
2

! Dialog boxes
! Editing
Copy, and move Commands
delete next/previous 1-10 characters
undo that
*Move or Select+ *Direction+ *Number /1 to 40+
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! Exponent commands (In exponent examples we assume that you have already said “echo” i.e.
exponent is on “e”)
Exponent *Letter+ —————– Examples: e x , e m , e l
Exponent *Greek Letter+——— Examples: e ( , e 7 , e )
Exponent *Minus Letter+——— Examples: e $x , e $m , e $l
Exponent *Minus Greek Letter+– Examples: e $( , e $7 , e $+ (Upper case Greek
Letters are not included in the minus Greek Letter vocabulary. To enter expressions such as e $) ,
see the tutorial.)

Exponent *Numbers+————–
Exponent *Minus Numbers+——
superscript—————————
exponent—————————–

/

Examples: e 8 , e 2 , e 2/
/
Examples: e $8 , e $ 2 , e $2/
2
2 2
2
Examples: e sin ( , e x ,y , e cot +$1
Examples: Same as Superscript

! Formatting Commands See tutorial
! Graphing
See tutorial
! Greek characters
See tutorial
! Integral Commands
See tutorial
! Letter (includes caps) and Number Commands
Command
Examples
The following list is available on Quick Reference laminate and/or by saying
“sample commands”.
*Letter+
a, b, c, x, y, z
*Letter+*Letter+
ab, xy, uv
*Number/1 to 99+
1, 11, 25, 65, 99
*Number/1 to 99+ *Letter+
27r, 5n, 10x
*Number/1 to 99+ *Letter+ *Letter+
5xy, 21cd
*Number/1 to 99+ *Greek Letter+
2a, 13", 3#
plus *Letter+
minus *Letter+
plus *Number/1 to 99+
minus *Number/1 to 99+
plus *Number/1 to 99+*Letter+
minus *Number/1 to 99+*Letter+

,a, , b
$x, $ y
,27, , 15
$10, $53
,3a, ,10y
$5x, $ 20b

*Letter+ plus *Letter+
x , y, r , s, X , Y
*Letter+ minus *Letter+
c $ d, w $ z, R $ S
*Letter+ plus *Number/1 to 99+
p , 33, h , 1, F , 5
*Letter+ minus *Number/1 to 99+ r $ 10, s $ 5, Y $ 20
*Number/1 to 99+ plus *Number/1 to 99+ 6 , 7, 13 , 42
*Number/1 to 99+ minus *Number/1 to 99+ 17 $ 5, 35 $ 25
*Number/1 to 99+ plus *Letter+
26 , i, 17 , z, 25 , B
*Number/1 to 99+ minus *Letter+
10 $ n, 32 $ v, 15 , N
*Number/1 to 99+ *Letter+ plus *Letter+
3x , y, 2u , y, a , b, 3A , D
*Number/1 to 99+ *Letter+ plus *Number/1 to 99+
6a , 9, 11x , 3, y , 2, 22R , 18
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*Number/1 to 99+ *Letter+ minus *Letter+
3x $ y, 25a $ b
*Number/1 to 99+ *Letter+ minus *Number/1 to 99+
3x $ 10, 2a $ 4
*Number/1 to 99+ *Letter+ plus *Number/1 to 99+ *Letter+
3x , 2y, 5v , 3i
*Number/1 to 99+ *Letter+ minus *Number/1 to 99+*Letter+ 4a $ 3b, 2x $ 3y
*Letter+ plus *Number/1 to 99+*Letter+
*Letter+ minus *Number/1 to 99+*Letter+
equals *Number/1 to 99+
equals minus *Number/1 to 99+
equals *Letter+
equals minus *Letter+
equals *Number/1 to 99+ *Letter+
equals minus *Number/1 to 99+ *Letter+
*Letter+*SqCube+ (includes Greek & cap)
*Number/1 to 99+ *Letter+ *SqCube+

x , 3y, a , 5b, Y , 7X
n $ 20m, x $ 2y, A $ 35B
- 25, - 6, - 87
- $16, - $3
- e, - c, - X
- $i, - $h, - $Y
- 3a, - 8y
- $2b, - $15r
b2, 12, A3, "3, x2, y3, (2, +2
7b 2 , 3x 3 , 5A 3

*Letter+ square plus *Number/1 to 99+
x 2 , 2, y 2 , 5, H 2 , 15
*Number/1 to 99+ *Letter+ *SqCube+ plus *Number/1 to 99+ 2x 2 , 10, 3r 2 , 1
*Letter+ square minus *Number/1 to 99+
x 2 $ 9, y 2 $ 9, A 2 $ 2
*Number/1 to 99+*Letter+ *SqCube+ minus *Number/1 to 99+ 3x 2 $ 5, 2y 2 $ 7
*Letter+ square plus *Letter+ square
a2 , b2, x2 , y2
*Letter+ square minus *Letter+ square
c2 $ d2, x2 $ y2
times *Number/1 to 99+
8 6, 885
*Number/1 to 99+ times *Number/1 to 99+ 4 8 5, 15 8 10
Combinations of *Letter+,*GreekLetter+, *Number 1-99+
over *Letter+,*GreekLetter+, *Number 1-99+
"
b w 2
w
, , y , 3 , XY , xy , 7y , 33z , 10
, 2x
" v
*Number/1 to 99+ *Letter+ over *Number/1 to 99+ *Letter+,
6k
5R
*Number/1 to 99+ *Letter+ over *Number/1 to 99+ 5a
, xy , 3x5 , 3d
, 10Y
7b
*Number/1 to 99+ over *Number/1 to 99+ *Letter+,
2
15
*Number/1 to 99+ over *Number/1 to 99+
, 17
, 2 , 11
, 75
, 30S
3x
4y 3
12
20
*Number/1 to 99+ spaces
Function *Letter+
parens *Number/1 to 99+
parens minus *Number/1 to 99+

f" #, w" #, B" #
"5#, "27#
"$6#, "$45#

$
$
*Letter+ *Decor+
', (, x , X , +
*Letter+ plus delta *Letter+
x , !x, y , !y, h , !h
*Letter+ factorial, *Letter+ minus *Letter+ factorial,
*Letter+ plus *DigitsOnly+ factorial
and *Letter+ minus *DigitsOnly+ factorial
n!"n $ x#!"m $ 1#!"m , 2#!, "l , 1#!
*Letter+ *Primes+
X . , f .. , ( ... , $ .
*Letter+ *Primes+ of *Greek Letter+
e .. "/#
cap greek delta (*pause here) *Letter+
!x, !h, !m
*Number/1 to 9+ by *Number/1 to 9+ determinant
See examples below.
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! limit as *Letter+ goes to *Letter+ also to Greek letters and Numbers
Examples: lim, lim, lim, lim
x/y

x/0

n/%

!/$%

! limits *Letter+ to *Letter+ also Greek letters and Numbers

These are limits to put on integrals, summations, products, intersections, unions,vertical
bars, etc. See the tutorial.

! log base 10 *Letter+ & natural log *Letter+ (includes Greek)
Examples: log a, ln +
! Math Mode
See the Tutorial
! Matrix / Determinants
See the Tutorial
*Number/1 to 9 by Number /1 to 9+ bracket matrix
*Number/1 to 9 by Number /1 to 9+ matrix
*Number/1 to 9 by Number /1 to 9+ determinant
! Minus Numbers Commands
Minus *Numbers+
! Parentheses Commands
Say “parentheses x-ray”,“parentheses x-ray yankee”,“parentheses minus one
one”
to get "x#, "x, y#, "$1, 1#
! Plus Numbers Commands
Plus *Numbers+
! Saving, closing and opening commands
! Summation Commands
! Subscripts
See the Tutorial
*DigitsOnly+
*DigitsOnly+ *DigitsOnly+
*Letter+
*Letter+ *Letter+
*Letter+ minus *DigitsOnly+
*Letter+ plus *DigitsOnly+
Subscript
! Toolbars
! Type commands - Table of Contents
! *Root+ root of *Letter, Greek Letter or Number+. Examples: / , 3 2 , 5 n
! *Trig+
Examples: sin, cos, tan 2
! *Trig+ *Argument+
Examples: sin x, cos (, tan 2 7, tan $1 (, sinh 2 x
There are many more special purpose and special symbol commands such as A R
process, Bessel function, reviewing commands, etc. You will be exposed to these commands
and more in the tutorial.
Opening, Closing, and Saving Files
If you need to open a file, close a file or save a file, you can do it in Scientific Notebook
by saying: “open file”, “close file”, and “save file” respectively. You can also say “save
this” or “save as”.
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About Voicing Commands in Dialog Boxes and Toolbars
When you are in the ScientificNotebook you can access any of the menus on the Toolbar
by saying, “click file”, “click open”, “click edit”, etc. You’ll have no trouble knowing what
to say since it will be written right on the screen in front of you. The same is true for
dialog boxes. In Scientific Notebook you will often be in a dialog box. For example, if you
say “change variable”, you will be in the “change variable dialog box”. Similarly if you say
“integrate by parts”, you will be in the “integrate by parts dialog box”. Whenever you are in
a dialog box you must use the International Alphabet. To review Dialog Box Variables,
say “dialog box variables”. You may also review Variable Lists in the Manual.
A Tutorial on using MathTalk/ScientificNotebook
We will first introduce a number of the more basic commands and then proceed to the
Tutorial in MathTalk/ScientificNotebook. You’ll find it quite easy. You just read along,
follow the instructions and watch what happens. Try it, you’ll like it, it’s fun!!
Voicing Math Symbols
We are going to initially voice some simple symbol commands to give you a quick feel
for how MathTalk/ScientificNotebook works.
Voicing or Typing Text
If you want to voice text, we suggest that you say “show dictation box”, dictate the text,
and then say “OK” to place the text in MathTalk. Say “go to type commands” to view a list
of “type...” commands that will enter short marcoed text into MathTalk without going into
“show dictation box”.
If you choose to type text, you must be in “text mode”. You can get there by saying
“text mode” or clicking the “red M" on the Toolbar which will change to a “black T”.
You can say “type text” which will turn off the microphone and put you in text mode. When
you are ready to return to “math mode”, turn on the microphone.
mouse grid
The “mouse grid” command is a very important command. When you need to click an
option and the Alt commands or key words don’t work, you can always click by using the
“mouse grid” command.
mouse grid on window
Mouse grid on window is the same as mouse grid except that it does not grid the entire
screen. It only grids the part that is the active window. Thus if you are graphing and the
plot properties dialog box is open, you can grid the box only by saying “mouse grid on
window”.
replacing a letter or symbol
This command allows you to replace symbols with different symbols. For example, if
you say “quadratic equation”, you will get ax 2 , bx , c - 0. If you want az 2 , bz , c - 0,
you can just change the x to a z manually. Or you can position the cursor at the beginning of
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the math expression. Then move the cursor to the immediate left of the first x in that math
expression by saying “move right ? spaces”. Now say “replace next character” which
will 1) highlight the first x, 2) open the Replace Dialog Box placing the x in “Search for”,
and 3) place the cursor in “Replace with” position. Now place z in the “Replace with” box by
saying “zulu”. Say “find next”, “replace”, “yes”and then “end replace”. And you will get
az 2 , bz , c - 0.
In the Replace dialog box, be sure “whole words only” is not checked!!
If you wish to replace the next two characters in a math expression, position the cursor to
the immediate left of the two characters, say “replace next two characters”, and follow step
2 above.
Special Note: When the last character(s) to be replaced is selected, say “end replace”.
See the following example.
Suppose that you wish to change the x in the equation
n"n$1#
"a , x# n - a n , na n$1 x , 2! a n$2 x 2 , % , x n to !. Note there are four x’s in this
expression. First place the cursor at the immediate left of the first x (i.e. left most x) in that
expression. Now say “replace next character” which will 1) highlight the first x, 2) open
the Replace Dialog Box placing the x in “Search for”, and 3) place the cursor in “Replace
with” position.
Now place ! in the “Replace with” box by saying “cap greek delta”. Say “find next”,
“replace”, “yes”, “replace” , “replace” and then “end replace”. (Again saying, “replace”
is continued like until the last x that you want to replace is selected. Then with that x still
selected, say “end replace”.)
n"n$1#

The result:
"a , !# n - a n , na n$1 ! , 2! a n$2 ! 2 , % , ! n
Of course, if you wanted to replace all of the x’s to the end of the document with !, you
would just say “replace all”.
For a video demonstration, see the Replace video on the MathTalk Demo CD.
replace text Command
If you wish to replace text, you select the text you want to replace and say “replace text”.
This will then give you the opportunity to replace this text, and any other text that is the
same.
display equation, number equation, remove number, numbering help, end display,
and align here
The display equation command is used to set off an equation or group of equations. It
sets off the equation and places the cursor in the proper position to begin voicing/typing the
equation or set of equations. The equations in the display will all be aligned. If you wish to
align them somewhere other than the equals sign, you can use the command “align here”.
See “Help” in ScientificNotebook if you do not understand the “align here” command.
If you wish to number the equation, this is the place to do so. Just say “number
equation”. Then enter the line number (i.e. 1,2,...) of the display where you want the number
to appear and say “custom” . Now enter the number in parentheses (if you want it in
parentheses) by saying “parentheses” and then the number. Then say “ok”. The display will
appear selected. Say “end display”. If you say anything else before you say “end
display”, you will erase the line! If you do not want to number the equation, say “end
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display” instead of “number equation”. This will take you out of the display box.
In display or to the right of a number, you can remove a number in a single line
equation by saying “remove number” and then saying “none”, “ok” in response to the
dialog box that appears. To get out of display, say “end display”. You can remove the
number in a multiline equation (assuming you entered it in “display equation”) as follows.
With the cursor either in the display or to the right of the number, say “remove number”. In
the dialog box, enter the number of the row of the equation that the display number is on and
say “none”, “ok”. Again, say “end display”. For further instructions on numbering
equations, say “numbering help”.
next line and enter key Commands
As normal, enter key takes you to the next line. However since MathTalk is written in
the section body tag “Body Text”, the enter key will also put you in Body Text Font.
Therefore any time you are entering math symbols, you should go to the next line by
saying “next line.”
move out Command
Display equation, fraction, exponent, etc. are commands that place you in “mathematical
boxes”. Before you can go to the next line (unless you want a new line within the box) you
must be out of a box. The command “move out” will get you out of a single box. However
you could be inside several boxes so you may have to say the command several times.
Alternatively you can say “out all” which moves the cursor out of all the boxes.
Type Face Commands
There are a number of voice commands available to you to change the font appearance in
Text Mode and Math Mode. They include the following:
Bigger font
Bold on
Bold off
Italics on
Italics off
Set font
Smaller font
Underline on (In Text Mode only)
Underline off (In Text Mode only)
Underbar (In Math Mode only)*
*Actually, “underbar” is just one of many Math Talk commands that allow you to put
bars, hats, etc. under and over characters. You can say “decoration menu” to see your
choices.
Want to see some one-liners?
After you have done the training exercise, with ScientificNotebook still open, click on
the microphone.
In each example, some dialog is given which produces the resulting mathematical
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expressions. You should say the dialog as many times as you like. If you say exactly
what the script says, you should get the indicated results. If you go through all of the
examples, even if there are symbols with which you are unfamiliar, you will know how
to use MathTalk/ScientificNotebook.
Pause at the commas between commands. Do not pause between words within
commands. Say all words within the quotes as continuous speech. Be sure to wait until the
math appears on the screen before saying the next command!
For easy viewing, set the screen at 150%. You can change the screen display by
saying “larger”(equals 150%), “much larger”(equals 200%), “normal screen”(equals 100
%), “smaller”(equals 85%), “much smaller”, (equals 50%). You can also say “100
percent”, “200 percent”, “150 percent”, “85 percent”, “50 percent”, or “400 percent”. If
you wish to erase the entire screen, say “select all”, “delete that”.
Example 1: These are examples of voice commands for common mathematical
expressions. Most begin with the word “review”, because they are reviewing the expression.
Remark: If a lengthy equation goes off the screen, say “normal screen” or “smaller”
to see the entire expression . Then say “larger” to return to 150 percent.
Words in quotes are to be said in continuous speech. To go to the next line say “next
line”. Pause between commands and wait for the math to appear on the screen
before continuing! Do not pause within commands.
“You Say”

“You Get”

“3 x-ray plus 4 yankee”, “equals 7”,

3x , 4y - 7

“eleven x-ray square minus 2”

11x 2 $ 2

“9 yankee over twenty-one zulu”

9y
21z

“review binomial squared”

"x , y# 2 - x 2 , 2xy , y 2

“review difference of two squares”

x 2 $ y 2 - "x , y#"x $ y#

“review difference of two cubes”

x 3 $ y 3 - "x $ y#"x 2 , xy , y 2 #

“review sum of two cubes”

x 3 , y 3 - "x , y#"x 2 $ xy , y 2 #

“quadratic equation”

ax 2 , bx , c - 0

“quadratic formula”

x-

$b0 b 2 $4ac
2a

“review quadratic formula”

ax 2 , bx , c - 0 1 x -

“review binomial formula”

"a , x# n - a n , na n$1 x ,

$b0 b 2 $4ac
2a
n"n$1#
2!

a n$2 x 2 , % , x n
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df
dx

“review definition of the derivative”
1
2/ 1

“normal density”
“normal integral”

1
2/ 1

- lim

!x/0

f"x,!x#$f"x#
!x

exp&$ 211 2 "x $ ,# 2 '

x

& $% exp&$ 211 2 "t $ ,# 2 'dt

Letters and Numbers
For available Letter, Greek Letter, and Number variables, say “math talk
learning module” and “sample commands”.
You can voice/type any letters or numbers you want as follows.
Numbers:
a) You can say zero or any integer 1 to 99.
b) For plus/minus numbers, you can say plus/minus any number 1 through 9.
c) If you have trouble with recognition of individual digits, you can say
“numeral #”. For example, “numeral 5”, “numeral 8”.
Examples:
Say: “5”, “comma”, “8”, “comma”, “zero”, “comma”, “99”
To Get: 5, 8, 0, 99
Say: “minus 8”, “comma”, “plus 5”
To get: $8, ,5
Say: “two seven point five eight six”
To Get: 27. 586
Say: “minus point zero three nine four”
To Get: $. 0394
The commands “27.586” and “minus .0394” are examples of the Digits Group
command. This command allows you to say any number in sequence, as well as a negative
sign and a decimal point. You must say the numbers in sequence, i.e., for “27”, you may say
“two seven” or “twenty-seven”. However, you need not pause between digits; in fact, you
should NOT pause between digits. Thus, the whole command should be said in continuous
speech without pausing. You may say single digit numbers, OR without pausing, you may
say, for example, twenty-seven, point, five, eighty-six.
The *Number 1 to 99+ *Letter+, *Greek Letter+ Commands
You can say any number from 1 to 99 followed by any letter in the Letter vocabulary or
followed by any letter in the Greek Letter vocabulary.
Examples:
Say: “x-ray”, “comma”, “3 spaces”, “3 x-ray”, “comma”, “3 spaces”,
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“9 yankee”, “comma”, “3 spaces”, “12 whiskey”, “comma”, “3 spaces”,
“65 alpha”, “comma”, “3 spaces”, “11 cap bravo”, “comma”,
“3 spaces”, “4 greek alpha”, “comma”, “3 spaces”, “21 lambda”,
“comma”, “3 spaces”, “33 beta”
To Get: x, 3x, 9y, 12w, 65a, 11B, 4!, 21+, 33"
“Cap” Commands
To say any uppercase letter, precede it by “cap”. For example say “cap alpha”,
“cap bravo”, “cap x-ray”, “cap yankee”, “cap greek delta”, and
“cap gamma” to get: ABXY!".
Exponents, Superscripts, and Subscripts Commands
You can raise any symbol to any power with the exponent command. For the exponents
2 and 3 you can say square or cube. For higher orders, say the number. You can say (in
continuous speech) “exponent”, followed by any word in the vocabularies “Greek
Letter”, “Letter”, “Minus Letter”, “Numbers”, “Minus Numbers”. To get more
complicated exponents, say “exponent” or “superscript”, pause and enter the exponent
you desire.
You can say any subscript you want by saying “subscript”, pausing and entering the
desired subscript.
To view Sub Sentence Commands, see MathTalk Learning Module.
Examples:
Say: “x-ray square”, “lima cube”, “zulu”, “exponent 6”, “x-ray”,
“exponent minus 4”, “echo”, “exponent
minus pi over 2”
/
To Get: x 2
l3
z6
x $4
e$ 2
Say: “cap victor”, “exponent”, “parentheses”, “x-ray square plus yankee square”,
“move out”, “sine theta”, “end exponent” (or “move out”), “tab key”,
“echo”, “exponent”, “minus”, “one half”, “x-ray square”, “end exponent”.
1 2
2 2
To Get: V x ,y sin (
e$ 2 x
Say: “alpha”, “sub one”, “lambda”, “sub one two”, “sigma”, “sub x-ray”,
“cap whiskey”, “sub x-ray yankee”
To Get: a 1
+ 12
1x
W xy
If you want something more complicated, you just say the symbol and say “subscript”
and enter what you wish. To get out of the subscript, say “end subscript” or “move
out”.
Root “of” Commands
You can say in continuous speech “square root, cube root, 4th root, 5th root, 6th root,
7th root, 8th root, 9th root”, “of” any word in the “Letter”, “Greek Letter”, or

34

“Numbers” vocabulary.
Examples:
Say: “square root of x-ray”, “cube root of cap romeo”, “4th root of beta”,
“5th root of pi”, “6th root of 3”
6 3
3 R
5 /
4 "
To Get: x
If you want something more complicated you can say “square root”, or “cube root” or
“general root”, pause, and put in whatever you want.
Say: “square root”, “x-ray square plus yankee square”, “move out”
To Get: x 2 , y 2
Say: “general root”, “ten”, “tab”, “greek alpha”, “plus”, “beta”, “minus fifteen”,
“move out”
To get: 10 ! , " 2 $ 15
Pre-Algebra Examples
1. Find the volume of a cube with an edge of 4 inches.
Say “4 times 4”, “times 4”, “equals 16”, “times”, “4”, “equals sixty-four”.
Get: 4 8 4 8 4 - 16 8 4 - 64
2. Evaluate the expression 9 , 5"3 , 2 ! 7#.
Say “9 plus 5”, “parentheses”, “3 plus 2”, “times dot”, “7”, “move
out”, “equals 9”, “plus 5”, “parentheses seventeen”, “equals 9”,
“plus”, “eighty-five”, “equals ninety-four”
Get:
9 , 5"3 , 2 ! 7# - 9 , 5"17# - 9 , 85 - 94
3. To simplify 7 ! 121 ! 3 ! 14
Say “parentheses”, “7”, “times dot”, “1 over twelve”, “move out”, “times
dot”, “parentheses”, “3”, “times dot”,“one fourth”, “move out”,
“equals”, “7 over twelve”, “times dot”, “3 over 4”, “equals”,
“twenty-one over forty-eight”, “equals”, “7 over sixteen”.
Get:
7 ! 121 ! 3 ! 14 - 127 ! 34 - 21
- 167
48
4. To simplify 4y , 6y , 8
Say “4 yankee plus 6 yankee”, “plus 8”, “equals”,
“ten yankee”, “plus 8”
Get: 4y , 6y , 8 - 10y , 8
Trigonometry Commands
Examples:
Say: “sine”, “cosine”, “tangent”, “cosecant x”, “cotangent theta”,
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“secant squared fee”, “arc tangent yankee”, “inverse sine theta”,
“hyperbolic cosine lambda”
To Get: sin cos tan

csc x cot ( sec 2 4 arctan y sin $1 (

cosh +

Say: “4”, “plus”, “3 india”, “equals 5”, “parentheses”, “cosine”,
“36”, “degrees”, “52”, “seconds”, “plus india”, “sine”, “36”,
“degrees”, “52”, “seconds”, “move out”
To Get: 4 , 3i - 5"cos 36 ' 52 . , i sin 36 ' 52 . #
The “parentheses” Commands
“Parentheses” commands are commands that are used for entering functions,
intervals, one and two tupels, and parentheses. For example, if you say
“parentheses”, “move out”, “parentheses x-ray”,“parentheses x-ray yankee”,
“parentheses minus one one”, you will get:
"(#

"x#,

"x, y#,

"$1, 1#

and if you say “foxtrot”,“parentheses x-ray”,“beta”,“parentheses x-ray yankee”,
and “cap romeo”,“parentheses lambda theta”, you will get:
f"x#,
""x, y#,
R"+, (#
For a list of “Parentheses” commands, see the MathTalk Learning Module. Or say
“show parentheses commands”.

REMARK: When saying commands, make a brief pause at the
commas between commands. Do not pause if there is no comma. If
the comma is spelled out it is a command, say it just like any other
command.
Examples: (Be sure you pause at the “,” when saying the commands. Do not pause
otherwise.)
Say: “foxtrot”, “parentheses x-ray”, “comma”, “foxtrot”, “parentheses one”,
“comma”, “foxtrot”, “parentheses minus one”, “comma”, “golf ”,
“parentheses yankee”, “comma”, “romeo”, “parentheses sierra”,
“comma”, “lambda”, “parentheses theta”, “comma”, “greek delta”,
“parentheses epsilon”, “comma”, “cap fee”, “parentheses zulu”, “comma”,
“hotel”, “parentheses zero”, “comma”, and “cap gamma”, “parentheses
one half”
To Get: f"x#, f"1# , f"$1#, g"y#, r"s#, +"(#, $"%#, !"z#, h"0#, "" 12 #
Say: “cap foxtrot ”, “parentheses x-ray yankee”, “comma”, “whiskey”, “parentheses
uniform victor”, “comma”, “uniform”, “parentheses romeo theta”, “comma”,
“yankee”, “parentheses minus one one”, “comma”, “foxtrot of x-ray yankee
and zulu”, “comma”, “cap foxtrot of x-ray yankee and zulu”
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To Get: F"x, y#, w"u, v#, u"r, (#, y"$1, 1#, f"x, y, z#, F"x, y, z#
REMARK: The function of three variables is different than one and two variables in that
it only offers you the arguments x, y, z and you simply say “foxtrot of x-ray yankee and
zulu”. There are no other choices for arguments. You can, of course, use the replace
command to replace them or you can manually replace them or voice a two variable function
and augment it. You could also just enter it a letter at a time.
Function *Letter+ Command
Standard functions can be typed by the “parentheses” commands. However if you want
to type something like f"x 2 #, or U" sin 2 (#, you will need to use the command “function
*Letter+”. That is, to get f"x 2 #, say “function foxtrot”, “x-ray square”, “move out”. To
get U" sin 2 (#, say “function cap uniform”, “sine squared theta”, “move out”. To
get F 2 "x#, you need not use the function command. Simply say “cap foxtrot
squared”,“parentheses x-ray”
The “over” Commands
You can say in continuous speech any letter (English or Greek) over any other letter.
You can say in continuous speech any single digit over any letter and any letter over
any single digit.
Examples: (Pause at the “,”)
Say: “x-ray over yankee”, “equals”, “greek alpha over beta”, “equals”,
“cap bravo over 7”, “equals”, “2 over pi”
x
!
B
2
To get:
y - " - 7 - /
You can enter as complicated a fraction as you like by saying “fraction”, entering the
numerator, saying “over”, entering the denominator, and saying “end fraction” or
“move out”.

Say: “romeo”, “equals”, “fraction”, “alpha x-ray”, “plus”, “bravo yankee”,
“over”, “charlie x-ray”, “plus”, “delta yankee”, “end fraction”
To Get: r -

ax,by
cx,dy

“decor” Commands
These commands allow you to place hats, bars, or tildes over any word in the “Letter”
variables and the “Greek Letter” variables. This includes all English upper and lower
case letters and all Greek upper and lower case letters that are supported by Scientific
Notebook. If you wish to put a decoration on more than a single letter, then you use
the “over bar”, “over hat”, “over tilde” commands.
Examples:
Say: “x-ray bar”, “cap x-ray bar”, “theta hat”, “yankee tilde”
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To Get: x

$
(

X

)
y

Say: “over bar”, “x-ray”, “plus yankee”, “move out”, “over hat”,
“alpha”, “theta”, “move out”
To get: x , y

a(

Factorial Commands
You can say, in continuous speech, any English letter factorial, any English letter minus
an English letter factorial, and any English letter factorial plus or minus the digits 1-9.
Examples:
Say: “november factorial”, “mike minus one factorial”, “lima plus three
factorial”, “november minus x-ray factorial”, “x-ray plus yankee factorial”
To Get:

n!"m $ 1#!"l , 3#!"n $ x#!"x , y#!

*Letter+ Square Plus or Minus *Letter+
You can say, in continuous speech, any letter square plus any letter square, and any letter
square minus any letter square.
Examples:
Say: “x-ray square plus yankee square”, “alpha square plus bravo square”,
“greek alpha square plus beta square”, “uniform square minus victor
square”
To Get:

x2 , y2

a2 , b2

!2 , "2

u2 $ v2

*Letter+ plus delta *Letter+ Commands
You can say, in continuous speech, any English letter plus delta any English letter.
Examples:
Say: “x-ray plus delta x-ray”, “yankee plus delta yankee”, “hotel plus delta hotel”,
“victor plus delta victor”, “cap november plus delta cap november”
To Get: x , !x

y , !y

h , !h

v , !v

N , !N

Derivative Commands
You can say, in continuous speech, derivative with respect to any English or Greek
Letter. You can also say in continuous speech d *Letter+ d *Letter+ or d *Letter+
d *Greek Letter+. You can say “first derivative”.
Examples:
Say: “derivative with respect to x-ray”, “derivative with respect to tango”,
“derivative with respect to theta”, “derivative with respect to lambda”,
“delta foxtrot delta x-ray”, “delta cap foxtrot delta x-ray”, “delta romeo
delta theta”, “delta uniform delta victor”, “delta yankee delta x-ray”.
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To Get:

d
dx

d
dt

d
d(

df
dx

d
d+

dF
dx

dr
d(

du
dv

dy
dx

Higher Order Derivative Commands
You can say in continuous speech higher order derivatives (2nd through 9th) of any
English letter with respect to any English letter or Greek Letter. You can also just say
2nd through
9th derivative. Also you can say a letter of the alphabet derivative, i.e. to
dny
get dx n , say “november derivative”.
Examples:
Say: “second derivative of yankee with respect x-ray”, “fourth derivative of romeo
with respect to theta”, “third derivative of cap golg with respect to tango”,
“fourth derivative”, “ninth derivative”, “mike derivative”, “kilo derivative”.
To Get:

d2y
dx 2

d4r
d( 4

d3G
dt 3

d4y
dx 4

d9y
dx 9

dmy
dx m

dky
dx k

Partial Derivative Commands
You can say any of the following commands. Examples of each are shown.
mixed partial of *Letter+ with respect to *Greek Letter+ and *Greek Letter+
#2f
Say: “mixed partial of foxtrot with respect to romeo and tau”, to get: #r#2
mixed partial of *Letter+ with respect to *Letter+ and *Greek Letter+
#2y
Say: “mixed partial of yankee with respect to romeo and theta”, to get: #r#(
mixed partial of *Letter+ with respect to *Letter+ and *Letter+
#2F
Say: “mixed partial of cap foxtrot with respect to x-ray and yankee”, to get: #x#y
partial of *Letter+ of *Letter+ and *Letter+ with respect to *Letter+
#f"x,y#
Say: “partial of foxtrot of x-ray and yankee with respect to x-ray”, to get: #x
partial of *Letter+ with respect to *Greek Letter+
#r
Say: “partial of romeo with respect to theta”, to get: #(
partial of *Letter+ with respect to *Letter+
Say: “partial of cap lima with respect to sierra”, to get: #L
#s
partial with respect to *Greek Letter+
#
Say: “partial with respect to omega”, to get: #7
partial with respect to *Letter+
Say: “partial with respect to x-ray”, to get: #x#
second partial of *Letter+ with respect to *Greek Letter+
#2h
Say: “second partial of hotel with respect to beta”, to get: #"
2
second partial of *Letter+ with respect to *Letter+
Say: “second partial of yankee with respect to whiskey”, to get:
cross partial
#2f
Say: “cross partial” to get: #y#x

#2y
#w 2
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mixed partial
#2f
Say: “mixed partial” to get: #y#x
partial derivative
#y
Say: “partial derivative” to get: #x
partial
Say: “partial” to get: #
second partial
Say: “second partial” to get: # 2
Differential Commands
In the example below, don’t forget to pause at the commas or you will get
a derivative. (That is say “delta yankee”, “delta x-ray”, not “dy dx”.)
Say: “delta yankee”, “delta x-ray”, “delta zulu”, “tab key”, “delta
fee”, “delta theta”, “delta lambda”.
To get: dy dx dz
d4 d( d+
Integral Commands
[integral]
[integral with joint scripts]

Resulting Action

&
*
&*
*

[integral with limits]

&

*

[integral with lower limit]

&
*

&*
[integral with subscript]
In each case the cursor will be at the lower limit. You can enter any lower limit you want
and then say “upper limit” (if required). After entering the upper limit, say “end upper
limit”, “end limits”, or “move out”. If you want limits and you said “integral”, you can add
a lower limit as a subscript by saying “subscript” and proceeding as in “integral with joint
scripts”.
An easy way to add most limits: Use the limits command listed below.
Limits * + to * +
This command puts limits on integrals, sums, products, unions, intersections, and vertical
bars. You say, in continuous speech, “limits * + to * +”, where the * +’s can be filled in
with any word in the Letter, Greek Letter, Numbers, Minus Letter, or Minus Numbers
vocabularies. Only use this command when the cursor is positioned at the lower limit or
subscript!
Examples:
Say: “integral with limits”, “limits alpha to 2 pi”, “integral with joint scripts”,
“limits minus infinity to infinity”, “sum with limits”, “kilo”, “equals”,
“limits 1 to november”, “union with limits”, “india”, “equals”, “limits
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minus mike to mike”, “vertical bar with limits”, “limits minus 5 to 5”,
“integral”, “lower limit”, “x-ray square”, “upper limit”, “x-ray”, “plus 2”,
“move out”, “natural log yankee”, “delta yankee”, “integral with
limits”, “tango”, “minus one”, “upper limit”, “tango”, “plus one”, “end
upper limit”, “yankee”, “exponent 4”, “delta yankee”
2/

To Get: &
a

%

& $%

n

(
k-1

m

+

i-$m

| 5$5

x,2

& x 2 ln ydy

t,1

& y 4 dy

t$1

Sum or Summation Commands
You can say “sum “ or “summation”, in any of the commands that include limits or
scripts. They perform the same action. Pick the one that gives you the best word
recognition.
The basic commands are:
[summation] Here you must say “summation”, you cannot say “sum”.
[sum with joint scripts]
[summation with joint scripts]
[sum with limits]
[summation with limits]
[sum with lower limit]
[summation with lower limit]
[sum with subscript]
[summation with subscript]
After adding the index, the limits are added just as with integrals.
Example:
Say: “sum with limits”, “mike”, “equals”, “limits zero to infinity”
%

To Get: (

m-0

Union, Intersection, Product, Vertical Bar Commands
The commands are the same as for integrals and sums, and they work the
same way. They are:
“union with limits”, or “union with joint scripts”
“intersection with limit”, or “intersection with joint scripts”
“product with limits”, or “product with joint scripts”
“vertical bar with limits”, “vertical bar”, “victor bar”
Matrix and Determinant Commands
You can enter any n 8 m matrix, where 1 ) n ) 9 and 1 ) m ) 9, with
paren notation, i.e. " #, or “bracket matrix”, i.e., - notation. You can also
enter a determinant in the same way.
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Example:
Say: “2 by 2 bracket matrix”, “x-ray”, “sub one one”,“tab key”,
“x-ray”, “sub one two”,“tab key”, “x-ray”, “sub two one”, “tab key”,
“x-ray”, “sub two two”, “end matrix”
To Get:

x 11 x 12
x 21 x 22

Type Commands A list of Type Commands which enter Connecting words is detailed
in the MathTalk Learning Module. You mat say “show type commands” to view these
commands.
In the following examples, we will issue several commands in a row, separated by spaces
and commas. Say the commands in continuous speech, but pause between commands.
WAIT FOR THE MATH TO APPEAR ON THE SCREEN BEFORE VOICING THE
NEXT COMMAND. Commands are set off in quotes. For example, if you say (pausing at
the commas) “cap x-ray”, “sub tango”, “comma”, “four spaces ”, “cap x-ray”,
“parentheses tango”, you’ll get X t , X"t#. Try it! Don’t forget to go to the next
line by saying “next line”.
You Say
You Get
“cap x-ray”, “sub tango”, “comma”, “four spaces”,
“cap x-ray”, “parentheses tango”, “four spaces”, “cap yankee bar”, “comma”,
“yankee bar”, “comma”, “theta hat”, “comma”, “x-ray”, “sub india juliette”
X t , X"t# Y , y , ( , x ij
REMARK: To maximize speech recognition, speak at a firm, steady pace. Also,
emphasize small differences in commands. We’ll call your attention to this and other
suggestions as we go through this Tutorial.
“integral”, “comma”, “tab key”,
“integral with joint scripts”, “limits minus infinity to infinity”,
“integral with joint scripts”, “limits zero to infinity”, “comma”,
“tab key”, “double integral”, “comma”,
%
%
&,
& & ,
&&,
“tab key”, “contour integral”

*

$% 0

“delta uniform delta x-ray”, “comma”, “delta victor delta x-ray”, “comma”,
“delta yankee delta x-ray”, “comma”, “tab key”, “first derivative”,
“comma”, “second derivative”,
dy d 2 y d 3 y
du dv dy
“comma”, “third derivative”
, , ,
,
,
dx dx 2 dx 3
dx dx dx
“mixed partial of foxtrot with respect to
x-ray and yankee”, “comma”, “tab key”, “mixed
partial of cap * foxtrot with respect to x-ray and yankee”
(*Here you should emphasize the word “cap”)

#2f
#y#x

,

#2F
#y#x
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“echo”,“exponent”, “minus, “one-half”
“tango square”, “end exponent”, “comma”, “tab key”,
1 2
“echo”, “exponent minus x-ray”, “comma”,
e! 2 t ,
“tab key”, “echo”, “exponent 3 pi over 2”

e !x ,

e

3!
2

Example 2: Now we’ll write a few one-line equations by voice in ScientificNotebook.
Words in quotes are to be said with continuous speech. Slight pauses should be
made at the commas. Say “next line” to go to the next line.
You Say

You Get

“three”, “x-ray cube”, “plus”, “x-ray square”
“minus four”, “equals zero”

3x 3 ! x 2 ! 4 " 0

“absolute value”, “x-ray”, “move out”, “equals”
“expanding left brace”, “minus x-ray”, “comma”,
“four spaces”, “x-ray”, “less than or equal to”,
“zero”, “next line”, “x-ray”, “comma”, “four spaces”,
“x-ray”, “greater than or equal to”, “zero”, “out all”.*
!x, x " 0

|x| "

x, x # 0
* “out all” is a command that will move the cursor out of all boxes. Here you could
have said “move out” twice to get the same result.
“sine squared theta”, “plus”, “cosine
squared theta”, “equals one”

sin 2 " ! cos 2 " " 1

“cap foxtrot”, “parentheses x-ray”, “equals”,
“normal integral”
F!x" " 1

x

2! #

“alpha romeo process”

$ !% exp#! 2#1 2 !t ! $" 2 $dt

X t ! % 1 X t!1 ! % 2 X t!2 ! % ! % p X t!p " a t

“juliette november”, “equals”, “bessel function”

“3 delta wave equation”

'2u
't 2

%

J n !t" " &

!!1" k

k"0

! c2

'2u
'x 2

!

'2u
'y 2

t
2

n!2k

k!#!n!k!1"

!

'2u
'z 2

"0
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“bold cap x-ray”, “equals”, “x-ray matrix”
x 11 x 12 % x 1n
x 21 x 22 % x 2n

X"

&

&

' &

x m1 x m2 % x mn

“yankee”, “double prime”, “plus”, “x-ray square”,
“yankee”, “prime”, “minus yankee”, “equals”
“sine squared x-ray

y $$ ! x 2 y $ ! y " sin 2 x

“bold cap x-ray”, “bold cap x-ray”, “inverse”,
“equals”, “identity matrix”
1 0 % 0
XX !1 "

0 1 % 0
&

&

' &

0 0 % 1
Tip: You can go to the top of any document by saying “top of document”. Similarly,
you can go to the bottom by saying “bottom of document”.
Example 3: In this example, we will introduce Type Commands. These are words that
are often used while entering math expression, such as “Thus”, “Therefore”, “Consequently”,
“is”, “if”, “or”, “odd”, “and”, etc. When you want to use a connecting word command you
must precede it by the word “type”. Thus you would say “type therefore” if you wanted the
word “therefore” inserted (first, you may need to say “text mode”). This example will
demonstrate the use of the Type Commands.
First, we intend to enter the text and mathematics below, beginning with (a) and ending
3% 5 i
with 2 .
(a)
Use the quadratic formula to find the roots of x 2 ! 3x ! 4 " 0.
ax 2 ! bx ! c " 0 & x "

!b % b 2 ! 4ac
2a

Therefore
3% 9!4&4
2
3 % 9 ! 16
"
2
3% 5i
"
.
2

x"

REMARK: If you wish to type the text, you may type all the text rather than dictating it.
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In that case, say “type text”. When you finish, turn on the microphone to return to entering
math. Otherwise proceed as follows. Pause at the commas. Do not pause within a
command.
Say: next line, show dictation box, dictate the following text: left parenthesis, alpha
(it may be necessary to correct this to get "a"), right parenthesis, cap use the quadratic
formula to find the roots of, OK (will be back in math), 2 spaces, x-ray square minus
3, x-ray plus 4, equals zero, period, display equation, review quadratic formula,
end display, next line, type therefore, display equation, x-ray, equals, fraction, 3,
plus or minus, square root, 9 minus 4, times 4, move out, over, 2, move out (or
“end fraction”), next line, equals, fraction, 3, plus or minus, square root, 9 minus
sixteen, move out, over, 2, move out, next line, equals, fraction, 3, plus or
minus, square root of 5, move out, india, over, 2, move out, period, end display.
You Get
(a)
Use the quadratic formula to find the roots of x 2 ! 3x ! 4 " 0.
ax 2 ! bx ! c " 0 & x "

!b % b 2 ! 4ac
2a

Therefore
3% 9!4&4
2
3 % 9 ! 16
"
2
3% 5i
"
.
2

x"

Read This! If you plan to output in Braille the document on which you are working,
we strongly recommend that you do not use the “display equation” command. Although
it is possible that the translator will correctly interpret equations in the “display”
format, it is highly likely that it will not. We will therefore repeat the example, but
without using “display equation”.
Example 3 repeated without using the command “display equation”
Say: next line, show dictation box, dictate the following text: left parenthesis, alpha
(it may be necessary to correct this to get "a"), right parenthesis, cap use the quadratic
formula to find the roots of, OK (will be back in math), 2 spaces, x-ray square
minus 3, x-ray plus 4, equals zero, period, next line, review quadratic formula,
next line, type therefore, next line, next line, x-ray, equals, fraction, 3, plus or
minus, square root, 9 minus 4, times 4, move out, over, 2, move out, next line, 5
spaces, equals, fraction, 3, plus or minus, square root, 9 minus sixteen, move
out, over, 2, move out, next line, 5 spaces, equals, fraction, 3, plus or minus,
square root of 5, move out, india, over, 2, move out, period.
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You Get:
(a)
Use the quadratic formula to find the roots of x 2 ! 3x ! 4 " 0.
ax 2 ! bx ! c " 0 & x "
Therefore
3% 9!4&4
x"
2
"
"

!b% b 2 !4ac
2a

3% 9!16
2
3% 5 i
.
2

In the first part of this example, we showed how to add text by saying “show dictation
box”, dictating the text, and then saying “OK” to place the text in MathTalk. We also used
the connecting word Therefore. Connecting words are words that are often used in
mathematical expressions to connect one set of expressions to another or to state a condition.
When entering a connecting word by voice always precede it by the word “type”. For
example, say “type for” to enter the connecting word “for”. For a list of connecting words,
see the Table of Contents or say “go to type commands”.
%

2

Now, we will solve the problem, “show that $ e !t dt " ! . You will note that we
!%
only need Connecting words, so we never have to go to Text Mode. In Math Mode, start a
new line by saying “next line”.
You Say : type cap let*, 5 spaces, x-ray, equals, romeo, cosine theta,
comma, 5 spaces, yankee, equals, romeo, sine theta, period, 5 spaces, type cap
then*, display equation, parentheses, integral with joint scripts, limits minus
infinity to infinity, echo, exponent, minus, tango square, end exponent, delta
tango, move out, squared, equals, integral with joint scripts, limits minus infinity
to infinity, integral with joint scripts, limits minus infinity to infinity, echo,
exponent, minus, parentheses, x-ray square plus yankee square, move out, end
exponent, delta x-ray, delta yankee, next line, equals two, integral with joint
scripts, limits zero to pi, integral with joint scripts, limits zero to infinity, echo,
exponent, minus, romeo square, end exponent, romeo, delta romeo, delta theta,
next line, equals, minus, integral with joint scripts, limits zero to pi, echo,
exponent, minus, romeo square, end exponent, vertical bar with limits, limits
zero to infinity, delta theta, next line, equals, integral with joint scripts, limits zero
to pi, delta theta, equals, pi, period, end display next line, type therefore*, 5
spaces, integral with joint scripts, limits minus infinity to infinity, echo, exponent,
minus, tango square, end exponent, delta tango, equals, square root of pi, move
out, period .
*These are connecting words.
You Get :
Let
x " r cos ",

y " r sin ". Then
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%

$ !% e !t

2

dt

2

"

%

%

$ !% $ !% e !!x !y " dx dy

" 2$

!

2

%

2

$ e !r r dr d"
0 0
!

2

" ! $ e !r | %0 d"
"

!

2

0

$ 0 d" " !.

%

$ !% e !t 2 dt " ! .

Therefore

Again, to emphasize that if you want an output in Braille do not use the command
“display equation”, we repeat the last part of the example without using the command
display equation. Also we will introduce some new commands, 2 lines, 2 tabs, 5 spaces, and
5 spaces. We use these commands to improve the appearance of the display. You can say “x
spaces”, where x ranges from 1 to 5. You can also say 3 lines and 3 tabs. The line
commands just add extra “enters” for spacing and keep you in Math Mode.
You Say : next line, parentheses, integral with joint scripts, limits minus infinity
to infinity, echo, exponent, minus, tango square, end exponent, delta tango,
move out, squared, equals, integral with joint scripts, limits minus infinity to
infinity, integral with joint scripts, limits minus infinity to infinity, echo, exponent,
minus, parentheses, x-ray square plus yankee square, out all*, delta x-ray, delta
yankee, 2 lines, 3 tabs, four spaces equals two, integral with joint scripts, limits
zero to pi, integral with joint scripts, limits zero to infinity, echo, exponent, minus,
romeo square, end exponent, romeo, delta romeo, delta theta, 2 lines, 3 tabs,
four spaces, equals, minus, integral with joint scripts, limits zero to pi, echo,
exponent, minus, romeo square, end exponent, vertical bar with limits, limits zero
to infinity, delta theta, 2 lines, 3 tabs, four spaces, equals, integral with joint
scripts, limits zero to pi, delta theta, equals, pi, period, 2 lines, type therefore,
5 spaces, integral with joint scripts, limits minus infinity to infinity, echo, exponent,
minus, tango square, end exponent, delta tango, equals, square root of pi, move
out, period .
* Note that here we used the command out all to get us out of both the exponent and the parentheses.
You Get :
%

$ !% e !t 2 dt

2

"$

%

%

$ e!

x 2 !y 2

! %

2

!% !%

dxdy

" 2 $ $ e !r rdrd"
0

!

0

2

" ! $ e !r | %0 d"
0

!

" $ d" " !.
0

Therefore

%

$ !% e !t 2 dt " ! .
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More on Text Mode / Math Mode
As the final part of this example, we are going to add text created in Dragon.
We are going to type the following (beginning with “Let ...” and ending with
“ ...complete the proof.”)
REMARK: The Greek letter Phi is used here. For better recognition we spell it “fee” in
all of the commands. Therefore you should say “fee”.
Let #% n : n " 1, 2, 3%$ be an orthogonal basis and show that
1

$ 0 a!x" dx "lim sup % n !a"
n'%

1

$ 0 a!x"b!x" dx "lim sup ' n !a, b"

1.2

n'%

to complete the proof.
You Say : type cap let, 2 spaces, braces, fee, sub november, colon, november,
equals, sequence one two three, move out, 5 spaces, show dictation box, dictate the
following text: be an orthogonal basis and show that, OK (will be back in math),
display equation, integral with joint scripts, limits zero to one, alpha, parentheses
x-ray, delta x-ray, less than or equal to, bottom label, limit superior, tab key,
november goes to infinity, move out, fee, sub november, parentheses, alpha,
move out, next line, integral with joint scripts, limits zero to one, alpha,
parentheses x-ray, bravo, parentheses x-ray, delta x-ray, less than or equal to,
bottom label, limit superior, tab key, november goes to infinity, move out, sigh
(for greek Psi), sub november, parentheses alpha bravo, move out, number
equation, two, custom, one point two, ok, end display, next line, show dictation
box, dictate the following text: to complete the proof period, OK (will be back in
math).
You Get :
Let #% n : n " 1, 2, 3, % $ be an orthogonal basis and show that
1

$ 0 a!x" dx "lim sup % n !a"
n'%

1

$ 0 a!x"b!x" dx "lim sup ' n !a, b"

1.2

n'%

to complete the proof.
REMARK: The dialogue in the number equations box will be clear. When there is more
than one line in the equation you will probably always choose “custom”. The command
“number equation” can only be used in the display equation box!
In the next example, we will work several problems ranging from simple to difficult.
You need not work through all of them, but we recommend that you read through all of them
and voice some of them. You will, we think, be surprised and impressed with the power of
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MathTalk in the “Compute Mode”.
Remark: If you wanted to type the text, rather than dictate it, you say “type text”
instead of “text mode”!! Remember, “type text” also turns off the voice bar, and you
will have to turn it back on manually.

Solving Problems Using The Compute Mode

* MuPad is the computation engine used for these computations.
Example 4: Working math problems by voice in ScientificNotebook using the
Compute feature: (Words between commas are to be said with continuous
speech. Pause at the commas and wait for the math to be created before
continuing.)
Problem 1:

Factor x 2 ! y 2

Solution :

Say “x-ray square minus yankee square”, “factor”.

You’ll get:

x 2 ! y 2 " !x ! y"!x ! y"

Problem 2:

Combine and simplify the sum

3x 2 !3x
8x 2 !7

!

5x 2 !3
2x 2 !x!7

Solution :
Say: “fraction”, “3 x-ray square”, “plus 3 x-ray”, “over”,
“8 x-ray square plus 7”, “move out”, “plus”, “fraction”,
“5 x-ray square plus 3”, “over”, “2 x-ray square”, “plus x-ray”,
“plus 7”, “move out”, “simplify”.
You’ll get:

Problem 3:

3x 2 !3x
8x 2 !7

!

5x 2 !3
2x 2 !x!7

"

46x 4 !9x 3 !83x 2 !21x!21
8x 2 !7 2x 2 !x!7

Solve the following equation x 3 ! x 2 ! x ! 1 " 0.

Solution :
Say “x-ray cube”, “minus”, “x-ray square”, “plus x-ray”,
“minus one”, “equals zero”, “solve”
You’ll get:

x 3 ! x 2 ! x ! 1 " 0, Solution is: 1, !i, i
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Problem 4:

Solve the following linear system:
x ! y ! 2z " 1
2x ! 4y ! z " 0
2y ! 3z " !1

Solution :
Say: “3 by 3 system”, “x-ray plus yankee”, “minus
2 zulu”, “equals one”, “tab key”, “2 x-ray minus 4 yankee”,
“plus zulu”, “equals zero”, “tab key”, “2 yankee minus 3 zulu”,
“equals minus one”, “solve exact”.
x ! y ! 2z " 1
2x ! 4y ! z " 0 , Solution is: x "

You’ll get:

17
8

,y "

11
8

,z "

5
4

2y ! 3z " !1

%

2

Problem 5: Evaluate $ e !t dt.
!%
Note: We did this the hard way in Example 3. Now we’ll do it the easy way.
Solution :
Say “integral with joint scripts”, “limits minus infinity to infinity”,
“echo”, “exponent”, “minus”, “tango square”, “move out*”, “delta tango”,
“evaluate”.
You’ll get :

%

$ !% e !t 2 dt " !

I told you it was the easy way!

*You can also say “end exponent” here.
REMARK: In the following examples, a dialog box will open in the process. You’ll
have no trouble knowing what to say, since the choices will be on the screen in front of you.
However, in dialog boxes, when entering English letters you must use the International
Alphabet!!

Problem 6:

Use integration by parts to find $ x sin 2x dx.

Solution :
Say “integral”, “x-ray”, “sine”, “2 x-ray”, “delta x-ray”, “integrate
by parts”, “x-ray”, “ ok”, “evaluate”.

$ x sin 2x dx " ! 12 x cos 2x ! $ ! 12 cos 2x dx "
You’ll get:
1
cos x sin x ! $ 0 dx ! 12 x cos 2x " 12 cos x sin x ! 12 x cos 2x
2
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Problem 7:

a) Find the exact general solution to the ODE
y $ ! 1x y " cos x.
b) Use the series method to find the general solution to the ODE
y $$ ! xy $ ! y " sin x.

Solution :
a) Say: “yankee prime”, “plus”, “1 over x-ray”, “yankee”,
“equals”, “cosine x-ray”, “solve oscar delta echo”, “x-ray”, “ok”.
You’ll get:

y$ !

1
x

y " cos x, Exact solution is: ! 1x !C 4 ! cos x ! x sin x"

b) Say: “yankee double prime”, “plus x-ray”, “yankee
prime”, “plus yankee”, “equals”, “sine x-ray”, “series solution”,
“x-ray”, “ok”.
You’ll get:
y $$ ! xy $ ! y " sin x, Series solution is:
$
y!0" ! xy !0" ! 12 x 2 y!0" ! x 3 ! 13 y $ !0" ! 16 ! 18 x 4 y!0" ! O!x 5 "
Note: You can get the solution to as many terms as you want by saying “change
series order” and entering the order you desire.
Problem 8:

a) Generate 9 values of a normal, mean 1, variance 4 (i.e., N(1,4)),
random variable.(Remember, variance 4 implies that the standard
deviation is 2.)
b) Calculate the sample mean, median, standard deviation and variance
of this data.
c) Find the following z-values from a N(0,1): Z .1 , Z .05 , Z .025 , Z .01 .

Solutions :

a) Say “random numbers”, “9”, “normal”, “one”, “tab”,
“two”, “ok”.

We got (you’ll get something different):
1. 248 3, 4. 646 4, !. 263 19, !3. 659 2, !2. 910 2, !. 627 62, 4. 727 8, 4. 919, 2. 037 3
b) For each of the following commands position the cursor in the data
or immediately at it’s end, and say “sample mean”, “sample
median”, “sample standard deviation”, “sample variance”.
Note: Here you will need to move the cursor to the proper position before you say the
next command. This can be done by keyboard, mouse, or voice.
We got (you’ll get something different):
Variance(s): 10. 599, Standard deviation(s): 3. 255 6, Mean(s): 1. 124 3,
Median(s): 1. 124 3
Actually, you will not get the same numbers, since they are random. You will get
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similar numbers along with the corresponding sample mean, median, std. dev.,
variance.
Solution :
You’ll get:

c) Say “zulu point one”, “comma”, zulu point zero five”, “comma”,
“zulu point zero two five”,“comma”, “zulu point zero one”.
z .1 " 1. 282, z .05 " 1. 645, z .025 " 1. 960, z .01 " 2. 326

Problem 9: Matrix example. Here you can enter any matrix you want by
saying “matrix”, or “bracket matrix” if you want brackets rather than parens. When the
dialog box comes up, answer the questions. To get the matrix below, we said “bracket
matrix”, “4”, “columns”, “4”, “ok” and then entered the numbers, moving from cell to cell
by saying “tab key”. Each time with the cursor in or directly following the matrix,
say “positive definite”, “matrix determinant”, “matrix inverse”.
6 2 2 2
You’ll get:

2 2 1 1
2 1 2 1
2 1 1 2

, inverse:

1
3
! 16
! 16
! 16

! 16

! 16

! 16

5
6
! 16
! 16

! 16

! 16

5
6
! 16

! 16

, determinant: 12 is positive definite

5
6

You can get most any characteristic of a matrix that you want by saying “matrix menu”
and then saying the property listed on the menu. For example, for the matrix below place the
cursor in or directly behind the matrix and say “matrix menu”, “eigenvalues”. Place the
cursor back in the matrix and say “matrix menu”, “characteristic polynomial”. You’ll get
4 2 2
2 2 1

, characteristic polynomial: X 3 ! 8X 2 ! 11X ! 4,

2 1 2
eigenvalues: 1, 72 ! 12 33 , 12 33 ! 72
Note: After each command, you will have to place the cursor in the matrix. Also, you
must say “matrix menu” to see what your options are. This will bring up the matrix menu
and you can say anything on the menu.
REMARK: Using Help. You can get the Help Menu by saying “help”. You can move
to any subtopic in Help by saying the name of the subtopic. For example, if you want to
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search, say “search”. When you get to where you want to be, either spell in the search words
(using the International Alphabet), or dictate the search words. You can, of course, type
from the keyboard.
2

Problem 10: Find the first four derivatives of e x .
REMARK: If you have previously defined x or y, say “clear definitions” before you
do this example. If you don’t know if you already have x and y defined, say “show
definitions”.
Solution :
Say: “yankee”, “equals echo”, “exponent”, “x-ray square”, “move out”,
“define equal”, “next line”, “first derivative”, “evaluate”, “next line”, “second
derivative”, “evaluate”, “next line”, “third derivative”, “evaluate”, “next line”, “fourth
derivative”, “evaluate”.
You’ll get:
2
y " ex
2
dy
" 2xe x
dx
2
2
d2y
" 2e x ! 4x 2 e x
dx 2
d3y
dx 3
d4y
dx 4

2

" 12xe x ! 8x 3 e x
2

2
2

" 12e x ! 48x 2 e x ! 16x 4 e x

2

Remark: Say “clear definitions” NOW! If you fail to clear the definitions, the
2
graphing in the next section will not always work since y will still be defined as y " e x .
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Graphing by Voice Commands

* MuPad is the computation engine used for these computations.
Example 5: Graphing by voice in Scientific Notebook.
In graphing functions and data, MathTalk employs the following convention:
1. 2 D graphs or data are plotted point by point if you voice a “plot” command.
2. 2 D graphs or data are plotted continuously (i.e. connected lines) if you voice
a “graph” command.
3. 3 D graphs are plotted the same whether you ‘plot’ or ‘graph’.
For example if you say “plot data”, “plot points”, or “plot this” the data or curve will be
plotted point-wise. If you say “graph this” or “graph data”, the data will be plotted as a
continuous curve. The commands “plot data”, “plot this”, and “graph this” are by default
always 2 D rectangular coordinates.
Setting the range
For a graph or a plot to be useful, it must be plotted over the range of interest. Although
Scientific Notebook selects a default range that is often the appropriate range, this is not
always the case. Therefore, at times you will need to change the range. This is done in Plot
Properties. In the examples below, we will demonstrate how to change the range and how to
reset other plot properties.
Before we begin graphing, we need to set some defaults for 3d graphs to make our graphs
more understandable. We will first set the color at Z (greyscale) and the surface at mesh. In
the last part of this example, we will show you how you can change those settings.
Say: “tools”, “computation setup”, “three d plot”, “surface mesh”, “drop list”.
Now using the “move down 1” command, and/or “move up 1” command, scroll
to “mesh”.
Then
Say: “directional shading”, “drop list”.
Again, using the “move up/down” commands, scroll to Z greyscale. Now
Say: “ok”, “ok”.
Graphing defined functions
Graph y " x and y " x 2 on the same graph. Use rectangular coordinates.
a) Say “x-ray”, “add expresssion”. In the Items Plotted dialog box, say
“x-ray squared”, “click OK” .
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You’ll get
y

25

20

15

10

5
0
-5

-2.5

0

2.5

5
x

-5
x
REMARK: You must be in Math Mode (i.e. the “red M”) when saying any
equation or graph command. Saying “next line” will accomplish this.
REMARK: If instead you said “x-ray”, “add plot expresssion”, and then in the Items
Plotted dialog box said “x-ray squared”, “click OK”, you would get

y

25

20

15

10

5
0
-5

x

-2.5

0

2.5

5
x

-5

b) Graph r " 1 ! cos " in polar coordinates.
Say: “one”, “minus”, “cosine theta”, “graph polar”.
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You’ll get:
y
1

0.5

0
-2

-1.5

-1

-0.5

0
x
-0.5

-1

1 ! cos "
c) Graph x sin

1
x

, x, ! x on the same graph.

Say: “x-ray”, “sine”, “one over x-ray”, “add expressiosn”. In the Items Plotted
dialog box, say “x-ray”, “add item”, “minus x-ray”, “click OK”.
You will get the following graph:
y

5

2.5

0
-5

-2.5

0

2.5

5
x

-2.5

x sin

1
x

-5

In this case, our interest is in the behavior close to the origin, so we need to change the
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range. To do this, “click” the graph. Probably the easiest way to do this is to:
Say: “mouse grid”. Then say any number that’s on the graph.
Now say: “button click”. A small square will appear in the bottom right-hand corner of
the graph. Click that square. Again, the easiest way is probably to use the mouse grid.
When you click this box, the “Plot Properties” dialog box will open.
Note: The ledger names do not have a letter underlined, so you cannot use the alt key to
open them. You can, however, say the name of the ledger.
Say: “view”, (to uncheck default) “default”, “x-ray”, “minus”, “point numeral 2”,
“tab key”, “point numeral 2”, “tab key”, “minus”, “point numeral 2”, “tab key”,
“point numeral 2”, (while in "View" to label the graph, say “plot labels”), “ok”.
After the graph appears, click a vacant spot on the screen to remove the boxed outline.
You can say “button click” to accomplish this.
* Can say “move mouse right”, “stop” (when mouse is out of graph), “button click”.
Warning! Be sure you are in an open place on the screen and not on a margin
surrounding the screen. Clicking a margin may erase your graph!
You’ll get
y

0.2

0.1

0
-0.2

-0.1

0

0.1

0.2
x

-0.1

x sin

1
x

-0.2

d) We will now plot the 3 dimensional graph of x 2 y 3 , followed by the 3d graph of
x 2 sin xy ! y 2 cos xy. For the second graph, we will go to “Plot Properties”
and install the following settings: (We’ll tell you below how to install them.)
1. Set the range of x and y as !3. 14 to 3. 14.
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2. Set the range of z at !25 to 25.
3. Set the shading at Z (hue).
4. Set the surface mesh at “mesh”.
5. Set the surface style at Color Patch.
Here is the dialog to accomplish all of this! First, say “next line” to start on
a new line and
Say: “x-ray square”, “yankee cube”, “3 delta graph”.
You should get

2500

1250

-5
5

-2.5
2.5

00

x

-2.5
2.5

-5
5
y

-1250

-2500
z

x2y3
Say: “next line”, “x-ray square”, “sine x-ray”, “yankee”, “plus”, “yankee
square”, “cosine”, “x-ray yankee”, “3 delta graph”.
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You should get

25
12.5
-5
5

-2.5
2.5

00

x

-2.5
2.5

-12.5

-5
5
y

-25
z

x 2 sin xy ! y 2 cos xy
Now we want to change the range and the color scheme. To do this we need to place the
cursor on the graph and say “button click”. You can do this by mouse commands. ( If you
use the mouse grid, some delay can occur due to replotting of the graph. If this happens just
say “button click” again.)
Repeat the procedure to click the small box on the lower right-hand corner of the graph.
Since the box is small, it is probably best to use the mouse grid here. When you do this, the
Plot Properties dialog box will open.
Say: “View”, “default”, “x-ray”, “minus 3.14”, “tab key”, “3.14”, “tab key,
“minus 3.14”, “tab key”, “3.14”, “tab key”, “minus 25”, “tab key”, “25”,
(while in "View" to label the graph, say “plot labels”).
Then say “items plotted”, “directional shading”, “drop list”.
Now scroll up or down to “Z hue” by using the “up/down one” commands.
Say: “surface mesh”, “drop list”. As before, scroll up or down to “mesh”.
Say: “surface style”, “drop list”. Scroll again to “color patch”.
Then say: “ok”. Be sure the mouse is not on the margin or when you click the
screen you will lose your graph! Now click an open space on the screen to remove the
boxed frame.
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The result should be:

10
5
-2.5
2.5

-1.25
1.25

00
-5

x

-1.25
1.25

-2.5
2.5
y

-10
z

x 2 sin xy ! y 2 cos xy
Plotting Data and Curve Fitting
Note: In several cases, a command will open a dialog box. In such cases, you
should wait for the dialogue to appear before issuing the next command.
In this example, we demonstrate how to plot data and fit a curve to it by voice using
Scientific Notebook. We also want to compare the plotted graph with the fitted graph by
placing them side by side. Currently the default for graphs is probably set at “Displayed”.
To put the graphs side by side, we need to change that to “in line”. To do this
say “Tools”, “computation setup”, “plot layout”, “in line”, “ok” (All of these choices will
be in front of you on the menu. Also, this will make the default “in line” until you change it.)
Now, to enter the data, say “next line” and “enter data”. You’ll get a dialog box.
Since we are going to put in 5 data pairs say “5”, (* if columns is a number different than
2, say “columns”, “2” before saying) “ok”. A matrix will appear with the cursor in the
upper left hand corner.
Say: “zero”, “tab”, “6”, “tab”, “1”, “tab”, “point numeral 1”, “tab”, “2”, “tab”,
“minus 3”, “tab”, “3”, “tab”, “2”, “tab”, “4”, “tab”, “8”.
You will have now have created the data matrix shown below. To plot the data,
say: “graph this”.
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You’ll get
y

7.5
6.25
5
3.75
2.5
1.25
0

0

6

4

8

0.75 1

1.25 1.5

1.75 2

2.25 2.5

2.75 3

3.25 3.5

3.75 4
x

-2.5

2 !3
2

0.25 0.5

-1.25

1 .1
3

0

Now say “fit polynomial”. When the dialog box opens, say “last column”,
“polynomial of degree”, “tab key”, “2”, “ok”. Then say, “graph polynomial”.
Note: In the dialog box you are just reading the proper choices from the menu. If they
are already checked correctly, you can just say “OK”. If some of the boxes are checked
correctly, just say the ones you want to change. For example, if “last column” is already
checked, but “polynomial of degree” is not, just start the dialog with “polynomial of degree”,
etc.
You’ll get:

0

6

1 .1
2 !3 , Polynomial fit: y ! 2. 278 6x 2 ! 8. 524 3x " 5. 997 1
3

2

4

8
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y

100

75

50

25

0
-5

-2.5

0

2.5

5
x

y

7.5
6.25
5
3.75
2.5
1.25
0

0

0.25 0.5

0.75 1

1.25 1.5

-1.25

1.75 2

2.25 2.5

2.75 3

3.25 3.5

3.75 4
x

-2.5

(You may choose to say “fifty percent” if all does not fit on the screen.)

We still have a problem!
These graphs are not really comparable since the y range in the first is about 16 times the
range of the second graph. We can however fix that as follows. First use the mouse grid to
click on the graph on the left and repeat the process to click on the box in the lower right
hand corner. When the dialog box opens say: “view”, “default”,“x-ray”, “zero”, “tab
key”, “4”, “tab key”,“minus 3”, “tab key”,“8”, “ok”.
Then click on an open place on the screen to take the graph out of the editing box.
Warning! Be sure you are in an open place on the screen and not on a margin
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surrounding the screen. Clicking a margin may erase your graph!
You’ll get
0

6

1 .1
2 !3 , Polynomial fit: y ! 2. 278 6x 2 ! 8. 524 3x " 5. 997 1
3

2

4

8
y

y

7.5

7.5
6.25

5

5
3.75

2.5

2.5
1.25

0

0

1

2

3

4
x

-2.5

0

0

0.25 0.5

0.75 1

1.25 1.5

1.75 2

2.25 2.5

2.75 3

3.25 3.5

-2.5

Now you’re finished but lets do it again another way. Instead of “graph this”, we’ll say
“plot this”. Suppose that we have already entered the data so that we have
0 6
1 .1
2 !3
3

2

4

8

Again with the cursor in the data say “fit polynomial” and answer the dialog box as
before. You will get:
0 6
1 .1
2 !3 , Polynomial fit: y ! 2. 278 6x 2 ! 8. 524 3x " 5. 997 1
3

2

4

8

3.75 4
x

-1.25

Now say “overlay polynomial”. You will get:
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y

100

75

50

25

0

6

1 .1

0
-5

-2.5

0

2.5
x

2 !3
3

5

2

4 8
Polynomial fit: y ! 2. 278 6x 2 ! 8. 524 3x " 5. 997 1
Now click the graph as before and set the range as before to get the final result with the
curve fit graphed along with the plotted data :
y

7.5

5

2.5

0

0

1 .1
2 !3
3

0

1

2

6

3

4
x

-2.5

2

4 8
Polynomial fit: y ! 2. 278 6x 2 ! 8. 524 3x " 5. 997 1
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Fitting and graphing a regression line
You can fit a regression line with any number of dependent variables . You can also fit
and graph a regression line with independent variable x as shown in the graph below.
You may want to reset the range after you plot this.
y

100

75

50

1

2

2

4

3

4

4

3

5

6

6

8

7

10

8

9

9

7

25

0
0

10 12
Regression is: y !

2.5

5

7.5

10
x

53
55

x"

6
5

Here’s how you do it (2 D example):
1. On a new line, beginning at the left margin, enter the data by saying “enter data”. In
order to fit a regression line with independent variable x, and dependent variable y, Scientific
Notebook requires you to place an x in the first data cell and a y in the second cell of the first
line. If you have already entered the data and did not do that, you must put the cursor
anywhere in the data and say “insert x-ray yankee”. The columns will then be labeled
automatically.
2. After you have the data entered and labeled as described in step 1, with the cursor
anywhere in the data, say “fit regression line”. Here is what you will see if you use the data
set listed here.
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x

y

1

2

2

4

3

4

4

3

5

6 , Regression is: y !

6

8

7

10

8

9

9

7

53
55

x"

6
5

10 12
3. Now say “graph regression line”. You will get
y

100

75

50

1

2

2

4

3

4

4

3

5

6

6

8

7

10

8

9

9

7

10 12
Regression is: y !

25

0
0

2.5

5

7.5

10
x

53
55

x"

6
5

REMARK: The appearance of the graph will vary according to the range you select for
x and y. Note that the labels x y at the top of the two columns have been removed. This is
because, contrary to the case of fitting a regression line, Scientific Notebook does not allow
the first two elements to be letters when graphing data. Therefore the command “graph
regression line” removes those labels so that the data and the line can be plotted. To use
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the command “graph regression line” you must begin a new line and enter the data at
the left most position of the page!
REPEATING Can’t Remember What To Say?
If you can’t remember what to say, remember the “go to” commands to view stand alone
commands. For example, if you wish to view commands beginning with the letter “s”, say
“go to sierra commands” will take you into the Pictionary to the commands that begin with
the letter “s”. Using the International Alphabet, say “go to and the letter commands” to
view commands beginning with that letter in the Pictionary. Saying “pictionary search”
will take you to other “go to” commands for searches such as commands beginning with
“integral” which would be accessed by saying “go to integral commands”.
Saving, Print Preview and Printing
If you would like to save your work, just say “save this” and give it a name. Normally
you will want to preview you work before you print it. To do so say “print preview”. This
will take you to the first page of the document in print preview. From page 1 in print
preview, you can go to any page you want to review by saying “preview x”, where x is any
number 2 thru 15. For example, if you want to preview page 10, say “print
preview”, “preview 10”. If you want to preview a page number greater than 15 you can
say “preview 15” and then say preview x, where x-1 is the number of pages you need to
move forward. For example, if you want to preview page 20, say “print preview”, “preview
15”, “preview 6”. Once you are satisfied, return to your document and print it by
saying “print this”.
Inserting a Value In a Formula
You may often want to evaluate mathematical expressions at a given value. The next
two examples demonstrate how to do that. Now, suppose that you wish to evaluate the
expression
y ! x 2 sin x " x cos x
x ! !2
First, let’s write down the equation.
Say: “yankee”, “equals”, “x-ray square”, “sine x-ray”, “plus x-ray”, “cosine x-ray”.
Now move the cursor above the line that the equation is on by placing the cursor at the
end of the equation and saying “insert one line”. Then say “x-ray”, “equals”, “pi over 2”,
“define equal”, “move down one”, (be sure the cursor is now in or at the end of the
equation) “evaluate”, “evaluate numerically”.
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Here’s what you should get:
x ! !2
y ! x 2 sin x " x cos x !

1
4

! 2 ! 2. 467 4

Now suppose that you also want the equation at !4 . Move the cursor to the end of the
equation (if cursor is at end of the line, say “move left 17” which places the cursor after
y ! x 2 sin x " x cos x ) and say “select to beginning of line”, “copy this”, “end key”, “next
line”, “put here” (or “paste”,or “paste this”). (We are assuming the equation is on a line by
itself. If not you can use the DNS command “select next/previous (number) characters”. )
Now say “insert one line”, “x-ray”, “equals”, “pi over 4”, * “clear definitions”, “define
equal”, (or “new definition”) “move down one”, “evaluate”, “evaluate numerically”. *
Now don’t forget to clear the definitions. Say “clear definitions”.
x
y
x
y

! !2
! x 2 sin x " x cos x !
! !4
! x 2 sin x " x cos x !

1
4

! 2 ! 2. 467 4

1
8

! 2 "

1
32

! 2 2 ! 0. 991 54

REMARK: You can change the number of digits displayed by saying “set digits
displayed”.
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STATISTICAL MODULE
This section should be skipped by those persons that are not specifically interested in
solving mathematical statistics problems. For those who choose to cover this section, the
supervision of a statistics instructor may be helpful.
MathTalk has several voice commands designed to allow you to do basic mathematical
statistics problems by voice. In particular, one can test hypotheses, find confidence intervals,
find p-values, and determine z and t-values. Additionally, voice commands are included to
determine critical values for Normal !", # 2 ", Standard Normal, (i.e., N(0,1)), student-t, chi
square, and F distributions.
Moreover, for any given !a, b", P#a " X " b$ , P#X " a$ and P#X # a$ are calculated on
command for the normal !", # 2 ", standard normal, t, $ 2 , uniform, binomial, and F
distributions. No graphing capabilities are included specifically for statistics. Before you try
any of the examples below, clear the definitions by saying “clear definitions”.
Remark: The letter “Z” is used to denote a Standard Normal random variable. The lower
case “z” is used for a value of Z or the z-statistic
Remark: To use the statistical command training module - say, “train statistics”.
Example 6
Given x ! 3. 2, " ! 2, # ! 3, and n ! 25, find the z-statistic
z!

!m!"" n
#

, where m ! x .

and calculate
a) P#!z " Z " z$
b) P#Z # z$
c) The p-value (for a one sided test assuming p-value ". 5".
REMARK: All p-values are for one sided test. For a two sided test just double them.
Now start a new line and find z.
Say: “next line”, “zulu statistic”.
!m!"" n
You should get:
z!
#
To enter the values of m (remember m ! x ), ", n, with the cursor at the end or in the
equation say “insert 1 line”, “mike”, “equals”, “3 point 2”, “define equal”, “next line,
“mu”, “equals 2”, “define equal”, “next line”, “november”, “equals twenty five”,
“define equal”, “next line”, “sigma”, “equals 3”, “define equal”, “move down 1”, (The
cursor should now be on the same line as z and the z equation should be on a line by itself.)
“evaluate numerically”.
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You should get
m ! 3. 2
"!2
n ! 25
#!3
!m!"" n
z!
! 2. 0
#
REMARK: These values of m, ", n, and, #will remain defined at these values until you
either redefine them or clear definitions.
a) To find P#!z " Z " z$, we use the command [standard normal probability]. This
command writes the general expression for P#a " Z " b$ for the Standard Normal random
variable, Z. That is say “standard normal probability” to get
b
1 2
P#a " Z " b$ ! 1 $ e ! 2 t dt
2!

a

In general, to calculate P#a " X " b$ for a given random variable X, say the name of the
distribution followed by the word “probability”. That is, for the T random variable,say
“tango probability” to get
P#a " X " b$ !

#! %"1
"
2
%
2

%! #! "

b

$a 1 "

t2
%

! %"1
2

dt,

and say “normal probability” to get
b
P#a " X " b| ", #$ ! 1 $ exp%! 2&#1 2 !t ! "" 2 'dt.
a

2! #

Do not be disturbed if you do not understand the symbols on the screen. They simply
represent a mathematical formulation for calculating an area under the given probability
density curve.
Now let’s continue with solving the problem at hand. We have calculated that z ! 2 and
we wish to find P#!z " Z " z$. Note that, here we want the Standardized Normal.
Say: “standard normal probability” to get
P#a " Z " b$ !

1
2!

b

1 2

$ a e ! 2 t dt

With the cursor in or directly following the equation
Say: “insert 1 line”, “alpha”, “equals minus 2”, “define equal”, “next line”,
“bravo”, “equals 2”, “define equal”, “move down 1”, “evaluate numerically”
You should get:
a ! !2
b!2
P#a " Z " b$ !

1
2!

b

$a e!

1 t2
2

b

1 2

d t ! 0. 398 94!numeric" $ e ! 2 t dt
!2

To calculate probabilities such as P#Z # 2$ or P#Z " 2$, proceed as follows.
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b) To find the P#Z # 2$, Say: “next line”, “alpha”, “equals 2”, “new definition” (or
define equal), “new line”, “probability zulu greater than or equal to
alpha”, “evaluate numerically”.
You should get:
a!2
P#Z # a$ ! 1

2!

%

$a e!

1 t2
2

dt ! 0. 022 75

c) Now to obtain the p-value for this problem, say “standard normal papa value” or
“normal papa value”. You will obtain
%
1 2
p value ! 1 $ e ! 2 t dt
2!

|z|

This expression is simply the mathematical formula for the p-value for a Standard
Normal random variable. You need not understand the formula. You do need to tell it the
value of z. You have just calculated that z ! 2. This is the value of z needed for the p
value. Although you calculated z, you have never defined z ! 2. So now, with the cursor
on the line with the equation,
Say: “insert 1 line”, “zulu”, “equals 2”, “define equal”, “move down 1”, “evaluate
numerically”
z!2
%
1 2
p value ! 1 $ e ! 2 t dt ! 0. 022 75
2!

|z|

Unless you have some definitions that you don’t want to clear, now clear the definitions
by saying “clear definitions”.
You can also calculate probabilities of the form P#X " a$, P#X # a$ for the Binomial,
Chi Square, F, Normal, Standard Normal, T, and Uniform distributions. In the case of the
binomial you can also calculate P#X ! a$. This can be accomplished as follows:
For the Binomial:
less than or equal to
Say “probability binomial
a

P#X " a|n, &$ ! &
k!0

alpha” to get

or
equal or less than

n!
k!!n!k"!

& & k !1 ! &" n!k
greater than or equal to

Say “probability binomial
n

P#X # a|n, &$ ! &
k!a

or

alpha" to get

equal or greater than
n!
k!!n!k"!

& & k !1 ! &" n!k

Say “probability binomial equals alpha” to get
n!
P#X ! a|&, n$ ! a!!n!a"!
& & a !1 ! &" n!a
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Say “probability binomial equals zero” to get
P#X ! 0$ ! !1 ! &" n
Say “probability binomial greater than zero” to get
P#X $ 0$ ! 1 ! !1 ! &" n
The Chi Square:
less than or equal to
Say “probability chi square
P#X " a$ !

%

22#

equal or less than

a

%
2

$0 t

1
%
2

alpha” to get

or

!1 ! 2t

e

dt
greater than or equal to

Say “probability chi square
P#X # a$ !

%

22#

equal or greater than

%

$a t

1
%
2

alpha” to get

or

%
2

!1 ! 2t

e

dt

The F distribution
less than or equal to
Say “probability foxtrot

alpha” to get

or
equal or less than

P#F " a|% 1 , % 2 $ !

#
#

%1
2

% 1 "% 2
2

#

%2
2

! %% 12 "

%1
2

a

$0

t
1"

!% 1 !2"
2

%1
%2

t

!% 1 "% 2 "
2

dt

greater than or equal to
Say “probability foxtrot

alpha” to get

or
equal or greater than

P#F # a|% 1 , % 2 $ !

#
#

%1
2

% 1 "% 2
2

#

%2
2

! %% 12 "

%1
2

%

$a

t
1"

!% 1 !2"
2

%1
%2

t

!% 1 "% 2 "
2

dt

The Normal distribution
less than or equal to
Say “probability normal
P#X " a | ", #$ !

1
2! #

a

or

alpha” to get

equal or less than

$ !% exp%! 2&#1 2 !t ! "" 2 'dt
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greater than or equal to
Say “probability normal
P#X # a | ", #$ !

1
2! #

alpha” to get

or
equal or greater than

%

$ a exp%! 2&#1 2 !t ! "" 2 'dt

The Standard Normal distribution
It is customary to refer to a Standard Normal random variable as a Z random variable or
a Z statistic. As we have done previously, we will use the letter Z when referring to a
Standard Normal random variable.
less than or equal to
Say “probability zulu

or

alpha"to get

equal or less than
P#Z " a$ !

1
2!

a

1 2

$ !% e ! 2 t dt
greater than or equal to

Say “probability zulu

or

alpha” to get

equal or greater than
P#Z # a$ !

1
2!

%

1 2

$ a e ! 2 t dt

T, and Uniform distributions
For the T and Uniform distributions to get P#X " a$ or P#X # a$, insert the proper
distribution name and proceed just as in the Chi Square, F and Normal distributions.
Example 7
Let X be the number of “ones” in ten tosses of a fair die (X is therefore a Binomial
random variable.). Find the probability X ! 2, i.e. P#X ! 2$.
Say “probability binomial equals alpha” and you will get:
n!
P#X ! a|&, n$ ! a!!n!a"!
& & a !1 ! &" n!a
Say: “insert 1 line”, “alpha”, “equals 2”, “define equal”, “next line”, “theta”,
“equals”, “1 over 6”, “define equal”, “next line”, “november”, “equals 10”,
“define equal”, “move down 1”, “evaluate numerically” .
You should get:
a!2
& ! 16
n ! 10
P#X ! a|&, n$ !

n!
a!!n!a"!

& & a !1 ! &" n!a ! 0. 290 71
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Note: If you want P#X " 2|&, n$, you proceed the same way, except you begin by
saying “probability binomial equal or less than alpha”.
Example 8
Given the 8 data values 2. 37, . 77, 1. 10, 3. 65, 2. 50, 2. 38, 3. 66, !1. 48 , from a normal
distribution, find the observed t-value under the assumption " ! 0.
After you have entered the data, with the cursor in or directly at the end of the data,
say “sample mean”.
You’ll get: Mean(s): 1. 868. Now move the cursor back into the data, and say “sample
sierra delta”.
You will get: Standard deviation(s): 1. 703 .
You can now calculate the t-statistic (or t-value). To do so, go to a new line and say “t
statistic”.
You’ll get: t !

!m!"" n
s

.

Remark: remember x ! m.

Say: “insert 1 line”, “mike”, “equals”, “one point eight six eight”, “define equal”,
“next line”, “sierra”, “equals”, “one point seven zero 3”, “define equal”,
“next line”, “mu”, “equals zero”, “define equal”, “next line”, “november”,
“equals 8”, “define equal”, “move down 1”, “evaluate numerically”.
You should get:
m ! 1. 868
s ! 1. 703
"!0
n!8
!m!"" n
t!
! 3. 102 5
s
Say “clear definitions”.
Example 9
a) Find the Z-value so that the area under a standard normal curve to its right is .025.
Solution:
Say “zulu point zero two five”. You’ll get : z .025 ! 1. 960.
You can use this method for
Z .1 , Z .05 , Z .025 and Z .01 .
For Z in general, you must proceed as follows:
Say: “next line”, “zulu critical value”
You will get:
1
2!

%

1 2

$ z e ! 2 t dt
74

Don’t let it bother you if you do not understand the symbols on the screen. They simply
represent a mathematical formulation for calculating an area under the standard normal
curve. Now, let’s suppose you want to know the Z .2 , i.e., the point such that the area under a
standard normal curve to the right of Z is . 2. Now say “equals”, “point”, “ 2”. You will see
the following on the screen:
1
2!

%

1 2

$ z e ! 2 t dt !. 2

Now say “solve numerically”. You will get:
1
2!

%

1 2

$ z e ! 2 t dt !. 2, Solution is: %#z ! 0. 841 62$'

b) Now find t .025 !7", i.e., the value of a t statistic with 7 degrees of freedom such that
the area to its right is .025.
Solution: Say “tango critical value”. You will get
#! %"1
"
2
%
2

%! #! "

%

$t 1 "

u2
%

! %"1
2

du

Say: “equals”, “point zero two five”. Now say “insert 1 line”, “degrees of freedom”,
“equals 7”, “define equal”, “move down 1”, “solve numerically”. You’ll get
%!7

#! %"1
"
2
%
2

%! #! "

%

$t 1 "

u2
%

! %"1
2

du !. 025, Solution is: %#t ! 2. 364 6$'

Example 10
This example uses the data from Example 8.
a) Find a 95% confidence interval (CI) for " if it is known that # ! 2.
Solution: Say “next line”, “normal confidence interval for mu”. You will get
CI ! m ! z #n , m " z #n
You must now insert the values of m, z, #, and n.
Say: “insert 1 line”, “mike”, “equals”, “one point eight six eight”, “define equal”,
next line”, “zulu”, “equals”, “one point nine six”, “define equal”, next line”,
“sigma”, “equals 2”, “define equal”, next line”, “november”,
“equals 8”, “define equal”, “move down 1”, “evaluate numerically”
m ! 1. 868
z ! 1. 96
#!2
n!8
CI ! m ! z

#
n

,m " z

#
n

! 0. 482 07 3. 253 9
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b) Find a 95% confidence interval for " if # is not known.
Solution: Here you need the t-distribution, so say “next line”, “tango confidence
interval for mu”. Again, you will have to enter the values of the variables. The value of t
required here is the t critical value you computed in Example 9. If you needed to compute it,
you would need to compute it on a separate line and then enter it in the CI as we did in part
(a) of this example. Now enter all the unknowns, i.e.,
t ! 2. 365
s ! 1. 703
m ! 1. 868
n !8

(Computed in Example 9)
(Computed in Example 8)
(Computed in Example 8)

in the same manner as in part (a). To be safe begin by saying “clear definitions”.
Remark: You do not have to say “insert 1 line”. However it seems more logical to place
the values of the parameters before the equation, rather than after it. You can, however,
define the value of the parameter either place so long as you say “define equal” before you
say “evaluate numerically”.
If you do everything right you will get the following:
t ! 2. 365
s ! 1. 703
m ! 1. 868
n!8
CI ! m ! t sn , m " t sn ! 0. 444 03 3. 292 0

TRANSLATING MATH INTO BRAILLE
using the Duxbury Braille Translator 10.5 +
*You may view a 'math to Braille' demo on the MathTalk Demo CD.
1. Create math in ScientificNotebook by voice and/or keyboarding.
2. Save the math as a .tex file in c:\Program Files\ScientificNotebook\ docs by
saying “save math as”, voice or type the name, then “save”.
3. Next say, “math to braille” which will open the Duxbury Braille Translator and
bring up the “open file” dialog box in c:\Program Files\ScientificNotebook\ docs.
4. Now select the file you wish to open. You may either a) voice the name of file
and then say “open that” or b) click on the file, then use combinations of clicking
and voicing to open that file in Duxbury.
5. The file is now open in the Duxbury Braille Translator. Say “translate to Braille”.
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To emboss, say “emboss this”. Unless connected to an embosser, now say “cancel”.
6. To close file and exit translator, say “close file”, “discard”, “exit translator”.
Available voice commands with in the Duxbury Braille Translator:
“translate to Braille”
“emboss this”
“close file”
“discard”
“exit translator”
“open math” -when already in Duxbury may be used to open an additional file
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HELP DOCUMENTS

MATHTALK LEARNING MODULE (c)
The MathTalk Learning Module is designed to quickly familiarize the user with the
features of MathTalk.
HELPFUL DEFINITIONS:
Pictionary -a list of the names of stand alone commands and the actions they
accomplish.
Tutorial - examples and explanations of use of commands.
Sentence Commands - allows the user to voice more than one expression at a time.
An example of this would be to say “square root of twenty”. This particular command
allows you to say any root (from square to ninth) of any number (1 through 20) or of
any letter (a through z, including caps) or any greek letter (including caps)!
Variable List - list of variables for use in Sentence Commands.
Training Modules - training for Pre-Algebra, Algebra, Calculus, Trig, Statistics.
This program contains the following learning features:
1) Manual /Tutorial
2) Pictionary
3) Learning Assistance Module which is comprised of
a. Video demonstrations – See CD video demo
b. Direct online access to available Sentence Commands, Variable Lists, stand alone
commands in Pictionary, and Manual/Tutorial search Learning Assistance Program
available by a single voice command. Just say “mathtalk learning module” for a
list of commands to access video demos, access to lists of sentence commands and
their variables, stand alone commands in the Pictionary, and Training Modules.
* The MathTalk documents were created in ScientificNotebook. There will be some
spacing and justification differences.
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TO VIEW:

YOU SAY

COMMAND INFORMATION
Sentence Command Examples

sentence command examples

Sentence and Dialog Box Variables

variable menu

Manual/Tutorial Topics

tutorial search

Pictionary Search - Stand Alone Commands

pictionary search

Statistics

statistics commands

HELP TOPICS
Command Training Modules
(pre-algebra, algebra, calculus, trig, stat)

training modules

International Alphabet

international alphabet

How to Replace a Letter or Symbol

replace help

Scientific Notebook Help

scientific notebook help

Trouble Shooting

trouble shooting

ADDITIONAL FEATURES
Translating Math to Braille
translate to Braille
(see Tutorial section, pages 76-77 of this manual)
Technical Support

technical support

VIDEOS (see Demo CD Video)
Adding Text to MathTalk
Quick Reference Laminate
Training MathTalk
Replace Video- How to Replace a Letter or Symbol
Math to Braille
and examples of Pre-Algebra, Algebra, Trig, Calculus, Statistics, Graphing, etc.
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REPLACE A LETTER OR SYMBOL (c)
This command allows you to replace symbols with different symbols. For example, if you
say “quadratic equation”, you will get ax 2 ! bx ! c " 0. If you want az 2 ! bz ! c " 0, you can
just change the x to a z manually. Or you can position the cursor at the beginning of the
math expression. Then move the cursor to the immediate left of the first x in that math
expression by saying “move right ? spaces”. Now say “replace next character” which
will 1) highlight the first x, 2) open the Replace Dialog Box placing the x in “Search for”, and
3) place the cursor in “Replace with” position. Now place z in the “Replace with” box by
saying “zulu”. Say “find next”, “replace”, “yes”and then “end replace”. And you will get
az 2 ! bz ! c " 0.
Be sure “whole words only is not checked!!
If you wish to replace the next two characters in a math expression, position the cursor to
the immediate left of the two characters, say “replace next two characters”, and follow
step 2 above.
Special Note: When the last character(s) to be replaced is selected, say “end replace”.
See the following example.
Suppose that you wish to change the x in the equation
n!n!1"
!a ! x" n " a n ! na n!1 x ! 2! a n!2 x 2 ! # ! x n to #. Note there are four x’s in this expression.
First place the cursor at the immediate left of the first x (i.e. left most x) in that expression.
Now say “replace next character” which will 1) highlight the first x, 2) open the Replace
Dialog Box placing the x in “Search for”, and 3) place the cursor in “Replace with” position.
Now place # in the “Replace with” box by saying “cap greek delta”. Say “find next”,
“replace”, “yes”, “replace” , “replace” and then “end replace”. (Again saying, “replace” is
continued like until the last x that you want to replace is selected. Then with that x still
selected, say “end replace”.)
n!n!1"
The result:
!a ! #" n " a n ! na n!1 # ! 2! a n!2 # 2 ! # ! # n
Of course, if you wanted to replace all of the x’s to the end of the document with #, you
would just say “replace all” to start with.

To exit this document, SAY, “close file”.
For a video demonstration, see the CD video demo.
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TUTORIAL SEARCH (c)

TO VIEW A TUTORIAL TOPIC ON:

YOU SAY

(listed in order of appearance in the Tutorial)
Helpful Definitions

helpful definitions

MathTalk For Pre-Algebra

prealgebra mathtalk

MathTalk For Algebra

mathtalk algebra

MathTalk For Trig

mathtalk trig

MathTalk For Calculus

mathtalk calculus

MathTalk For Statistics

mathtalk statistics

Rules For Voicing Commands

command rules

Improve Your Recognition

improve recognition

Rules For Correcting

correction rules

Rules For Correcting Video

correction techniques

Editing Commands

editing commands

Using The International Alphabet

using international alphabet

Using The Greek Alphabet

greek alphabet

Types Of Math Commands

math command types

Voicing Text

voice text

Alt ! letter commands

letter keystroke commands

Mouse Grid

grid tutorial

Align Text

align text

Next Line and Enter Key Commands

next line command

Move Out Command

move out command

Type Face Commands

type face commands

Math Entry Commands - several pages long

math entry examples

( Commands are also detailed in Pictionary)

pictionary search

One Line Equations By Voice

example one

Type Commands

example two

Display Equation

example three

4

Using the Compute Feature

example four

Graphing Examples

example five

Statistics Example

example six

Statistics Example

example seven

Statistics Example

example eight

Statistics Example

example nine

Statistics Example

example ten

Solving Problems In Compute Mode

compute mode

Graphing By Voice

graphing by voice

Saving, Print Preview, and Printing

document information

Inserting A Value In A Formula

formula value

5

LIST OF SENTENCE COMMANDS (c)
ALPHABET
!Alphabet" derivative
Example: Say “mike derivative”. Get

dmy
dx m

ANGLE
angle !Greek Letter"
Example: Say “angle theta”. Get ! !
angle !Greek Letter" with arc
"
Example: Say “angle beta with arc”. Get "
angle !Letter"
angle !Letter" with arc
x
Example: Say “angle x-ray with arc”. Get "
BOLD
bold !Cap Letter"
Example: Say “bold cap november”. Get N
bold !Greek Letter"
bold !Letter"
CAP
!Cap Letter"
Example: Say “cap hotel”. Get H
D
delta !Greek Letter"
Example: Say “delta lambda”. Get d#
delta !Letter"
delta !Letter" delta !Greek Letter"
Example: Say “delta yankee delta theta” . Get
delta !Letter" delta !Letter"
Example: Say “delta yankee delta x-ray”. Get

dy
d!
dy
dx

DELETE
delete next !Number 2 to 10" characters
delete previous !Number 2 to 10" characters
DELTA
delta !Letter"
Example: Say “delta x-ray”. Get #x
DERIVATIVE
derivative with respect to !Greek Letter"
derivative with respect to !Letter"
6

Example: Say “derivative with respect to romeo. Get drd
!HOrdDeriv"
!HOrdDeriv" of !Letter" with respect to !Greek Letter"
d4r
Example: Say “fourth derivative of romeo with respect to theta”. Get d!
4
!HOrdDeriv" of !Letter" with respect to !Letter"
Example: Say “second derivative of cap golf with respect to tango”. Get

d2G
dt 2

EXPONENT
exponent !Greek Letter"
exponent !Letter"
exponent !Minus Letter"
Example: Say “echo”, “exponent minus x-ray”. Get e #x
exponent !Minus Numbers"
exponent !Numbers"
exponent !Number/1 to 99" !Greek Letter"
exponent !Number/1 to 99" !Letter"
FUNCTION
function !Letter"
Example: Say “function foxtrot” (or function foxtrot). Get f!"#.
Then say “x-ray square”, “move out”. Get f!x 2 #
GREEK LETTER
!Greek Letter"
!Greek Letter" !Decor"
$
Example: Say “theta hat”. Get !
!Greek Letter" !Primes"
!Greek Letter" !SqCube"
Example: Say “fee cube”. Get. $ 3
!Greek Letter" goes to !Numbers"
Example: Say “sigma goes to 5”. Get % $ 5
!Greek Letter" over !Greek Letter"
LETTER
!Letter"
!Letter" !Decor"
Example: Say “yankee tilde”. Get %
y
!Letter" !Letter"
!Letter" !Primes"
!Letter" !SqCube"
Example: Say “yankee cube”. Get y 3
!Letter" factorial
Example: Say “mike factorial”. Get m!
!Letter" goes to !Letter"
!Letter" goes to !Numbers"
Example: Say “x-ray goes to zero”. Get x $ 0
!Letter" minus !DigitsOnly" factorial
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Example: Say “november minus 5 factorial”. Get !n # 5#!
!Letter" minus !Letter" factorial
!Letter" over !DigitsOnly"
!Letter" over !Greek Letter"
!Letter" over !Letter"
Example: Say “alpha over bravo”. Get ab
!Letter" over !Number1 to 99"
!Letter" plus !DigitsOnly" factorial
!Letter" plus !Letter" factorial
!Letter" plus delta !Letter"
Example: Say “victor plus delta victor”. Get v % #v
!Letter" square minus !Letter" square
!Letter" square plus !Letter" square
LIMIT
limit as !Greek Letter" goes to !Numbers"
Example: Say “limit as beta goes to 1”. Get lim
"$1

limit as !Letter" goes to !Letter"
limit as !Letter" goes to !Numbers"
Example: Say “limit as hotel goes to zero”. Get lim
limit as delta !Greek Letter" goes to zero
limit as delta !Letter" goes to zero
LIMITS
limits !Greek Letter" to !Greek Letter"
limits !Greek Letter" to !Letter"
limits !Greek Letter" to !Numbers"
limits !Letter" to !Greek Letter"

h$0

2&

Example: Say “integral with limits”, “limits alpha to 2 pi”. Get $
limits !Letter" to !Letter"
limits !Letter" to !Numbers"
limits !Minus Letter" to !Greek Letter"

d

l

Example: Say “integral with limits”, “limits minus 5 to lambda”. Get $
#5

limits !Minus Letter" to !Letter"
limits !Minus Letter" to !Minus Numbers"
limits !Minus Letter" to !Numbers"
limits !Minus Numbers" to !Letter"
limits !Minus Numbers" to !Minus Letter"
limits !Minus Numbers" to !Minus Numbers"
limits !Minus Numbers" to !Numbers"
Example: Say “vertical bar with limits”, “limits minus 5 to 5”. Get | 5#5
limits !Numbers" to !Greek Letter"
limits !Numbers" to !Letter"
limits !Numbers" to !Numbers"
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LOG
log base 10 !Greek Letter"
Example: Say “log base 10 beta”. Get log "
log base 10 !Letter"
Example: Say “log base 10 alpha”. Get log a
MINUS
!Minus Greek Letter"
Example: Say “minus theta”. Get #!
!Minus Letter"
Example: Say “minus alpha”. Get #a
!Minus Numbers"
Example: Say “minus 3”. Get #3
MIXED PARTIAL
mixed partial of !Letter" with respect to !Greek Letter" and !Greek Letter"
mixed partial of !Letter" with respect to !Letter" and !Greek Letter"
mixed partial of !Letter" with respect to !Letter" and !Letter"
Example: Say “mixed partial of foxtrot with respect to x-ray and yankee”.
%2f
Get %x%y
NATURAL LOG
natural log !Greek Letter"
Example: Say “natural log lambda”. Get ln #
natural log !Letter"
NUMBER
!Number/1 to 9" by !Number/1 to 9" bracket matrix
Example: Say “2 by 2 bracket matrix”. Get

" "
" "

!Number/1 to 9" by !Number/1 to 9" determinant
!Number/1 to 9" by !Number/1 to 9" matrix
!Number/1 to 99"
!Number/1 to 99" !Greek Letter"
!Number/1 to 99" !Letter"
!Number/1 to 99" over !Greek Letter"
!Number/1 to 99" over !Letter"
Example: Say “4 over alpha”. Get 4a
!Number/1 to 99" over !Number/1 to 99"
!Number/1 to 99" spaces
!Numbers"
PARENTHESES
parentheses !Greek Letter"
Example: Say “parentheses theta”. Get !!#
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parentheses !Greek Letter" !Greek Letter"
parentheses !Greek Letter" !Letter"
parentheses !Letter"
parentheses !Letter" !Greek Letter"
parentheses !Letter" !Letter"
Example: Say “parentheses x-ray yankee”. Get !x, y#
parentheses !Letter" plus !Letter"
parentheses !Letter" plus delta !Letter"
parentheses !Minus Letter"
parentheses !Minus Numbers"
parentheses !Minus Numbers" !Minus Numbers"
parentheses !Minus Numbers" !Numbers"
Example: Say “parentheses minus one one”. Get !#1, 1#
parentheses !Numbers"
parentheses !Numbers" !Minus Numbers"
parentheses !Numbers" !Numbers"
PARTIAL
partial of !Letter" with respect to !Greek Letter"
%r
Example: Say “partial of romeo with respect to theta”. Get %!
partial of !Letter" with respect to !Letter"
Example: Say “partial of cap lima with respect to sierra”. Get
partial with respect to !Greek Letter"
%
Example: Say “partial with respect to omega”. Get %'
partial with respect to !Letter"
Example: Say “partial with respect to x-ray”. Get %x%

%L
%s

PLUS
!Plus Greek Letter"
Example: Say “plus cap greek x-ray”. Get %&
Example: Say “plus omega”. Get %'
!Plus Letter"
Example: Say “plus alpha”. Get %a
Example: Say “plus cap hotel”. Get %H
!Plus Numbers"
Example: Say “plus 6”. Get %6
ROOT
!Root" root of !Greek Letter"
Example: Say “fourth root of beta”. Get 4 "
!Root" root of !Letter"
Example: Say “fifth root of november”. Get 5 n
!Root" root of !Numbers"
Example: Say “square root of 2”. Get 2
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SECOND PARTIAL
second partial of !Letter" with respect to !Greek Letter"
Example: Say “second partial of hotel with respect to beta”. Get
second partial of !Letter" with respect to !Letter"
Example: Say “second partial of yankee with respect to
%2y
whiskey”. Get %w 2

%2h
%" 2

SQUARE ROOT
Square Root of !Greek Letter"
Example: Say “square root of fee”. Get $
Square Root of !Letter"
Square Root of !Numbers"
Example: Say “square root of 10”. Get 10
SUB
sub !DigitsOnly"
sub !DigitsOnly" !DigitsOnly"
Example: Say “lambda”, “sub one two”. Get # 12
sub !Letter"
Example: Say “sigma”, “sub x-ray”. Get % x
sub !Letter" !Letter"
Example: Say “cap whiskey”, “sub x-ray yankee”.
Get W xy
sub !Letter" minus !DigitsOnly"
sub !Letter" plus !DigitsOnly"
TRIG
!Trig"
Example: Say “cosine”. Get cos
!Trig" !Argument"
Example: Say “tangent squared omega”. Get tan 2 '
!Trig" !NumArg"
Example: Say “inverse sine theta”. Get sin #1 !
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VARIABLE LISTS

*Say "sample commands" to view sample list of variables used with variables.
ARGUMENT LIST
ALPHABET LIST USE International Alphabet
a alpha

j juliette

s sierra

b bravo

k kilo

t tango

c charlie

l lima

u uniform

d delta

m mike

v victor

e echo

n november

w whiskey

f foxtrot

o oscar

x x ray

g golf

p papa

y yankee

h hotel

q quebec

z zulu

i india

r romeo

CAP ALPHABET LETTER LIST
* Add ’cap’ to the International Alphabet letter in the above list.

LETTER LIST
Is composed of the above two lists:
ALPHABET LIST and CAP LETTER LIST.

12

GREEK LETTER LIST
cap chi

'

fee

$

lambda #

cap fee

!

gamma

(

mu

cap gamma

(

greek alpha

cap greek delta #

beta

cap greek x

greek delta

&

*

)

omega '
pi

&

+

rho

,

-

sigh

.

"

cap omega

)

greek eta

cap pi

*

greek november /

sigma

%

cap sigh

'

greek x-ray

0

tau

1

cap sigma

+

greek x

0

theta

!

cap theta

,

greek z

2

upsilon 3

cap upsilon

-

greek zulu

2

chi

4

iota

epsilon

6

kappa

5
7

PLUS LETTER LIST (For caps of any listed, say “plus cap ...”.
plus alpha

plus romeo

plus greek november

plus bravo

plus sierra

plus greek x-ray

plus charlie

plus tango

plus greek zulu

plus delta

plus uniform

plus iota

plus echo

plus victor

plus kappa

plus foxtrot

plus whiskey

plus lambda

plus golf

plus x-ray

plus mu

plus hotel

plus yankee

plus omega

plus india

plus zulu

plus pi

plus juliette

plus rho

plus kilo

plus chi

plus sigh

plus lima

plus epsilon

plus sigma

plus mike

plus fee

plus tau

plus november

plus gamma

plus theta

plus oscar

plus greek alpha

plus upsilon

plus papa

plus beta

plus quebec

plus greek delta
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MINUS LETTER LIST
Use above list and substitute "MINUS" for "plus" in previous list.
(For caps of any listed, say “minus cap ...”.
NUMBERS LIST
1 fifth

3 fourths

pi over 3

1 fourth

3 pi over 2

pi over 4

1 half

3 pi over 4

pi over 6

1 sixth

5 pi over 6

pi

1 space

5 sixths

0 (zero) thru 20

1 third

infinity

2 pi

minus infinity

2 thirds

pi over 2

MINUS NUMBERS LIST
minus 1

minus 7

minus 1 sixth

minus infinity

minus 2

minus 8

minus 1 third

minus pi over 2

minus 3

minus 9

minus 2 pi

minus pi over 3

minus 4

minus 1 fifth

minus 3 pi over 2

minus pi over 4

minus 5

minus 1 fourth

minus 3 pi over 4

minus pi over 6

minus 6

minus 1 half

minus 5 pi over 6

minus pi

PLUS NUMBERS LIST
plus 1

plus 7

plus 1 sixth

plus infinity

plus 2

plus 8

plus 1 third

plus pi over 2

plus 3

plus 9

plus 2 pi

plus pi over 3

plus 4

plus 1 fifth

plus 3 pi over 2

plus pi over 4

plus 5

plus 1 fourth

plus 3 pi over 4

plus pi over 6

plus 6

plus 1 half

plus 5 pi over 6

plus pi

DECORATION LIST
bar
hat
tilde

14

DIGIT LIST
% [plus]

1

6

- [minus]

2

7

-[negative]

. [point]

3

8

4

9

0 [zero] through 9

5

HOrdDERIV LIST
second derivative
third derivative
fourth derivative
fifth derivative
sixth derivative
seventh derivative
eighth derivative
ninth derivative
ROOT LIST

SQCUBE LIST

PRIME LIST

cube
fourth
fifth
sixth
seventh
eighth

cube
cubed
square
squared

double prime
prime
triple prime

ninth
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TRIG LIST
arc cosine

cotan squared

inverse cotan

arc cotan

cotan

inverse cotangent

arc cotangent

cotangent squared

inverse sine

arc secant

cotangent

inverse tangent

arc sine

hyperbolic cosine squared

secant squared

arc tan

hyperbolic cosine

secant

arc tangent

hyperbolic cotangent squared

sine square

cosecant square

hyperbolic cotangent

sine squared

cosecant squared

hyperbolic sine squared

sine

cosecant

hyperbolic sine

tan squared

cosine square

hyperbolic tangent squared

tangent squared

cosine squared

hyperbolic tangent

tangent

cosine

inverse cosine

cosine theta
NUMARG LIST
pi

7 pi

pi over 2

2 pi

8 pi

pi over 3

3 pi

9 pi

pi over 4

4 pi

3 pi over 2

pi over 6

5 pi

3 pi over 4

numbers (zero) thru 20

6 pi

5 pi over 6
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“TYPE” short word/phrases commands (c)
You say:
You get:
You say:

You get:

type and

and

type is

is

type as

as

type odd

odd

type but

but

type on

on

type cap but

But

type or

or

type cap example

Example

type otherwise otherwise

type cap hence

Hence

type since

since

type cap if

If

type then

then

type cap let

Let

type thus

thus

type cap let x equal Let X equal

type to

to

type cap now

Now

type variance

Var

type cap so

So

type when

when

type cap then

Then

type whenever whenever

type cap theorem

Theorem

type where

type cap therefore

Therefore

type cap thus

Thus

type covariance

Cov

type even

even

type for all

for all

type for every

for every

type for

for

type Hence

Hence

type if and only if

if and only if

type if

if

type in

in

where
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TRIG COMMANDS (c)
SAY

GET

SAY

GET

arc cosine

arccos

hyperbolic cotangent

coth

arc cotan

arccot

hyperbolic sine squared

sinh 2

arc cotangent

arccot

hyperbolic sine

sinh

arc secant

arcsec

hyperbolic tangent squared

tanh 2

arc sine

arcsin

hyperbolic tangent

tanh

arc tan

arctan

inverse cosine

cos !1

arc tangent

arctan

inverse cotan

cot !1

cosecant squared

csc 2

inverse cotangent

cot !1

cosecant square

csc 2

inverse sine

sin !1

cosecant

csc

inverse cotangent

cot !1

cosine square

cos 2

secant squared

sec 2

cosine squared

cos 2

secant

sec

cosine

cos

sine squared

sin 2

cotan squared

cot 2

sine square

sin 2

cotan

cot

sine

sin

cotangent squared

cot 2

tan squared

tan 2

cotangent

cot

tangent squared

tan 2

tangent

tan

hyperbolic cosine
2

squared

cosh

hyperbolic cosine

cosh

hyperbolic cotangent
squared coth 2
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STATISTIC COMMANDS FOR NATURALLYSPEAKING (c)
#

Denotes you MUST use the International Alphabet for letter(s).
YOU SAY

YOU GET

binomial mean

! ! n!"

binomial probability

P"X ! k# !

binomial standard deviation

#!

binomial sum

P"a " X " b|n, "# ! #

n!
k!$n!k%!

! " k $1 ! "% n!k

n ! "$1 ! "%
b

chi square critical value

k!a

%

$
2

2 "

! " k $1 ! "% n!k

t

$

$ a t 2 !1 e ! 2 dt

1

$
2

n!
k!$n!k%!

chi square probability

P"a " X " b# !

degrees of freedom

$

$
2

b

2 "

t

$

$ a t 2 !1 e ! 2 dt

1
$
2

denominator degrees of freedom $ 2
#

#

#

f p value

$ 1 #$ 2
2

"

f critical value

"

$1
2

"

P"a " F " b|$ 1 , $ 2 # !

$2
2

$ 1 #$ 2
2

"

p value ! P"F & a|$ 1 , $ 2 # !

f probability

$ $$ 12 %

"

$1
2

"

$ 1 #$ 2
2

$1
2

"

"

"

$2
2

%

$1
2

$a

t

$2
2

$ $$ 12 %

$1
$2

1#

$ $$ 12 %
$1
2

$1
2

$$ 1 !2%
2
$$ 1 #$ 2 %
2

t

%

$a

t

b

$a

t
1#

greek nu sub one

$1

greek nu sub two

$2

mu

!

normal confidence interval for mu

CI !

m!z

#
n

,m # z

#
n

normal confidence interval for the mean CI !

m!z

#
n

,m # z

#
n

#

normal p value

normal probability
normal critical value

p value !

1
2%

%

t

$$ 1 #$ 2 %
2

$$ 1 !2%
2

$1
$2

t

$$ 1 #$ 2 %
2

dt

dt

1 2

$ |z| e ! 2 t dt

P"a " X " b| !, ## !
1
2% #

$$ 1 !2%
2

$1
$2

1#

dt !

1
2% #

b

$ a exp&! 2!#1 2 $t ! !% 2 'dt

%

$ a exp&! 2!#1 2 $t ! !% 2 'dt

numerator degrees of freedom $ 1
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probability binomial equal or greater
n

than alpha P"X & a|n, "# ! #
k!a

n!
k!$n!k%!

! " k $1 ! "% n!k

n!
k!$n!k%!

! " k $1 ! "% n!k

probability binomial equal or less
a

than alpha

P"X " a|n, "# ! #
k!0

n!
a!$n!a%!

probability binomial equals alpha

P"X ! a|", n# !

probability binomial equals zero

P"X ! 0# ! $1 ! "% n

! " a $1 ! "% n!a

probability binomial greater than
n

or equal to alpha

P"X & a|n, "# ! #
k!a

n!
k!$n!k%!

! " k $1 ! "% n!k

probability binomial greater than zero P"X $ 0# ! 1 ! $1 ! "% n
probability binomial less than or
a

equal to alpha

P"X " a|n, "# ! #
k!0

n!
k!$n!k%!

! " k $1 ! "% n!k

probability chi square equal or
greater than alpha P"X & a# !

$
2

1

2 "

$
2

%

$

a

$

%

$

t

$ a t 2 !1 e ! 2 dt

probability chi square equal
or less than alpha

P"X " a# !

$
2

1

2 "

$
2

t

$ 0 t 2 !1 e ! 2 dt

probability chi square greater
than or equal to alpha

P"X & a# !

$
2

1

2 "

$
2

t

$ a t 2 !1 e ! 2 dt
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probability chi square less than
or equal to alpha P"X " a# !
#

t

$

"

P"F & a|$ 1 , $ 2 # !

$1
2

"

$ 1 #$ 2
2

"

$ $$ 12 %

$2
2

$1
2

%

$a

$$ 1 !2%
2

t
1#

$1
$2

$$ 1 #$ 2 %
2

t

dt

"

P"F " a|$ 1 , $ 2 # !

$1
2

"

$ 1 #$ 2
2

"

$ $$ 12 %

$2
2

$1
2

a

$0

t
1#

$$ 1 !2%
2

$1
$2

t

$$ 1 #$ 2 %
2

dt

probability f greater than or
equal to alpha

#

2 "

$
2

probability f equal or less
than alpha

#

a

$ 0 t 2 !1 e ! 2 dt

1

probability f equal or greater
than alpha

#

$
2

"

P"F & a|$ 1 , $ 2 # !

$1
2

"

$ 1 #$ 2
2

"

$ $$ 12 %

$2
2

$1
2

%

$a

$$ 1 !2%
2

t
1#

$1
$2

t

$$ 1 #$ 2 %
2

dt

probability f less than or
"

P"F " a|$ 1 , $ 2 # !

equal to alpha

$1
2

"

$ 1 #$ 2
2

"

$ $$ 12 %

$2
2

$1
2

a

$0

t
1#

$$ 1 !2%
2

$1
$2

t

$$ 1 #$ 2 %
2

dt

probability normal equal or greater
than alpha P"X & a | !, ## !

%

1
2% #

$ a exp&! 2!#1 2 $t ! !% 2 'dt

1
2% #

$ !% exp&! 2!#1 2 $t ! !% 2 'dt

probability normal equal or less
than alpha

P"X " a | !, ## !

a

probability normal greater than or
equal to alpha P"X & a | !, ## !

%

1
2% #

$ a exp&! 2!#1 2 $t ! !% 2 'dt

1
2% #

$ !% exp&! 2!#1 2 $t ! !% 2 'dt

probability normal less than or
equal to alpha
#

"$ $#1
%
2

$a 1 #

"$ $#1
%
2

$ !% 1 #

$% "$ $2 %

%

u2
$

! $#1
2

du

P"T " a# !

$
2

$% "$ %

a

u2
$

! $#1
2

du

probability t greater than or
equal to alpha

#

P"T & a# !

probability t equal or less than
alpha

#

a

probability t equal or greater
than alpha

#

P"X " a | !, ## !

P"T & a# !

"$ $#1
%
2
$
2

$% "$ %

%

$a 1 #

u2
$

! $#1
2

du

probability t less than or equal
to alpha

P"T " a# !

"$ $#1
%
2
$
2

$% "$ %

a

$ !% 1 #

u2
$

! $#1
2

du
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probability uniform equal or greater than alpha

P"X & a# !

$d%!$a%
$d%!$c%

probability uniform equal or less than alpha

P"X " a# !

$a%!$c%
$d%!$c%

probability uniform greater than or equal to alpha P"X & a# !

$d%!$a%
$d%!$c%

probability uniform less than or equal to alpha

P"X " a# !

$a%!$c%
$d%!$c%

#

probability z equal or greater than alpha

P"Z & a# !

1
2%

$ a e ! 2 t dt

#

probability z equal or less than alpha

P"Z " a# !

1
2%

$ !% e ! 2 t dt

#

probability z greater than or equal to alpha

P"Z & a# !

1
2%

$ a e ! 2 t dt

#

probability z less than or equal to alpha

P"Z " a# !

1
2%

$ !% e ! 2 t dt

#

review standard deviation of x bar

Sigma X bar!

#

review t statistic

t!

#

review z statistic

z!

$m!!% n
s
$m!!% n
#

%

1 2

a

1 2

%

1 2

a

1 2

#x
n

, where m ! x .
, where m ! x .

s2

sierra squared

1
2%

b

P"a " Z " b# !

#

t confidence interval for mu

CI !

m!t

s
n

,m # t

s
n

#

t confidence interval for the mean CI !

m!t

s
n

,m # t

s
n

#

t critical value

#

t p value

p value ! P"T & a# !

#

t probability

P"a " X " b# !

#

t statistic

t!

"$ $#1
%
2

$% "$ $2 %

uniform probability

%

! $#1
2

u2
$

$t 1 #

"$ $#1
%
2

$% "$ $2 %

1 2

$ a e ! 2 t dt

standard normal probability

"$ $#1
%
2

du

$% "$ $2 %
b

%

$a 1 #

$a 1 #

t2
$

u2
$

! $#1
2

! $#1
2

du

dt

$m!!% n
s

P"a " X " b| c, d# !

$b%!$a%
$d%!$c%

what’s the mean of a binomial ! ! n ! "
what’s the standard deviation
of a binomial # !
#

x bar

#

z critical value

n ! "$1 ! "%

x
1
2%

%

1 2

$ z e ! 2 t dt
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New Commands for ScientificNotebook 5.5
File Menu
import non-ScientificNotebook LaTex
Compute Menu, Combine
combine arctan
combine hyperbolic trig functions
Compute Menu, Rewrite
rewrite sin
rewrite cos
rewrite cosine
rewrite arcsin
rewrite arc cos
rewrite arc cosine
rewrite arc tan
rewrite arc cot
rewrite arc cotan
Compute Menu, Calculus
plot approximate integral animated
Compute Menu, Plot 3d
plot 3 delta implicit
Compute Menu, Plot 2D Animated
plot 2 delta rectangular animated
plot 2 delta polar animated
plot 2 delta implicit animated
plot 2 delta parametric animated
plot 2 delta conformal animated
plot 2 delta vector field animated
Compute Menu, Plot 3D Animated
plot 3 delta rectangular animated
plot 3 delta cylindrical animated
plot 3 delta spherical animated
plot 3 delta implicit animated
plot 3 delta tube animated
plot 3 delta gradient animated
plot 3 delta vector field animated
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Accessing the MathTalk manual WITH voice commands
The MathTalk manual is divided into 3 parts: Tutorial, Help Documents, Pictionary.
Say “mathtalk learning module” for voice commands that access MathTalk.
* The MathTalk Demo CD shows features of MathTalk.
* To move up/down within all documents, say “page up”, “page down”, “move down 1”,
“move down 4”, “move down 10”, “move up 1”, “move up 4”, “move up 10”, etc.
MathTalk Tutorial:
Say “helpful definitions” to open the Tutorial portion of the manual at this heading
(which is 5 paragraphs down from the top of the document). Say “top of document” to
move to the beginning of the Tutorial.
Say “tutorial search” for a list of voice commands that access Topics in the Table of
Contents.
MathTalk Pictionary:
The Pictionary is a list of ‘stand alone’ MathTalk commands (i.e. commands without
variables).
Say “pictionary search” for a list of voice commands accessing the Pictionary.
Say “go to 1 commands” to open the Pictionary at the beginning.
Help Documents:
Some of the previous information is listed in this portion of the manual.
Additionally, find:
1. Replace Letter or Symbol – say “replace help”; there find 'replace example' for text
help and see Demo CD for 'replace video'.
2. List of Sentence Commands - say “sentence command examples”, “variable menu”
for variable lists, and “sample commands” (one of the Quick Reference laminates
included in MathTalk).
3. Type Commands List - say “go to type commands” for a list of entering 1-2 words of
Text.
4. Trig Commands – say “trig list”.
5. Statistics Commands – say “statistics commands”. In this menu you will find
“available statistics commands” and “statistics tutorial”. “Statistical overview”
will open the Tutorial to the Statistics topic.
6. Trouble Shooting in MathTalk – say “trouble shooting”.
7. Technical Support – say “technical support”.
* To access the International Alphabet, say “international alphabet” (second Quick
Reference laminate included in MathTalk).
To reference this topic in the Tutorial, say “using international alphabet”. Then say
“page down” to view both the International Alphabet and Greek Alphabet.
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TECHNICAL SUPPORT
Technical Support can be obtained as follows:
1. Technical support is available via E-Mail at mathtalk@mathtalk.com or via fax at
817.719.9207.
Please send a written description of the request.
2. The majority of past requests for technical support have been the result of not
following instructions, particularly the MathTalk Install Instructions.
Please read the instructions and complete the recommended training before requesting
tech support.
3. For updates and helpful information, check “Tech Notes” on our website
www.mathtalk.com .
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PICTIONARY

MATHTALK PICTIONARY
# Indicates MUST use International Alphabet for letter(s)
You say:
1 over 2 pi
1 over pi
1 over square root of 2 pi

You get:
1
2!
1
!
1
2!

100 percent

Changes screen size to 100%.

150 percent

Changes screen size to 150%.

2 by 2 system

Sets up 2 by 2 linear system.

# 2 d graph menu

Opens 2 d graph menu.

# 2 d plot menu

Opens 2 d plot menu.

# 2 d plot

Executes 2 d plot command.

# 2 d rectangular plot

Executes 2 d rectangular plot command.

# 2 d rectangular

Executes 2 d rectangular command.

# 2 d wave equation

!2u
!t 2

" c2

2 element column vector

!
!

2 element row vector

! !

!2u
!x 2

!

!2u
!y 2

"0

# 2 i’s paren

ii"

2 lines

Enters two blank lines.

2 pi over 3

2!
3

2 tabs

Moves cursor two tab keys.

200 percent

Changes screen size to 200%.

3 by 3 system

Sets up 3 by 3 linear system.

# 3 d graph menu

Opens 3 d graph menu.

# 3 d graph

Executes 3 d graph.

# 3 d heat equation

!u
!t

"k

!2u
!x 2

!

!2u
!y 2

!

!2u
!z 2

"0

# 3 d plot menu

Opens 3 d plot menu.

# 3 d plot

Executes 3 d plot command.

1

# 3 d rectangular plot
# 3 d wave equation

Executes 3 d rectangular plot command.
!2u
!t 2

" c2

!2u
!x 2

!

!2u
!y 2

!

!2u
!z 2

"0

#
#

3 element column vector

#
# # #

3 element row vector
3 halves

3
2

# 3 i’s parens

iii"

3 lines

Enters three blank lines.

3 tabs

Moves cursor 3 tab keys.

300 percent

Changes screen size to 300 %.

400 percent

Changes screen size to 400 %.

4th power

#4

4th root

4

#

50 percent

Changes screen size to 50 %.

5th power

#5

5th root
6th power
6th root

5

#

#6
6

#

75 percent

Changes screen size to 75%.

7th power

#7

7th root

7

#

85 percent

Changes screen size to 85 %.

8th power

#8

8th root
9th power
9th root

8

#

#9
9

#

a 11 a 12 $ a 1n
# a matrix

a 21 a 22 $ a 2n
%

%

& %

a m1 a m2 $ a mn
# a r operator

1 " "1B " "2B2 " $ " "pBp

# a r process

X t " " 1 X t"1 " " 2 X t"2 " $ " " p X t"p " a t

2

about scientific notebook Information about ScientificNotebook.
absolute value

|! |

acre

acre

add expression

In graphing, say when adding expression.
Say “mupad graphs” to view document.

add item

Say in Items Plotted dialog box.

additive union

!

additive union menu

Opens additive union menu.

adjugate

Executes adjugate in Compute Menu.

align center

Aligns center.

align here

Aligns cursor. Use only in display box.

align left

Aligns left.

ampersand

&

angle

#

angle bar angle

'$(

angle bracket vbar

'! |

angle brackets

'! (

angle with arc

%

angstrom

Å

apostrophe

#

apply tag

Opens Apply Tag in Tools Menu.

approximately

&

approximately equal

'

approximate integral

Brings up choice of numerical routines
on approximate integral.

argument

arg

arithmetic progression

a ! )a ! d" ! )a ! 2d" ! $ ! *a ! )n " 1"d+

arrange icons

Choice in Windows Menu.

as

::

Ex. x : y :: 2 : 3

asterisk

(

average

Finds the average of a given data set.

3

#

#

b2t

B 2 *f)x"+
0

f)x"

f # )x"

f)x"

f # )x" f ## )x"

f # )x" f ## )x" f ### )x"
b 2 transform

f # )x" f ## )x"
f ## )x" f ### )x"

#

b3t

B 3 *f)x"+
0

f)x"

f )1" )x" f )2" )x"

f)x"

f )1" )x" f )2" )x" f )3" )x"

f )1" )x" f )2" )x" f )3" )x" f )4" )x"
#

f )2" )x" f )3" )x" f )4" )x" f )5" )x"
b 3 transform

f )1" )x" f )2" )x" f )3" )x"
f )2" )x" f )3" )x" f )4" )x"
f )3" )x" f )4" )x" f )5" )x"

backspace

Backspaces 1 time.

backspace 2

Backspaces 2 times.

backspace 3

Backspaces 3 times.

backspace 4

Backspaces 4 times.

backspace 5

Backspaces 5 times.

bar

Puts a bar over preceding symbol or letter.
Ex. say “charlie”, “bar”. Get: c

beginning of line

Moves cursor to beginning of line.

belongs to

)
+

)"1" k

bessel function

*

#

B)a, b"

beta a b

beta function

k"0

t
2

n!2k

k!$)n!k!1"

1

, 0 x a"1 )1 " x" b"1 dx

beta hat

,
#

big integral with joint scripts

,!

!

!

big integral with limits

,
!

4

big union

,
.

bigger font

Sets font to defined bigger font for text.

binomial

Opens choice menu for binomial function.

#

) nx "

big integral
big intersection

binomial coefficient n x

binomial coefficient ) !! "
binomial menu
Opens menu of choices for binomial function.
body math

Formatting command.

body text

Formatting command.

bold off

Turns bold off.

bold on

Turns bold on.

both double arrows

%

bottom brace

/

!

bottom label

!

bottom labeled both arrows

0

braces

1! 2

bracket matrix

Opens matrix dialog box.

brackets menu

Opens brackets menu.

brackets

*! +

bravo 2 tango

B 2 *f)x"+

!

!

0

f)x"

f # )x"

f)x"

f # )x" f ## )x"

f # )x" f ## )x" f ### )x"
bravo 2 transform

f # )x" f ## )x"
f ## )x" f ### )x"

bravo 3 tango

B 3 *f)x"+

5

0

f)x"

f )1" )x" f )2" )x"

f)x"

f )1" )x" f )2" )x" f )3" )x"

f )1" )x" f )2" )x" f )3" )x" f )4" )x"
f )2" )x" f )3" )x" f )4" )x" f )5" )x"
bravo 3 transform

f )1" )x" f )2" )x" f )3" )x"
f )2" )x" f )3" )x" f )4" )x"
f )3" )x" f )4" )x" f )5" )x"

bravo square minus
4 alpha charlie

b 2 " 4ac

break spacing

Spacing command.

bullet

3

button click

Executes “button click”.

#

cdf

P*X - x+

#

c dots

$

calculus iterate

Iterate command from Calculus Menu.

calculus menu

Opens Calculus Menu.

#

cap foxtrot of x y and z F)x, y, z"

cascade windows

Cascade in Windows Menu.

cauchy

Executes New Definition in Compute Menu.

ceiling brackets

4! 5

center dots

$

center text

Centers line and the following lines.

center this

Same as “center text” and “align center”.

centered dot

3

change digits in display Lets you set number of digits displayed in computations.
change font

Opens change font dialogue box.

change matrix form

Puts string of symbols in matrix form.

change series order

Say to change order of number of terms in infinite
series representation of function or in ODE series solution.

change variable

In Compute, Calculus Menu.

characteristic polynomial Say with cursor in or immediately following the matrix.
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check equality

Checks correctness of an equality.

check spelling

Checks spelling.

chi square

$2

circle

"

circle dot

#
$

circle dot menu

Opens dialog box to customize this symbol.

circle cross

circle menu

Opens Operator Menu.

circle minus

.

circle plus

/

circle plus menu

Opens dialog box to customize this symbol.

circle slash

0

circle times menu

Opens dialog box to customize this symbol.

circle times

1

clear definitions

Clears the definition file.

close all

Closes all open files.

close file

Closes file.

close menu

Closes bring down menu.

closed open interval

*! "

collect polynomial

Collects like terms.

collect terms

Simplifies like terms.

colon

:

column basis

Computes column basis.

column matrix

Takes you to matrix dialog box with columns
set at 1.

column vector

Same as “column matrix”.

combine exponential

Say with cursor in/immediately following expression.

combine logs

Say with cursor in/immediately following expression.

combine powers

Say with cursor in/immediately following expression.

combine trig functions

Say with cursor in/immediately following expression.

comma

,

7

companion matrix

Say with cursor in or immediately following the matrix.

composition

2

computations

Opens Compute Menu.

computations menu

Opens Compute Menu.

compute adjugate

Say with cursor in/immediately following expression.

compute characteristic
polynomial

Say with cursor in/immediately following expression.

compute cholesky
decomposition
compute column basis

Say with cursor in/immediately following expression.
Say with cursor in/immediately following expression.

compute condition number Say with cursor in/immediately following expression.
compute correlation

Say with cursor in/immediately following expression.

compute covariance

Say with cursor in/immediately following expression.

compute determinant

Say with cursor in/immediately following expression.

compute eigen values

Say with cursor in/immediately following expression.

compute eigen vectors

Say with cursor in/immediately following expression.

compute fraction free gaussian
elimination

Say with cursor in/immediately following expression.

compute Gaussian elimination

Say with cursor in/immediately following expression.

compute hermite normal form

Say with cursor in/immediately following expression.

compute hermitian transpose

Say with cursor in/immediately following expression.

compute Hessian

Say with cursor in/immediately following expression.

compute interpret

Executes Interpret in Compute Menu.

compute inverse

Say with cursor in/immediately following expression.

compute jordan form

Say with cursor in/immediately following expression.

compute menu

Opens Compute Menu.

compute minimum polynomial

Say with cursor in/immediately following expression.

compute norm

Say with cursor in/immediately following expression.

compute rank

Say with cursor in/immediately following expression.

compute row basis

Say with cursor in/immediately following expression.

compute settings

Opens dialog box in Computation Settings.

compute singular value
decomposition

Say with cursor in/immediately following expression.
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compute singular values

Say with cursor in/immediately following expression.

compute smith normal form

Say with cursor in/immediately following expression.

compute spectral radius

Say with cursor in/immediately following expression.

compute stack matrix

Say with cursor in/immediately following expression.

compute trace

Say with cursor in/immediately following expression.

compute transpose

Say with cursor in/immediately following expression.

computing techniques

Takes you to Help, Computing Techniques.

concantenate

Matrix command. Calculates the concantenate.

condition number

Say with cursor in/immediately following the matrix.

conditional probability

P*|+

contour integral

3

contour integral menu

Opens Operator Menu.

contour integral with lower limit 3

!

contour integral with subscript

3!

coproduct

4

coproduct menu

Opens menu to customize this symbol.

coproduct with joint scripts

4 !!

coproduct with limits

4

coproduct with lower limit

4

coproduct with subscript

4!

copy as internal format

Executes Copy As Internal Format in File Menu.

copy this

Copies selected materials.

copy to beginning of line

Copies from cursor to beginning of line.

!
!
!

No need to select.
copy to end of line

Copies from cursor to end of line. No need to select.

copy to beginning of line

Copies from cursor to beginning of line.
No need to select.

copy to end of line

Copies from cursor to end of line. No need to select.

9

corresponds to

~

cross partial

!2f
!y!x

cross product

1

cube root

3

!

cubed

!3

decoration menu

Opens decoration menu.

define equal

Sets the two expressions equal in MuPad.

define menu

Opens Define Menu.

define mupad name

Opens this dialog box.

#

define t statistic

t"

)m"%" n
s

, where m " x .

#

define z statistic

z"

)m"%" n
&

, where m " x .

!

definite integral

,

definite sum

*

definiteness tests

Opens menu to check definiteness of a Matrix.

definition

Item tag.

definitions menu

Opens Definitions Menu.

degrees

2

del squared

62

del

6

delete

Deleted 1 character to RIGHT of cursor

!
!
!

OR SELECTED characters.
delete break

Deletes page break.

delete key

Deletes 1 character to right of cursor.

delete next character

Deletes 1 character to right of cursor.

delete next 2 -10 characters

Deletes 2-10 characters to right of cursor.

delete previous character

Deletes 1 characters to left of cursor.

delete previous 2-10 characters Deletes 2-10 characters to left of cursor.
delete rest of line

Deletes from cursor to end of line.

delete that

Deletes selected materials.

delta x-ray

dx

delta yankee

dy

10

d
dx

derivative open ended
determinant

Say with cursor in/immediately following the matrix.
Calculates the determinant of matrix.

diagonal dots

&

differentiate implicitly

Differentiates implicitly.

display equation

Sets off equation.
~

distributed as
divide

Same as divide polynomial.

divided by

'

divide polynomial

Divides two polynomials.

document info

Document info in File Menu.

document manager

Opens Document Manager dialog box.

dollar sign

$

double integral

,,

double integral menu

Opens symbol dialog box to customize symbol.

double integral with lower limit

,,

double integral with subscript

,, !

double prime

##

!

!
&! &

double under bar
double vertical bars
down double arrow

'

dual simplex

MuPad command to produce dual of a linear system.

#

exp

exp

edit menu

Opens Edit Menu.

eigen values

Say with cursor in or immediately following matrix.

eigen vectors

Say with cursor in or immediately following matrix.

element of

)

emphasized font

Activates that text tag.

empty set

5

end determinant

Moves out of determinant when cursor is at last element.
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end display

Moves out of display equation.

end exponent

Ends the exponent.

end fraction

Ends the fraction.

end key

Presses the End Key.

end limits

Moves out of upper or lower limit.

end line segment

Moves out from under line segment indicator.

end matrix

Moves out of matrix.

end of document

Moves to end of document.

end of line

Moves cursor to end of the line.

end ray

Moves out from under line ray indicator.

end subscript

Ends subscript.

end superscript

Ends superscript.

end system

Extend right.

end this

Ends Particular math “box”.

end upper limit

Ends upper limit.

enter data

Sets up column matrix to enter data.

enter key

Presses Enter Key.

equal

"

equal or greater than 6
equal or less than

-

equals

"

equivalent

7

erase 2 lines

Erases line cursor is on and line above.

erase 3 lines

Erases line cursor is on and two lines above.

erase graph

Erases selected graph.

erase line

Erases line the cursor is on.

erase rest of line

Erases part of line to left of cursor.

erase review binomial distribution Erases same.
erase review uniform distribution

Erases same.

erase to beginning of line

Erases to beginning of line.

escape

Presses Escape Key.

escape key

Presses Escape Key.
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evaluate

Cursor must be in/directly to right of math
to be evaluated.

evaluate numerically

Same as above.

evaluate this

Same as above.

even

Same as above.

#

exact ode

Cursor must be in ODE or directly to right .
Gives MuPad solution.

exam builder

Opens Exam builder dialog box.

expand

Expands an algebraic expression.

expanding left brace

1!

expanding left bracket

*!

expanding left parenthesis

)!

expanding right brace

expected value

!2
!+
!"
E*! +

expected value of theta hat

E*( +

exponent

Puts cursor in exponent position on

expanding right bracket
expanding right parenthesis

preceding symbol.
exponential

exp

export document as

Opens that dialog box.

export documents as

Opens that dialog box.

export settings

Opens that dialog box.

#

foxtrot of x y and z

f)x, y, z"

factor

Factors algebraic expressions.

factor this

Factors algebraic expressions.

factorial

!

field menu

Opens Field Menu from Insert Menu.

fifth derivative exponent notation

f )5" )x"

file menu

Opens File Menu.
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fill matrix

Matrix command. Calculates the fill matrix.

find all solutions

Finds solutions of an equation.

find extrema

Finds minimums & maximums of a function.
Cursor needs to be in/directly right of function.

find max

See “find extrema” command.

find min

See “find extrema” command.

find numeric solution

Solves numerically.

find roots

Finds roots of equation.

find solution

Finds all solutions of an equation analytically.

find this

Opens “find” dialog box to search for words, symbols.

find word

Opens “find” dialog box to search for words, symbols.

first derivative
first derivative exponent notation

dy
dx
)1"

f )x"

first derivative of y with respect to x

dy
dx

fit curve

Cursor must be in data.

fit polynomial

Cursor must be in data.

fit regression line

Cursor must be in data.

five spaces

Moves cursor 5 spaces.

for all

8

for any

8

for every

for every

formula

Opens Formula dialog box for inserting a formula.

!
!
!
!

four element column vector

! ! ! !

four element row vector
+

fourier transform

, "+ exp)"2!ift"

four spaces

Moves cursor 4 spaces.

fourth derivative exponent notation

f )4" )x"

fraction

!
!

fraction free gaussian elimination

Operates this function in Compute, Matrices Menu.
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#

gcd

gcd

gamma matrix

)0

)1

$ ) n"1

)1

)0

$ ) n"2

%

%

& %

) n"1 ) n"2 $ ) 0
1
2

gamma of one half

$

gaussian elimination

Cursor must be in matrix or to immediate right.
*n/2+

)"1" k )*" n"k )2x" n"2k
k!)n"2k"!

gegenbauer polynomial

*

gegenbauer nu

C *n )x"

general determinant

Opens menu to set up determinant.

general information

Opens general information index.

general matrix

Places cursor in matrix dialog box & puts

k"0

the matrix you choose inside. )!"
general quadratic

ax 2 ! bx ! c

general root

!

generate random numbers Places cursor in random number generator
dialog box.
get help

Opens ScientificNotebook Help.

go author

In Go Menu, Links.

go beginning

Use only in linked documents.
Goes to 1st document.

go bibliography

In Go Menu, Links.

go contents

In Go Menu, Links.

go copyright

In Go Menu, Links.

go disclaimer

In Go Menu, Links.

go editor

In Go Menu, Links.

go end document

Use only in linked documents. Goes
to last document.

go glossary

In Go Menu, Links.

go history back

In Go Menu.

go history forward

In Go Menu.

go index

In Go Menu, Links.
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go links menu

In Go Menu.

go menu

Opens Go Menu.

go next document

In Go Menu, Links.

go next section

In Go Menu.

go parent document

In Go Menu, Links.

go previous document

In Go Menu, Links.

go previous section

In Go Menu, Links.

go publisher

In Go Menu, Links.

go to beginning of line

Places cursor at beginning of line.

go to marker

In Go Menu.

go to paragraph

In Go Menu.

go top of document

Cursor moves to top of document.

go trademark

In Go Menu, Links.

go view history

In Go Menu.

gradient

9

graph cylindrical

Graphs in cylindrical coordinates.

graph data

Graphs data.

graph implicit

Graphs implicit.

graph parametric

Graphs in parametric coordinates.

graph polar

Graphs in polar coordinates.

graph polynomial

Graphs in polynomial coordinates.

graph regression line

Graphs regression line.

graph spherical

Graphs in spherical coordinates.

graph this

Graphs function. Cursor must be in
or immediately right of function.

greater than

(

greater than or equal to 6
greatest lower bound

inf

hat

,
Say “alpha”, “hat”. Get a

heading 1

Section Body Tag. See ScientificNotebook.

heading 2

Same as “heading 1”.

heading 3

Same as “heading 1”.
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heading 4

Same as “heading 1”.

heading 5

Same as “heading 1”.

help contents

Contents in Help Menu.

help index

Index in Help Menu.

help index menu

Index in Help Menu.

help menu

Opens Help Menu.

help search

Search in Help Menu.

#

hermite n

hermite normal form

H n )x"
Computes Hermite matrix.
*n/2+

)"1" k n!)2x" n"2k
k!)n"2k"!

hermite polynomial

*

hermitian transpose

Computer Hermitian Transpose matrix.

hessian

Computes Hessian matrix.

hollow dot

2

hollow dot line segment

k"0

2""2

!

horizontal spacing

Opens horizontal spacing dialog box.

hundred

00

hypergeometric series

1!*

hypertext link

Opens Hypertext Link dialog box.

hyphen

-

#

i+

+

i omega

identically equal

)a" n )b" n z n
)c" n n!

n"1

7
1 0 $ 0
0 1 $ 0

identity matrix

%

%

& %

0 0 $ 1
imaginary

)

implicit differentiation

Differentiates implicitly.

import contents

Opens Import Contents dialog box.

import fragment

Opens Import Fragment dialog box.

import picture

Opens Import Picture dialog box.

inf key

inf
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infinity

+

infinity key

+

insert column

Inserts one column.

insert formula

Opens Formula dialog box in Insert Menu.

insert html

Opens that dialog box.

insert hypertext link

Opens that dialog box.

insert marker

Opens that dialog box.

insert matrix

Opens that dialog box.

insert menu

Opens Insert Menu.

insert note

Opens that dialog box.

insert one line

Inserts 1 line.

insert row

Inserts one row.

insert two lines

Inserts 2 lines.

#

With cursor next to or in data set, inserts

insert x y

“x” and “y” as heading for 2 column data set.
integral menu

Opens menu for customizing this symbol.

integral with joint scripts

,!

!

!

integral with limits

,

integral with lower limit

,

integral with subscript

,!

integral

,

integrand

Moves cursor from upper limit to integrand.

integrate by parts

Say with cursor in integrand.

interpret

Interprets possibility ambiguous expressions.

intersection

:

intersection menu

Opens menu to customize intersection symbol.

intersection with joint scripts

- !!

!
!

intersection with limits above
!

and below
intersection with limits

!
!

!
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inverse

Say with cursor in or immediately to right.
of matrix.

inverse matrix

Computes the inverse of the matrix.

inverse triangle

9

is an element of

)

is it positive definite

Answers question. Can be used with cursor
in matrix or next to it.

is to

:

italics off

Turns off italics.

italics on

Turns on italics.

iterate

Opens iterate dialog box.

#

jn

J n )t"

#

j omega

j+

#

j one half

J 1 )t"

j zero

J 0 )t"

#

2

jacobian

Calculates Jacobian of vector of functions.

joint scripts

!
!

jordan form

Calculates Jordan form of a matrix.

#

l dots

*
!

label above

!

label axis

Opens label menu axis.

label below

!

label menu

Opens label position dialog box.

laguerre alpha

L )a"
n )x"

laguerre polynomial

*

!

n

k"0

)"1" k )1!a" n x k
k!)n"k"!)1!a" k

laplace equation in a cube

!2u
!x 2

!

!2u
!y 2

!

laplace equation in a rectangle

!2u
!x 2

!

!2u
!y 2

"0

#

Compute ODE menu command.

laplace o d e

laplace transform
large coproduct

!2u
!z 2

"0

+

, 0 e "st

4
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large coproduct with joint scripts

!

4!
!

large coproduct with limits

4
!

large coproduct with lower limit

4
!

large coproduct with subscript
large coproduct
large integral

4!
4
,
!

large integral with joint scripts

,!

large integral with limits

,
!

large integral with over limits

,
!

large intersection with joint scripts

!

-!
!

large intersection with limits

!
!

large intersection with over limits

!

large intersection

-

large product

;

large union with joint scripts

.!

large union with limits

.

large union

.

larger font

Makes font larger.

larger

Enlarges to 150%.

largest intersection with joint scripts

-!

!

!
!

!

!

largest intersection with limits

!
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largest intersection
largest union
largest union with joint scripts

.
!
.!
!

largest union with limits

.
!

largest union with lower limit

.
!

largest union with subscript

.!

least upper bound

sup

left angle bracket

'! +

left arrow over
left arrow with top label

!
!
!

left arrow

+

left bar

|!

left brace only

1!

left bracket only

*!

left bracket right paren

*! "

left double arrow

,

left double bar

&!

left double v bar

&!

left expanding brace

1!

left expanding bracket

*!

left expanding parenthesis

)!

left implies

,

left joint scripts

!
!

left left bracket only

**

left over arrow
left parenthesis right bracket

!
)! +

left parenthesis

)

left ray

!

left arrow with bottom label
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left superscript

7
!!
!!

left triangle

%

left v bar

|!

left left expanding bracket

**!

left slanted line
left subscript

n

legendre polynomial first kind *
k"0

)n!k"!
)n"k"!)k!" 2 2 k

legendre rodriques formula

P n )x" "

less than or equal to

-

less than

-

lim inf key

lim inf

#
#

limit as n and m go to infinity
limit as x goes to x naught

)x " 1" k

1
dn
2 n n! dx n

)x 2 " 1" n

lim

n,m.+

lim

x.x 0

limit inferior

lim inf

limit superior

lim sup

limit

lim

line integral

3

!

3""3

line segment
linear system

Say when you wish to enter linear system.

log

log

logical and menu

Opens menu to customize the symbol.

logical and

<

logical not

/

logical or

=

logical or menu

Opens menu to customize the symbol.

lower limit

Places lower limit box on preceding symbol.

#

m a operator

1 " (1B " (2B2 " $ " (qBq

#

m a process

X t " a t " ( 1 a t"1 " ( 2 a t"2 " $ " ( q a t"q

marker

Opens Marker dialog box.

math mode

Sets MathTalk in math mode for math entry.
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math name

Opens dialog box to select name of
standard mathematical functions.

math to braille

Opens Duxbury Braille Translator (if installed).

matrices menu

Opens Matrix Menu.

matrix

Opens box to define matrix dimensions.

matrix column basis

Computes column basis for a matrix.

matrix condition number Computes condition number of a matrix.
matrix determinant

Computes the determinant.

matrix inverse

Computes the inverse.

matrix menu

Opens Matrix Menu.

matrix norm

Say with cursor in matrix.

max

max

maximize document

Maximizes document.

maximize simplex

Say with cursor in data.

maximum

max

mean deviation

Say with cursor in data.

mean

Say with cursor in data.

median

Say with cursor in data.

member of

)

midpoint rule

Say only in approximate integral box.

min

min

minimize simplex

Say only with cursor within system of equations.

minimum

min

minimum polynomial

Say only with cursor in matrix.

minus

"

minus infinity

"+

mixed partial

!2f
!y!x

mod

mod

mode

Calculates mode of a given set of data.

moment

Opens Moment dialog box.

move down 1

Moves cursor down one line.

move one word left

Moves cursor one word left.

move one word right

Moves cursor one word right.
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move out

Moves cursor out of mathematical “box”, such
as “exponent”, “fraction”, “subscript”, etc.

move this

Moves selected text and symbols.

move right/left 1-5

Moves cursor right/left 1-5 characters.

move up/down 1-5

Moves cursor up/down 1-5 lines.

much larger

Sets screen at 200%.

much smaller

Sets screen at 50%.

multiple integral menu

Opens menu allowing symbol customization.

mupad graphs

Shows examples of MuPad graphing.

mupad settings

Opens Settings in Compute.

#

) nx "

n choose x

natural log

ln

negative

"

new definition

Opens MuPad box to select new definition.

new file

Opens a new file.

new paragraph

Enters two lines.

new window

Opens New window in Window Menu.

next element

Moves to next position in a matrix.

next line

Inserts new line and stays in Math Mode.

no break

Removes page break.

norm

&!&

normal

Opens Apply Tag dialog box.

normal mode

Sets Normal in Apply Tag.

#

P*X - x+ "

normal c d f

1
2! &

normal density

1
2!

x

1 2

, "+ e " 2 t dt

exp1" 2&1 2 )x " %" 2 2

normal distribution function

&)x"

normal font

Sets font at style you have defined as normal.
1
2! &

normal integral

x

, "+ exp1" 23&1 2 )t " %" 2 2dt

normal mu sigma square

N)%, & 2 "

normal screen

Sets screen at 100%.

normal subgroup

%

normal tag

Opens Tag, Apply, selects Normal.
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1
2! &

normal zero one density

1 2

e" 2 t

not a member of

>

not an element of

>

not equal

?

not in

>

note pad

Brings up Note dialog box. (See Help, Notes.)

#

) nx "

november choose x

november derivative

dny
dx n

nullspace basis

Computes nullspace basis of a matrix.

number equation

Opens dialog box to number equation.

number sign

#

numbering help

Opens number equation help.

numerator

When in a fraction, moves cursor to numerator.

#

o d e series solution order

To define order of ODE series solution.

#

one d heat equation

!u
!t

#

one d wave equation

!2u
!t 2

#

one half x square

one over pi

1
2
1
!

2

" k !!xu2 " 0
" c2

!2u
!x 2

"0

x2

one over square root of two pi

1
2!

one over two pi

1
2!

open closed interval

)!+

open file

Opens open file in dialog box.

open location

Opens Location in File Menu.

open quote

“

operator menu

Opens Operator choice box.

order powers

Orders polynomial by power.

orthogonal test

Test for orthogonality of a matrix.

orthogonality test

Test for orthogonality of a matrix.

out all

Moves to end of line.

over

In fraction, moves cursor from numerator to denominator.

over bar

!
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8

!

over brace

3

over dot
over double dot

!
33
!

over hat

,
!

over label

!

over script

!
!
333
!

!
!

over tilde
over triple dot
overlay polynomial

See Tutorial. Overlays a polynomial on the data.

#

pdf

f X )x|("

#

p l u decomposition

Say with cursor in matrix.

#

p n of x

P n )x"

page break

Inserts a page break.

page setup

Opens Page Setup menu.

parallel to

&

parens

)! "

parentheses

)! "

partial

!

partial derivative
partial fractions
#

!F)x,y"
!y

partial of foxtrot of x and
y with respect to x

#

!F)x,y"
!x

partial of cap f of x and
y with respect to y

#

Performs MuPad partial fraction routine.

partial of cap f of x and
y with respect to x

#

!y
!x

!f)x,y"
!x

partial of foxtrot of x and
y with respect to y

!f)x,y"
!y

paste special Paste menu command.
paste this

Performs paste.

permanent

Matrix command.
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perpendicular

'

#

plot 2 d data

Plots 2 d data in rectangular coordinates.

#

plot 2 d menu

Opens 2 d menu.

#

plot 2 d rectangular

Plots 2 d data in rectangular coordinates.

plot approximate integral

Opens plot approximate integral.

plot conformal

Plot command.

plot cylindrical

Plots in cylindrical coordinates.

plot data

Plot 2 d data in rectangular coordinates.

plot gradient

Plot gradient command.

plot implicit

Plot implicit command.

plot parametric

Plot parametric command.

plot phase plane

MuPad plot menu.

plot points

MuPad plot menu.

plot polar

2 d plot command..

plot spherical

3 d plot command

plot this

2 d rectangular plot command.

plot tube

3 d plot command.

plot vector field

3 d plot command.

plus

!

plus or minus

0

point

.

polynomial menu

Opens polynomial menu.

positive definite

Answers question. Can only be used with
cursor in/next to matrix.

pound sign

#

power series

Calculates power series of a function.

precedes

@

preview 10

In Print Preview, moves to 10th page. The
page that you are on counts as page 1.

preview 15

See “preview 10”.

preview 2

See “preview 10”.

preview 3

See “preview 10”.
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preview 4

See “preview 10”.

preview 5

See “preview 10”.

preview 6

See “preview 10”.

preview 7

See “preview 10”.

preview 8

See “preview 10”.

preview 9

See “preview 10”.

prime

#

print document

Opens print dialog box.

print preview

Opens print preview.

print this

Opens Print menu.

probability

P*!+

product

;

product menu

Opens Product menu.

product with joint scripts

; !!

product with limits

;

product with lower limit

;

product with subscript

;!

proper subset

A

proper superset

B

proportional to

(

put here

Places copied selection at cursor.

put it here

Places copied selection at cursor.

!

#

qed

#

q r decomposition

!
!

Q.E.D.
Calculates the Q R decomposition of matrix.

quadratic equation

ax 2 ! bx ! c " 0

quadratic formula

x"

quantile

Calculates quantities of a data base.

radical
random matrix

"b0 b 2 "4ac
2a

!
Opens random matrix choice box.

random number generator Opens Random Numbers dialog box.
random numbers

Opens Random Numbers dialog box.

random sample

X 1 X 2 $X n
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range one two

1, 2, $,

range zero one two

0, 1, 2, $,

range zero plus or minus

0, 01, 02, $,

rank

Say with cursor in matrix.

rational canonical form

Calculates rational canonical form of a matrix.

reduced row echelon form Matrix command.
reference library

Opens ScientificNotebook Reference Library.

remove number

Removes number from equations typed in
“display mode”.

replace next character

With cursor to immediate left of character, selects
1 character to right of cursor and places it in
Replace Dialog box. See Tutorial.

replace next two
characters

With cursor to immediate left of characters,
selects 2 characters to right of cursor,places
them in Replace Dialog box. See Tutorial.

replace text

Replace Dialog box. See Tutorial.

reshape

Opens Reshape Matrix dialog box.

restore definitions

MuPad Command.

reverse normal subgroup

Say with cursor in matrix.

review arithmetic progression

a ! )a ! d" ! )a ! 2d" ! $ ! *a ! )n " 1"d+

review average

Reviews definition of sample mean.

review binomial distribution

Reviews definition of binomial distribution.

review binomial formula

)a ! x" n " a n ! na n"1 x !

review binomial squared

)x ! y" 2 " x 2 ! 2xy ! y 2

n)n"1"
2!

a n"2 x 2 ! $ ! x n

review definition of the derivative Reviews definition of the derivative.
review difference of two cubes

x 3 " y 3 " )x " y")x 2 ! xy ! y 2 "

review difference of two squares

x 2 " y 2 " )x ! y")x " y"

review equation of a line

Reviews definition of the equation.

review geometric progression

a, ar, ar 2 , $, ar n"1

review quadratic formula

ax 2 ! bx ! c " 0 1 x "

#

Reviews definition of the “root mean square”.

review r m s

"b0 b 2 "4ac
2a
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review sample mean

Reviews definition of sample mean.

review standard deviation
of x bar
review standard deviation

Sigma X bar"

&x
n

Reviews definition of standard deviation.

review sum of a geometric
progression

S " a ! ar ! ar 2 ! $ ! ar n"2 ! ar n"1 "

a"ar n
1"r

review sum of an
arithmetic progression

Reviews sum of an arithmetic progression.

review sum of two cubes

x 3 ! y 3 " )x ! y")x 2 " xy ! y 2 "

review taylor series

f)x" " f)a" !

review trinomial squared

)x ! y ! z" 2 " x ! y ! z ! 2xy ! 2xz ! 2yz

review uniform distribution

Reviews definition of a Uniform probability.

rewrite equations as matrix

Brings up System Variable dialog box for such.

rewrite exponential

Rewrites as exponential.

rewrite factorial

Rewrites as factorial.

rewrite float

Rewrites as float.

rewrite gamma

Rewrites as gamma.

rewrite logarithm

Rewrites as logarithm.

rewrite matrix as equations

Rewrites matrix as equations.

rewrite menu

Opens Rewrite Menu.

rewrite polar

Rewrites as polar.

rewrite rational

Rewrites as rational.

rewrite rectangular

Rewrites as rectangular.

rewrite sin and cos

Rewrites as sin and cos.

rewrite sinh and cosh

Rewrites as sinh and cosh.

rewrite tan

Rewrites as tan.

right angle bracket

(

right arrow

.

right arrow over

!
!

right arrow under
right arrow with bottom label
right arrow with top label
right bar

)x"a"f # )a"
1!
2
2

!

)x"a" 2 ##
f )a"
2!
2

!$

!
!
!|
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right brace

2

right bracket

+

right bracket only
right diagonal dots

!+
&

right double arrow

1

right double bar

right expanding parenthesis

!&
!&
!2
!+
!"

right implies

1

right left bracket

+! *

right paren

"

right parenthesis

"

right parenthesis only

right v bar

!"
!
! ++
9
!|

roots

Finds roots of a polynomial.

row basis

In Compute menu. Use with cursor in matrix.

row matrix

Sets up a row matrix.

row vector

Sets up a row matrix.

rug menu

Opens Decorations Menu for symbols that

right double v bar
right expanding brace
right expanding bracket

right ray
right right bracket
right slanted line

go above and below.
rule spacing

Opens dialog box to customize spacing.

sample mean

Calculates “sample mean” of given data set.

sample median

Calculates “sample median” of given data set.

sample mode

Calculates “sample mode” of given data set.

#

Calculates sample standard deviation for given

sample s d

set of data. Cursor must be in/at end of data.
sample standard deviation

Same as “standard deviation”.
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sample variance

See as “sample mean”.

save all

Opens Save for all open files.

save as

Opens Save As dialog box.

save definition

Saves MuPad definition.

save file

Saves file.

save file as

Opens Save As dialog box.

save fragment

Opens Save Fragment dialog box.

save math as

Save math in ScientificNotebook/docs for
math that will be opened in Duxbury for
translation into braille.

save this

Opens Save file.

scalar field

F

scalar potential

Computes Scalar Potential.

screen appearance

Opens Note dialog box which allows you to
put notes and hints in margin.

script fee

,

#

script L

2

script theta

(

second derivative exponent
notation

f )2" )x"

second partial

!2

seconds

#

select all

Selects all.

select following screen

Selects following screen.

select next 2 characters

Selects next (right of cursor) 2 characters.

select next 3-10 characters

Selects that number of next characters.

select next character

Same as above.

select previous 2 characters

Selects previous (left of cursor) 2 characters.
for copying/deleting.

select previous 3-10 characters

Selects that number of previous characters.

select previous character

Same as above.

select to beginning of line

Selects from cursor to beginning of line.

select to end of document

Selects from cursor to end of document.

32

select to end of line

Selects from cursor to end of line.

select to start of line

Selects from cursor to beginning of line.

semicolon

;

send this

Send in File Menu.

sequence one two three

1, 2, 3, $

sequence zero one two

0, 1, 2$

sequence zero plus or minus one 0, 01, 02, $
series solution

MuPad ODE menu command.

set alignment

See SnBk Help on alignment.

set basis variables

Say with cursor in matrix.

set digits displayed

Opens dialog box for setting number
of digits displayed.

set font

Opens dialog box to change font.

show definitions

Show Definitions in Compute Menu.

show pictionary

Opens Pictionary.

show properties

In Edit Menu, Properties.
~

similar to
simplex dual

Say with cursor on linear system. Calculates
the dual system

simplex feasible

Say with cursor on linear system.
Determines if a solution exists.

simplex menu

Opens Compute simplex Menu.

simplify

MuPad command to simplify by expression.

simplify this

MuPad command to simplify by expression.

simpson rule

Opens Approximate Integral dialog box for Simpson.

single quote

#

singular value decomposition Gives singular value decomposition of matrix.
singular values

Calculates singular value of a matrix.

slash

/

smaller

Sets screen at 85%.

smaller font

Makes font smaller.

smith normal form

Calculates this form of a given matrix.

solid dot

3
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solution

Solution:

solve

Place cursor in or directly following equation.

solve equation Place cursor in or directly following equation.
solve exactly

Place cursor in or directly following equation.

solve integer

Gives integer solutions only.

solve menu

Opens solve choice box in Compute Menu.

solve numerically

Solves numerically.

#

solve o d e

Say with cursor in or following ODE.

#

solve o d e exactly

Gives exact solution if closed form exists.

#

solve o d e laplace

Solves ODE by this method.

#

solve o d e menu

Opens MuPad ODE menu.

#

solve o d e numerically

Say with cursor in or following equation.

#

solve p d e

Say with cursor in or following PDE.

solve recursion

Say with cursor in or following recursion.

sort polynomial

Arranges polynomial in descending powers.

spaces five

Moves cursor 5 spaces.

spacing menu

Opens spacing menu.

square

!2

square quartered

C

!

square root
#

square root of x square
plus y square

x2 ! y2

square shape

#

square with diagonals

D

square with dot

E

square with horizontal bar

F

squared

!2

standard deviation

In Compute menu, Standard Deviation.
+

standard normal critical value

1
2!

,z

standard normal density

1
2!

e" 2 t

standard normal integral

1
2!

, "+ e " 2 t dt

1 2

e " 2 t dt

1 2

x

1 2
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1
2!

standard normal p value p value "

+

, |z| e "

1 t2
2

dt

standardize simplex

Say with cursor in matrix.

start of line

Moves cursor to start of line.

statistics menu

Opens Statistics menu in Compute.

style

Opens Style Menu.

style editor

Opens Style Menu.

style menu

Opens Style Menu.

subscript

#!

subset

G

such that

H

sum
sum with joint scripts

*
* !!

sum with limits

*

sum with lower limit

*

sum with subscript

*!

!
!
!

summation cap yankee square

*
* Xi
* X 2i
* XiYi
* Yi
* Y 2i

summation menu

Opens dialog box to customize this symbol.

summation
#

summation cap x

#

summation cap x square

#

summation cap x y

summation cap yankee

summation with joint scripts

* !!
!

summation with limits

*

summation with lower limit

*

summation with subscript

*!

#

summation x

#

summation x square

#

summation x y

* xi
* x 2i
* xiyi

!
!
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#

summation y

#

summation y square

* yi
* y 2i

superior

sup

superscript

#!

system of equations

Opens box so you just answer how many
equations in the system.

#

#

t probability

P*a - X - b+ "

t statistic

t"

$) *!1
"
2
*
2

*! $) "

b

,a 1 !

t2
*

" *!1
2

dt

)m"%" n
s

tab

Tabs and keeps you in Math Mode.

tab key

Tabs and keeps you in Math Mode.

tag appearance

Opens this option in Tag Menu.

tag apply

Opens this option in Tag Menu.

tag function key

Opens this option in Tag Menu.

tag menu

Opens Tag Menu.

taylor series

Gives the Taylor series expression.

text mode

Set MathTalk in Text Mode for dictation.

text open quote

“

the set of all x-ray such that

1x|2

thick space

Inserts a thick space.

thin space

Inserts a thin space.

third derivative exponent notation

f )3" )x"

three spaces

Moves cursor 3 spaces.

tile horizontally

Window choice menu.

tile vertically

Window choice menu.

times asterisk

(

times dot

3

#

-

times x

times

-

toggle math mode

Clicks “math mode” on in toolbar.

toggle text

Clicks “text mode” on in toolbar.

tools action

Action in Tools Menu.
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tools automatic substitution Selects automatic substitution in
Tools Menu.
tools menu

Opens Tools Menu.

tools spelling

Opens spell check in tools menu.

tools user setup

Opens user setup in Tools Menu.

top brace

8
#

top label

#

top labeled both arrows

#

top labeled left arrow

#

top labeled right arrow

#

top of document

Moves cursor to top of document.

train commands

Opens dialog box to enter and train command.

train initial commands

Opens training of initial MathTalk commands.

train math commands

Brings up list of math commands for training.

transforms fourier

Calculates Fourier – in Transforms menu in Compute.

transforms inverse fourier

Calculates Inverse Fourier – in Transforms menu in Compute.

transforms inverse laplace

Calculates Inverse Laplace – in Transforms menu in Compute.

transforms laplace

Calculates Laplace – in Transforms menu in Compute.

transforms menu

Opens Transforms menu in Compute.

transpose

Cursor must be in or immediately right of matrix.

transpose matrix

Cursor must be in or immediately right of matrix.

trapezoid rule

Say with cursor in the integrand.

!

B

:

triangle abc

A

triangle on the right

)

triple integral

,,,

triple integral menu

Opens dialog box to customize this symbol.

C

triple integral with lower
limit

,,,
!

triple integral with subscript

,,, !

triple prime

###
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type and

and

type as

as

type but

but

type cap but

But

type cap example

Example

type cap Hence

Hence

type cap if

If

type cap let

Let

#

Let x equal

type cap let x equal

type cap now

Now

type cap so

So

type cap then

Then

type cap theorem

Theorem

type cap therefore

Therefore

type cap thus

Thus

type covariance

Cov

type even

even

type for

for

type for all

for all

type for every

for every

type if

if

type if and only if

if and only if

type in

in

type is

is

type let

let

type odd

odd

type on

on

type or

or

type otherwise

otherwise

type since

since

type text

Clicks “text mode” for entering text.

type then

then

type thus

thus
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type to

to

type variance

Var

type when

when

type whenever

whenever

type where

where

undefine

Undefines a previous definition in
MuPad definitions.

under bar

!

under brace

/

!

under double bar

!

under script

#

underline off

Turns off underline.

underline on

Turns on underline.

undo deletion

Undoes deletion.

undo that

Undoes deletion.

union

I

union menu

Opens dialog box with choices for style, size, union.

union with joint scripts

. !!

union with limits

.

union with lower limit

.

union with subscript

.!

unit name

Opens Unit Menu.

up arrow

3

up double arrow

4

upper limit

Moves cursor from lower limit to upper limit.

#

v bar

|

#

v bar a to b

$ ba

#

v bar angle bracket

*(

#

v bar with limits

| !!

#

v dots

%

!

!
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variance

Computes sample variance. Cursor must
be in or at end of data.

vector calculus

Opens Vector Calculus Menu in Compute.

vector curl

Calculates Curl.

vector divergence

Calculates Divergence.

vector gradient

Calculates Gradient.

vector hessian

Calculates Hessian.

vector laplacian

Calculates Laplacian.

vector potential

Calculates the vector potential.

vector scalar potential

Calculates the scalar potential.

vector set basis variables Allows resetting of basic vector variables.
vector wronskian

Calculates Wronskian.

vertical arrow

5

vertical bar

|

vertical bar with limits

| !!

vertical dots

%

vertical spacing

Opens dialog box to customize vertical spacing.

view 100 percent

Sets screen at 100%.

view 200 percent

Sets screen to 200 %.

view 300 percent

Sets screen to 300%.

view 400 percent

Sets screen to 400%.

view custom

Allows you to customize screen view size.

view helper lines

Toggles helper lines off and on.

view input boxes

Toggles input boxes, i.e. the small boxes that
show where limits go, for example. Without
this on, you won’t be prompted visually on the
screen where certain symbols go. It’s a good
idea to always have this on.

view invisibles

Shows markers that aren’t normally shown.

view marker fields

Toggles Marker Fields in View Menu.

view menu

Opens View Menu.
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view refresh

Clicks Refresh in View Menu.

view status bar

Toggles Status bar in View Menu.

view tool bars

Opens Toolbar Menu.

web site

Web site in Help Menu.

window menu

Opens Window Menu.
x 11 x 12 $ x 1n

#

x 21 x 22 $ x 2n

x matrix

%

%

& %

x m1 x m2 $ x mn
#

x minus i y

x " iy

#

x plus i y

x ! iy

#

z point one

z .1 " 1. 282

#

z point zero one

z .01 " 2. 326

#

z point zero five

z .05 " 1. 645

#

z point zero two five z .025 " 1. 960

#

z statistic

z"

zero vector

0

zoom in

Enlarges text in Preview in File Menu.

zoom out

Makes text smaller in Preview in File Menu.

)m"%" n
&
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